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Die in dieser Einführung enthaltenen Hinweise auf Bezugsquellen für Programme sowie die
Preisangaben entsprechen dem Stand zur Drucklegung und erfolgen ohne Gewähr!
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1 Einleitung

1.1 Übersicht
Wenn Sie dieses Dokument zur Hand nehmen, so sollten Sie mit der grundlegenden Nutzung
des Internets vertraut sein. Eine gute Übersicht über die Dienste des Internets findet man bei-
spielsweise in der Schrift:

Internet- Eine Einführung in die Nutzung der Internet-Dienste
Regionales Rechenzentrum für Niedersachsen (NET.ALL 4)

Diese Schrift ist über die Betriebsvorbereitung des Rechenzentrums der Ruhr-Universität er-
hältlich.

Wir wollen uns in der vorliegenden Einführung mit einem speziellen Dienst des Internets, dem
World Wide Web befassen. Server im World Wide Web bieten Ressourcen wie Dokumente,
Bilder, Videosequenzen, Sound, etc. an, die ein Klient sich mit Hilfe eines Web-Browsers an-
schauen und herunterladen kann. Der Web-Browser präsentiert diese Netz-Ressourcen in Form
von Hypertext. Dies ist Text, der Verweise auf weitere Ressourcen enthält. Die Verweise wer-
den auch Links (Hyperlinks) oder Anker genannt. Zugriff auf die weltweit verstreuten Daten
erhält der Nutzer, indem er einfach auf einen solchen Anker mit der Maus klickt.

Ein Dokument im Web hat einen speziellen Aufbau: Es besteht aus Nutzinformation, die dem
Leser im Browser-Fenster präsentiert wird, und aus Steueranweisungen für den Browser, die
dieser zur Gestaltung des Dokumentes nutzt. Die Steueranweisungen sind in der sogenannten
Hypertext MarkUp Language (HTML) zu verfassen. Dieses Heft soll Ihnen eine Starthilfe zum
Verfassen derartiger HTML-Dokumente vermitteln. Es gibt bereits eine ganze Reihe von Web-
Editoren, die den angehenden Autoren von Web-Dokumenten die Arbeit erleichtern. Auch in
dieser Einführung wird ein Web-Editor verwendet. Die Wahl ist auf den Netscape Editor 3.01
gefallen, da dieser einfach zu bedienen und für nahezu alle Betriebssysteme verfügbar ist. Der
Netscape Editor ist in der Gold-Version des Netscape Navigators enthalten.Er kann zudem im
Bereich Forschung und Lehre kostenlos genutzt werden. Mit Hilfe des Netscape Editors wird
in dieser Einführung ein kleines Web-Projekt entwickelt. Dabei wird sowohl die Nutzung des
Editors als auch die Syntax der HTML-Sprachelemente beschrieben. Als Entwicklungsumge-
bung wurde ein PC mit dem Betriebssystem Windows 95 oder Windows NT eingesetzt. Die
Beschreibung bezieht sich also auf den Einsatz des Netscape Editors unter diesen Betriebssy-
stemen. Die Bedienung sollte auch unter den anderen Betriebssystemen, für die es diese Versi-
on des Editors gibt, ähnlich erfolgen. Dabei kann es aber vorkommen, daß einzelne Leistungen
über anderen Tastenkombinationen abzurufen sind.

Wenn man eigene Web-Seiten gestaltet, sollte man das Ergebnis stets mit mehreren Browsern
kontrollieren. Dies ist erforderlich, da nicht alle der üblicherweise genutzten HTML-
Sprachelemente auch standardisiert sind. In dieser Einführung beschränken wir uns auf zwei
Web-Browser, nämlich den Netscape Navigator 3.01 und den Microsoft Internet Explorer
3.01, beide in der englischen Version. Während der Netscape Navigator für nahezu alle Rech-
nerplattformen erhältlich ist, läuft der Microsoft Internet Explorer zur Zeit nur in einer Win-
dows-Umgebung oder auf einem Macintosh-PC. Ab Mitte 1997 soll der Browser auch für
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UNIX-Plattformen erhältlich sein. Der Internet Explorer ist kostenlos verfügbar, der Netscape
Navigator kann im Bereich Forschung und Lehre ohne Kosten eingesetzt werden.
Sie können die genannten Programme vom Ftp-Server des Rechenzentrums der RUB herun-
terladen (ftp.rz.ruhr-uni-bochum.de). Die Browser sind im Verzeichnis /local/web/browser zu
finden (siehe dazu auch den nächsten Abschnitt).

Im ersten Teil dieser Einführung wird nochmals kurz auf einige Aspekte der Konfiguration und
Nutzung der beiden verwendeten Browser eingegangen. Dies geschieht nicht zuletzt mit dem
Ziel, sich die Darstellung der Dokumente im Browser-Fenster aus dem Blickwinkel eines ange-
henden Web-Autors anzuschauen.
Im Hauptteil dieser Einführung wird, wie bereits oben gesagt, unter Zuhilfenahme des Netsca-
pe Editors ein kleines Web-Projekt entwickelt. Obwohl Sie sehr viele Bilder als Illustrationen
vorfinden werden, sollten Sie dieses Buch nicht lesen, ohne gleichzeitig das Projekt in eigener
praktischer Arbeit nachzuentwickeln. Sämtliche Zusatzdateien, die Sie dazu brauchen, finden
Sie im Web unter http://www.ruhr-uni-bochum.de/www-rz/wojcibbw/WebBuch/. Holen Sie
sich diese Dateien auf Ihren Rechner. Sie wissen nicht wie? Lesen Sie den ersten Teil des Bu-
ches.

Dieses Buch lebt! Es wird in mehreren überarbeiteten und erweiterten Auflagen erscheinen. In
dieser ersten Auflage werden Sie nahezu alle HTML-Sprachelemente kennenlernen, die im
neuesten HTML Standard beschrieben werden. Dies sind Sprachmittel zur farblichen Gestal-
tung einer Seite, zur Konstruktion von Absätzen, Listen, Tabellen und Formularen, zur Defini-
tion von Ankern und zur Verwendung von Bildern auf Web-Seiten.
Die nächste Auflage, die bereits in Arbeit ist, wird sich mit zusätzlichen Sprachelementen be-
fassen, die zur Zeit noch nicht standardisiert sind, aber vielfach im Web genutzt werden. Dies
sind beispielsweise Sprachmittel zur Gestaltung von Web-Seiten in Frame-Technik, zur Nut-
zung von Java-Applets und Java-Script. Ferner werden einige proprietäre Sprachmittel be-
schrieben werden, die zur Zeit nur der Netscape Navigator oder der Internet Explorer beherr-
schen, beispielsweise Sprachmittel zur Verwendung von Hintergrundmusik und zur Definition
von Style Sheets.

Viel Spaß mit dieser Einführung!

1.2 Hinweise zu den verwendeten Programmen
Wie oben gesagt, finden Sie alle für Ihre Arbeit mit diesem Buch notwendigen Programme auf
dem Ftp-Server des Rechenzentrums der RUB. In diesem Abschnitt wird beschrieben, wie Sie
an diese Informationen herankommen.
Jeder Arbeitsplatz, der fürs Internet fit gemacht worden ist, verfügt auch über ein Klientenpro-
gramm namens ftp zum File-Transfer. In der Regel sind diese ftp-Programme sehr einfach kon-
struiert und müssen zeilenorientiert bedient werden. Unter Windows 95 oder Windows NT
starten Sie das Programm an der MS-DOS Eingabeaufforderung. Wir werden uns damit zu-
nächst ein anderes FTP-Programm besorgen, das für Windows-Anwender etwas einfacher zu
bedienen ist, nämlich das Programm ws_ftp.

1. Gehen Sie in die MS-DOS-Eingabeaufforderung und geben Sie den Befehl (Abbildung 1):
ftp ftp.rz.ruhr-uni-bochum.de ein.
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2. Es meldet sich der ftp-Server des Rechenzentrums. Sie müssen sich mit dem Benutzernamen
anonymous und Ihrer email-Adresse als Paßwort einloggen.

Abbildung 1: Ftp-Server des Rechenzentrums der RUB

3. Mittels des Kommandos help bekommen Sie eine Information über die verfügbaren Sub-
Kommandos des Programms ftp (Abbildung 2). Weitere Hilfe zu einem bestimmten Kom-
mando bekommen Sie, indem Sie den Kommandonamen hinter dem Befel help auf der
Befehlszeile angeben, z. B. help get.

Abbildung 2: Ftp-Submenü (Hilfe)

4. Wechseln Sie mittels des Kommandos cd in das Verzeichnis /pub/simtelnet/win95/inet/. In
diesem Verzeichnis ist das Programm ws_ftp in einer zip-Archivdatei abgelegt. Für Win-
dows 3.x Benutzer liegt das entsprechende Programm in /pub/simtelnet/win3/inet/.
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5. Mittels des Kommandos binary stellen Sie den Typ des Transfers auf binär um und holen
sich anschließend mittels des Kommandos get <Quelle> <Ziel> eine Kopie des Pro-
gramms auf Ihren PC (Abbildung 3). Der Quelldateiname lautet ws_ftp32.zip für die Win-
dows 95/NT-Version und ws_ftp.zip für die Windows 3.x Version des Programms. Sie
sollten die Datei in ein neues, leeres Verzeichnis auf Ihrem PC kopieren. Liegt dieses Ver-
zeichnis z.B. auf dem Laufwerk c: Ihres PCs und heißt ftpneu, so ist als Ziel
c:\ftpneu\ws_ftp32.zip anzugeben.

Abbildung 3: Ftp-Dateitransfer

6. Falls Sie kein Programm haben, mit dem Sie eine zip-Archivdatei entpacken können, so
müssen Sie sich in gleicher Art das Programm unzip.exe aus dem Verzeichnis
/pub/simtelnet/win95 oder /pub/simtelnet/win3 auf Ihren PC holen. Sie können das Pro-
gramm beispielsweise ins selbe Verzeichnis ablegen, in das Sie zuvor die Archivdatei abge-
legt haben.

7. Verlassen Sie das Programm ftp mittels des Kommandos quit.

8. Wechseln Sie in der MS-DOS Eingabeaufforderung in das neue Verzeichnis, in das Sie die
Software übertragen haben. Sie entpacken die Zip-Datei über das Kommando
unzip ws_ftp32.zip (Windows 3.x Benutzer: unzip ws_ftp.zip). Anschlies-
send finden Sie das Programm install.exe vor. Durch Aufruf dieses Programms installiert
sich das Programm ws_ftp. Während der Installation werden Sie nach einem Installations-
verzeichnis gefragt. Windows 3.x Benutzer installieren sich die 16-Bit Version dieses Pro-
gramms, Windows 95/NT Benutzer die 32-Bit Version.

Das Programm ws_ftp ist ein fensterorientiertes ftp-Programm von John A. Junod. Es darf im
Bereich Forschung und Lehre kostenlos benutzt werden. Mittels dieses Programms können Sie
sich jetzt die Browser vom FTP-Server herunterladen. Starten Sie das Programm ws_ftp aus
der Startleiste von Windows 95/NT oder dem Programmanager von Windows 3.x. Sie erhalten
zunächst ein Dialogfenster, in dem Sie Ihre Sessionprofile festlegen können (Abbildung 4).
Einige Sessionprofile sind bereits vordefiniert. Zur Kontaktaufnahme mit dem FTP-Server des
Rechenzentrums der RUB müssen wir ein neues Profil definieren. Klicken Sie auf die Schalt-
fläche New und füllen Sie die Felder des Dialogfeldes wie in Abbildung 4 angegeben aus. Als
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Paßwort müssen Sie natürlich Ihre eigene email-Adresse einsetzen. Klicken Sie anschließend
auf die Schaltfläche Übernehmen, damit das Profil zwecks späterer Wiederverwendung er-
halten bleibt.

.

Abbildung 4: Sessionprofil  für den Rechenzentrums FTP-Server

Klicken Sie auf die Schaltfläche OK. Sie sehen nun das Arbeitsfenster des Programms ws_ftp
(Abbildung 5). Automatisch wird jetzt der Aufwahldialog auf den FTP-Server des Rechenzen-
trums der RUB für Sie durchgeführt. Der Dialog wird im unteren Bereich des Arbeitsfensters
protokolliert.

Abbildung 5: Session mit dem FTP-Server des Rechenzentrums der RUB
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Nach erfolgreicher Kontaktaufnahme mit dem FTP-Server, sehen Sie im linken Fensterbereich
das Dateisystem Ihres PCs, in der rechten Fensterhälfte das Dateisystem auf dem FTP-Server.
Der Umgang mit dem Programm geschieht ebenso wie mit anderen Programmen zur Datei-
verwaltung unter Windows üblich: Beispielsweise wechseln Sie in ein anderes Verzeichnis
durch Doppelklick auf den Verzeichnisnamen. Über Schaltflächen können Sie weitere Leistun-
gen abrufen, beispielsweise MkDir zur Erzeugung eines neuen Verzeichnisses und Rename
zum Ändern des Namens eines Verzeichnisses oder einer Datei. Weitere Informationen zum
Programm ws_ftp können Sie über die Online-Hilfe abfragen. Die Online-Hilfe starten Sie über
die Schaltfläche Help.

Mit Hilfe des Programms ws_ftp können Sie sich jetzt die notwendigen Programme für Ihre
Arbeit holen. In der folgenden Tabelle sind die Fundorte auf dem FTP-Server angegeben:

Netscape Navigator Gold für Fundort (/local/web/browser/...)

Windows 3.x pc/netscape/netscape-gold-301/g16e301.exe

Windows 95/NT pc/netscape/netscape-gold-301/g32e301.exe

Macintosh mac/netscape-gold-301/

Unix unix/netscape-gold-301/

Internet Explorer 3.01 für Fundort (/local/web/browser/...)

Windows 3.x (Version 3.0) pc/iexplorer/dlbm30d.exe

Windows 95 pc/iexplorer/msie301m95.exe

Windows NT pc/iexplorer/msie301mnt.exe

Macintosh pc/iexplorer/ie30full.hqx

Beispiel:

Um den Netscape Navigator für Windows 95/NT zu holen, wechseln Sie im Dateisystem des
FTP-Servers in das Verzeichnis /local/web/browser/pc/netscape/netscape-gold-301/. Wechseln
Sie auf Ihrem PC in ein Verzeichnis, in das Sie den Netscape Navigator übertragen wollen. Sie
sollten eventuell dafür ein neues Verzeichnis anlegen. Markieren Sie durch Anklicken die Datei
g32e301.exe im Dateisystem des FTP-Servers (Abbildung 6).

Der Dateitransfer wird angestoßen, wenn Sie auf den entsprechenden Pfeil (ß) zwischen linker
und rechter Fensterhälfte klicken. Während des Transfers erhalten Sie ein zusätzliches Status-
fenster, in dem der Fortschritt der Übertragung angezeigt wird (Abbildung 7). Ist die Übertra-
gung beendet, so wird die Datei auch in der linken Fensterhälfte angezeigt. Holen Sie sich in
gleicher Art und Weise den Internet Explorer auf Ihren PC.

Sie verlassen das Programm ws_ftp, indem Sie zunächst die Verbindung mit dem FTP-Server
durch Betätigen der Schaltfläche Close beenden und anschließend das Programm über die
Schaltfläche Exit verlassen.
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Abbildung 6: Übertragen des Netscape Navigators Gold 3.01

Abbildung 7: Fortschritt der Übertragung

Die Dateien, die Sie vom FTP-Server übertragen haben, sind Containerdateien, die sich durch
Doppelklick selbst auspacken und installieren.
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2 Adressierung im Web
Internet-Dienste funktionieren auf der Grundlage des TCP/IP-Protokolls, sozusagen dem
Grundwortschatz des Netzes. Darauf aufbauend gehört zu jedem Internetdienst ein eigenes
Protokoll, ein eigener zusätzlicher Wortschatz.  Einige Internetdienste mit der zugehörigen
Protokollbezeichnung finden Sie in der Tabelle gelistet:

Dienst Protokoll
File Transfer File Transfer Protokoll (FTP)
Terminal Emulation Telnet Protokoll
Electronic Mail Simple Mail Transfer Protocol (SMTP)

Post Office Protocol (POP)
Usenet News Network News Transfer Protocol (NNTP)
Gopher Internet Gopher Protocol
World Wide Web Hypertext Transfer Protocol (HTTP)

Server im Internet wie Web-, FTP-, Gopher-, News-, Mail-Server bieten diese Dienste an, die
von Klienten im Internet, beispielsweise von Ihnen mit Ihrem PC, genutzt werden können. Zur
Nutzung eines Dienstes benötigen Sie Klientensoftware wie Mail-Programme, News Reader,
Web-Browser etc., die das entsprechende Zusatzprotokoll des Dienstes beherrschen.

Auf den Servern laufen die Pendants dieser Klientenprogramme (Daemons), die auf sogenann-
ten TCP-Ports auf Anfragen der Klienten „lauschen“.
Eine Besonderheit des World Wide Web ist, daß es alle Dienste vereinigt. Dies bedeutet, daß
Sie mit einem einzigen Anwendungsprogramm, dem Web-Browser, Zugriff auf die Ressourcen
aller Dienste im Internet haben. Die Adressierung im Web trägt dem Rechnung. Ein URL
(Uniform Resource Locator), so werden die Web-Adressen genannt, kann viele verschiedene
Formen annehmen. Uns interessieren hier zunächst drei Formen:

• Will man auf eine Datei eines Web-Servers zugreifen, so hat der URL folgende Form:

http://internet_adresse_des_servers/Dateipfad
http://internet_adresse_des_servers/Verzeichnispfad
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Groß- und Kleinschreibung ist in den Pfadangaben relevant. Fehlt die Angabe zum Datei-
namen, so wird serverabhängig eine Datei mit Standarddateinamen, z.B. Index.html adres-
siert.

Beispiel:

http://www.leo.org/index.htm

Manchmal kann es auch erforderlich sein, den TCP-Port mit anzugeben:

http://www.leo.org:80/index.htm

Auf einem HTTP-Server können Ressourcen beliebiger Art liegen, beispielsweise Doku-
mente in Postscript-, ASCII-Text-, oder Word-Format, oder auch Software im Binär-
Format. Dabei charakterisiert (vereinfacht gesprochen) die Dateinamenserweiterung den In-
halt der Datei. Dateien im Hypertextformat haben stets die Endung .htm oder .html.

• Will man auf Dateien eines anonymen FTP-Servers zugreifen, so hat der URL die Form:

ftp://internet_adresse_des_servers/Dateipfad
ftp://internet_adresse_des_servers/Verzeichnispfad

Groß- und Kleinschreibung in der Pfadangabe sind relevant. Fehlt die Angabe zum Datei-
namen, so wird eine anklickbare Liste der Dateien des adressierten Verzeichnisses im
Browser-Fenster dargestellt.

Beispiel:

ftp://ftp.rz.ruhr-uni-bochum.de/local/web/browser/pc/iexplorer/msie301m95.exe

Auch auf Dateien von FTP-Servern, auf denen man sich als Benutzer validieren muß, kann
man zugreifen. Der URL hat dann die Form:

ftp://userid@internet_adresse_des_servers/Pfad

Der Benutzer wird anschließend nach seinem Paßwort gefragt.

• Auch email  kann man mit Hilfe mancher Web-Browser verschicken. Der URL nimmt dann
die Form an:

mailto:email_adresse

Beispiel:

mailto:Beratung@rz.ruhr-uni-bochum.de

In der Regel öffnet sich dann neben dem Web-Browser-Fenster ein weiteres Fenster, in das
man seinen Brief eingeben kann (Abbildung 8).
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 Abbildung 8: Mailfenster des Netscape

Sollte Ihnen diese Beschreibung zunächst vielleicht noch etwas theoretisch vorkommen, so
wird sich dies sicherlich ändern, wenn Sie einige Zeit im Web „gesurft“ haben. In der folgenden
Beschreibung finden Sie zudem auch weitere Beispiele zur Verwendung der verschiedenen
URLs.
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3 Konfiguration und Nutzung von Web-Browsern
Installieren Sie sich wie oben schon gesagt den Netscape Navigator 3.01 Gold und den Internet
Explorer 3.01 auf Ihrem Arbeitsplatz.

3.1 Netscape 3.01 Gold
Im folgenden finden Sie keine komplette Beschreibung, wie Sie den Netscape Navigator nut-
zen können. Es werden lediglich einzelne Punkte herausgegriffen und näher erläutert. Eine
vollständige Beschreibung des Navigators können Sie über den Menüpunkt Help -> Hand-
book des Netscape Navigators übers Netz abrufen. Eine deutschsprachige Anleitung finden Sie
unter http://home.de.netscape.com/de/eng/mozilla/3.01/handbook/.

3.1.1 Netzkonfiguration

Einstellen einer Home Page
Starten Sie den Netscape Navigator und stellen Sie sich zunächst eine sogenannte Home Page
ein1. Dies ist diejenige Web-Seite, die nach dem Start des Navigators als erste in Ihr Browser-
Fenster geladen wird. Sie können als Startseite beispielsweise die Grundseite (Home Page) der
Ruhr-Universität (http://www.ruhr-uni-bochum.de) verwenden. Zum Einstellen der Startseite
wählen Sie aus dem Navigator-Menü den Punkt Options -> General Preferences ..... und
füllen Sie das Feld Browser Starts With wie in Abbildung 9 angegeben aus.

Abbildung 9: Netscape Home Page

Proxy-Konfiguration

                                               
1 Falls Sie sich über eine Telefonleitung mit dem Internet verbinden, so wird beim Start des Netscape Naviga-
tors automatisch ein Anwahlversuch gestartet. Sie müssen sich zur Konfiguration des Browsers aber nicht un-
bedingt ins Internet einwählen. Unterbrechen Sie gegebenenfalls den Anwahlversuch.
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Die Ruhr-Universität stellt mit dem WWW-Server auch einen Proxy-Server zur Verfügung,
der häufig geholte Seiten zwischenspeichert, damit diese nicht ständig übers Internet neu ge-
holt werden müssen. Um den Proxy-Server zu nutzen, wählen Sie im Netscape Navigator den
Menüpunkt Options -> Network Preferences... und darin die Registerkarte Proxies aus
(Abbildung 10).  Die Proxy Konfiguration kann automatisch erfolgen. Wählen Sie dazu das
Kontrollkästchen Automatic Proxy Configuration und tragen Sie in das Eingabefeld die
Adresse http://www.ruhr-uni-bochum.de/proxy.pac ein.

Abbildung 10: Proxy-Konfiguration

Falls Sie dennoch eine manuelle Proxy-Konfiguration vornehmen wollen, so wählen Sie das
Kontollkästchen Manual Proxy Configuration und anschließend die Schaltfläche View aus.
In die Felder FTP-, Gopher-, HTTP- und Security-Proxy geben Sie jeweils die Adresse
http://www-cache.rz.ruhr-uni-bochum.de ein. In den zugehörigen Port-Feldern tragen Sie die
Portnummer 80 ein. Ins Feld No Proy for geben Sie die Rechneradressen www.ruhr-uni-
bochum.de und www.rz.ruhr-uni-bochum.de durch Komma getrennt ein (siehe Abbildung 11).
Wir empfehlen allerdings, daß Sie eine automatische Proxy-Konfiguration vornehmen sollten.

Abbildung 11: Proxies
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3.1.2 Netscape Cache
Der Netscape Navigator speichert die bereits vom Internet empfangenen Seiten in einem loka-
len Cache auf der Platte Ihres PCs. Die Einstellungen für diesen lokalen Cache können Sie über
den Menüpunkt Options ->Network Preferences ... durchführen. Wählen Sie dazu die Regi-
sterkarte Cache aus (Abbildung 12). Hier können Sie insbesondere dafür sorgen, daß Memo-
ry- und Platten-Cache bereinigt werden. Dies ist normalerweise nur dann erforderlich, wenn
beispielsweise durch Übertragungsfehler defekte Dateien im Cache gelandet sind.

Beim Navigieren im Web schaut der Netscape Navigator zunächst in Ihrem lokalen PC-Cache
nach, ob eine von Ihnen angeforderte Seite bereits vorhanden ist. Dies ist in vielen Fällen auch
wüschenswert, da das Laden der Seite dann erheblich schneller geht. Der Nachteil ist, daß Sie
nicht unbedingt mitbekommen, wenn eine Seite auf dem Server geändert worden ist. Um diese
neue geänderte Seite angezeigt zu bekommen, müssen Sie die Reload Schaltfläche in der
Werkzeugleiste des Browsers klicken. In diesem Fall schaut der Navigator zunächst auf dem
Server nach, ob sich am Dokument etwas geändert hat (z.B. Größe oder Zeitstempel). Erst
wenn dies nicht der Fall ist, wird die Seite aus dem lokalen Cache genommen, andernfalls wird
die Seite neu vom Server übertragen. Es gibt allerdings Situationen, in denen dieses Verfahren
auch nicht klappt, d.h. der Navigator kann letztlich nicht feststellen, daß die Seite auf dem Ser-
ver geändert worden ist. Um in diesem Fall eine Seite mit Sicherheit frisch vom Server zu ho-
len, muß beim Anklicken der Reload-Schaltfläche gleichzeitig die Shift-Taste gedrückt wer-
den.

Wollen Sie eine Seite, die in Ihrem Browser dargestellt wurde, einfach nur „auffrischen“, so
wählen Sie den Menüpunkt View -> Refresh. Die Seite wird dann nochmals neu aus dem lo-
kalen Cache eingelesen.

Abbildung 12: Netscape Cache
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3.1.3 Navigieren auf „einfachen“ Hypertext-Seiten

Durch Eingeben eines URLs (im Beispiel: http://www.leo.org/demap/) in das Feld Location
des Netscape-Navigators veranlassen Sie das Holen des entsprechenden Dokuments in das
Browser-Fenster (Abbildung 13). Die Eingabe muß mit der Return-Taste quittiert werden.
Fehlt eine Angabe zum Dateinamen, so wird serverabhängig eine Standarddatei, z. B. In-
dex.html eingesetzt. Sie können eine Übertragung vorzeitig beenden, indem Sie die Schaltflä-
che Stop der Werkzeugleiste betätigen.

Abbildung 13: Navigieren
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Die letzten 10 Eingaben, die in das Feld Location gemacht worden sind, werden im Pull-Down
Menü des Feldes gespeichert.

In unserem Beispiel sind in der Darstellung des Textes im Browser-Fenster einige Links direkt
zu erkennen. Beispielsweise sind die farbigen, unterstrichenen Textpassagen Anker auf andere
Dokumente. Klicken Sie auf diese Anker, so wird das zugehörige Dokument ins Browser-
Fenster geladen.

Andere Hyperlinks lassen sich nicht so leicht erkennen. Fahren Sie jedoch mit der Maus über
den Hypertext im Browser-Fenster, so sehen Sie, daß der Mauspointer sich an manchen Stellen
zu einer Hand ändert. Alle diese Stellen bezeichnen Anker. In dem in der Abbildung darge-
stellten Hypertext verstecken sich beispielsweise auch hinter den dargestellten Graphiken
(Landkarte, City Net) Anker. Hinter der Landkarte verstecken sich sogar viele verschiedene
Anker. Ein derartiges Bild wird auch als Clickable Image oder verweissensitive Graphik be-
zeichnet. Einzelne Stellen dieses Bildes (Hot Spots) sind besonders ausgezeichnet und entspre-
chen unterschiedlichen Hyperlinks.

Titel- und Statusleiste

Beachten Sie die angenehme Eigenschaft des Netscape Navigators, die URLs der Anker unter
dem Mauszeiger in der Statuszeile des Browsers (Zeile im unteren Fensterrahmen) anzugeben
(Abbildung 13). Oben im Fensterrahmen wird der Titel des Dokumentes angegeben (in unse-
rem Beispiel: Karte deutscher WWW-Server).

Bookmarks

Haben Sie eine Seite im Netz gefunden, deren URL Sie auf keinen Fall verlieren wollen, so
können Sie sich auf diese Seite ein Bookmark (Lesezeichen) setzen. Das Setzen eines
Bookmarks geschieht über den Menüpunkt Options -> Add Bookmarks. Alle Seiten, die Sie
sich auf diese Art „gemerkt“ haben, werden anschließend im Menü Bookmarks angezeigt. In
Abbildung 14 sehen Sie das Ergebnis, wenn ein Bookmark auf die in Abbildung 13 dargestellte
Seite gesetzt wird. Als Bookmark-Bezeichnung wird der Titel der Seite verwendet. Denken
Sie daran, wenn Sie später eigene Web-Seiten gestalten wollen: Geben Sie jeder Seite einen
signifikanten Titel!

Sie veranlassen das Anzeigen einer „gebookmarkten“ Seite im Browser-Fenster, wenn Sie das
zugehörige Lesezeichen aus dem Menü Bookmark auswählen.

Abbildung 14: Bookmarks

Der Netscape-Navigator bietet komfortable Möglichkeiten, Bookmarks zu verwalten. Hier
können Sie dann auch eigene Bezeichnungen für Ihre Bookmarks vergeben. Die Verwaltung
von Bookmarks geschieht über das Bookmark-Fenster. Dies wird angezeigt, wenn Sie den
Menüpunkt Window -> Bookmarks wählen (Abbildung 15). Das Verwalten der Bookmarks
erfolgt menügesteuert über die Menüs File, Edit und Item. Wie dies im einzelnen funktioniert,
wird in der Netscape Dokumentation beschrieben.
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Abbildung 15: Bookmark

History-Liste

Unter dem Menüpunkt Window -> History wird dokumentiert, welche Hypertext-Dokumente
Sie sich bereits haben anzeigen lassen (Abbildung 16). Durch Doppelklicken eines dieser Ein-
träge wird das erneute Laden der entsprechenden Seite in das Browser-Fenster veranlaßt.
Mit Hilfe der Schaltflächen Back und Forward aus der Werkzeugleiste des Browsers können
Sie in dieser History-Liste zurück- oder wieder nach vorne blättern. Die Wirkung dieser
Schaltflächen hängt also von der Reihenfolge ab, in der ein Leser durch die Dokumente hin-
durchgewandert ist. Bei der Gestaltung eigener Seiten sollten Sie berücksichtigen, daß diese
Browser-Schaltflächen daher kein Ersatz für explizite Navigationshilfen auf Ihren Seiten sind,
die das Vorwärts- und Rückwärtsblättern in der von Ihnen angebotenen Dokumentstruktur
ermöglichen. Wir werden zu gegebener Zeit noch darauf zurückkommen. Die History-Liste
wird bei Verlassen des Netscape Navigators gelöscht.

 

Abbildung 16: History-Liste

Laden von Graphiken
Das Laden von Web-Seiten übers Netz dauert häufig sehr lange, insbesondere dann, wenn der
Autor viele schöne hochauflösende Graphiken auf seiner Seite untergebracht hat. Über den
Menüpunkt Options -> Auto Load Images können Sie das Holen der Bilder auf den Seiten
unterdrücken. Ist der Menüpunkt angehakt, so werden Bilder geholt. Fehlt der Haken, so wer-
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den Bilder zunächst nicht geholt. Stattdessen wird ein kleines Ersatzicon vom Navigator an der
Stelle eingesetzt, an der das Bild erscheinen würde (Abbildung 17).

 

Abbildung 17: Auto Laod Images ist abgestellt

Ein Web-Author kann für diesen Fall auch eine gewisse Vorsorge treffen, indem er zu jedem
Bild einen Ersatztext angibt, der angezeigt wird, wenn das Bild nicht geladen werden konnte.
Dieser Ersatztext kommentiert das Ersatzicon, das der Netscape Navigator eingesetzt hat. In
unserem Beispiel wurde vom Autor für die Graphik City Net ein Ersatztext angegeben. Für die
Landkarte wird kein Ersatztext angezeigt.

Auf die meisten Graphiken können Sie verzichten. Selbst wenn eine Graphik als Anker dient,
können Sie in diesem Fall auf den Ersatztext oder das Ersatzicon klicken. Die Landkarte, das
heißt das Clickable Image, ist auf dieser Seite jedoch zur Navigation unerläßlich. Es muß also
geholt werden. Dazu klicken Sie mit der rechten Maustaste auf das Ersatzicon für die Land-
karte. Sie erhalten das in Abbildung 18 dargestellte Kontextmenü. Wählen Sie den Menüpunkt
Load Image und das Bild wird in Ihr Browser-Fenster geholt. Ein zusätzlicher Ersatztext hätte
dem Leser der Seite eine Hilfestellung geben können, ob er das Bild nachladen muß oder nicht.
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Abbildung 18: Kontextmenü

Kontextmenü

Das Aussehen des Kontextmenüs ist, wie der Name schon sagt, vom Zusammenhang abhängig,
in dem es aufgerufen wurde. Das Kontextmenü für ein Objekt rufen Sie auf, indem Sie mit der
rechten Maustaste auf das Objekt klicken. Das Kontextmenü für Links bietet immer auch den
Punkt Open Link in New Browser Window. Wählt man diesen Menüpunkt an, so wird ein
weiteres Netscape-Fenster mit diesem Hyperlink geöffnet. Wenn man in solcher Art navigiert,
verliert man die Ausgangsseite nicht, denn diese bleibt weiterhin im Ursprungsfenster ange-
zeigt.

Ein neues Browser-Fenster kann auch über den Menüpunkt File -> New Web Browser ange-
fordert werden.

Abbildung 19: Bildchen im Web
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Für Autoren werden im Web zahlreiche Bildchen und Texturen zur Verschönerung Ihrer Web-
Seiten angeboten. In Abbildung 19 sehen Sie zum Beispiel die Trennlinien, die im BenBers-
Iconarchiv bereitgehalten werden.
Will man diese Bilder nutzen, so muß man sie sich zunächst auf seinen Rechner herunterladen.
Das Kontextmenü für Links oder Graphiken bietet immer den Menüpunkt Save Link As oder
Save Image As. Wählen Sie diesen Punkt an, so haben Sie die Möglichkeit, die Graphik oder
das Hypertext Dokument im Verzeichnissystem Ihres PCs zu speichern.

3.1.4 Navigieren mit Frames
Mit dem Netscape Navigator 2.0 wurde eine neue, umstrittene Leistung des Browsers einge-
führt, die Frames-Technik. Ein Dokument, das unter Nutzung der Frames-Technik gestaltet
wurde, teilt das Browser-Fenster in weitere Teilfenster (Frameset) auf. In jedem Teilfenster
wird ein separates Hypertext-Dokument dargestellt.
Schauen Sie sich das Beispiel in Abbildung 20 (URL: http://www.ruhr-uni-bochum.de/www-
rz/dezenbbq/Win95/win95_f.html) an. Hier ist das Browser-Fenster in 5 Teilfenster aufgeteilt.
Die beiden Teilfenster am oberen Rand dienen lediglich dazu, ein Logo und einen Titel anzu-
zeigen. Die mittleren beiden Teilfenster haben einen eigenen Rollbalken, um durch die Infor-
mationen, die in dem Teilfenster angezeigt wird, durchblättern zu können. Das linke Teilfenster
fungiert dabei als Menüfenster, das rechte Teilfenster als Anzeigefenster. Klicken Sie auf einen
Anker im Menüfenster, so erhalten Sie entweder ein erweitertes Menü in diesem Fenster oder
es wird das Hypertext-Dokument, auf das der Anker verweist, in dem Anzeigefenster darge-
stellt.

Abbildung 20: Frames
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Jeder Web-Autor hat natürlich seine eigenen Vorstellungen darüber, wieviele Teilfenster er mit
welcher Information füllen möchte. Für den Leser bedeutet dies, daß er sich zunächst in dem
Verweissystem einer solchen Frames-Seite zurechtfinden muß. Hat man dies jedoch einmal
herausgefunden, so ist das Blättern durch derartig gestaltete Web-Seiten in der Regel ganz
komfortabel: Dadurch, daß in der Regel Teilfenster mit Logo-Informationen beim Navigieren
erhalten bleiben, weiß man immer, wo man ist. Ferner hat man über Menüfenster zu jeder Zeit
Zugriff auf alle zu einem Thema angebotenen Informationen. Nachteilig wirkt sich jedoch aus,
daß die Anzeigefenster durch die Unterteilung kleiner geworden sind. Um mit solcher Technik
noch sinnvoll arbeiten zu können, sollte der Leser auf seinem PC daher mindestens eine Gra-
phikleistung von 800 x 600 Bildpunkte (Pixel) zur Verfügung haben.

Das Navigieren mit Frames, wie oben schon dargestellt, ist von der Gestaltung abhängig, die
der Web-Autor vorgenommen hat. Darüberhinaus erfordert das Navigieren mit Frames noch
einige grundsätzlich andere Vorgehensweisen.

• Bookmarks auf Frames
Wählen Sie aus dem Browser-Menü den Punkt Bookmarks -> Add Bookmarks, so wird
ein Bookmark auf diejenige Seite gesetzt, die Sie ganz zu Anfang erhalten haben, als Sie auf
die Seite mit den Frames navigiert sind. Um ein Bookmark auf einen Hypertext, der in ei-
nem einzelnen Frame dargestellt wird, vorzunehmen, müssen Sie den Menüpunkt Add
Bookmark aus dem Kontextmenü benutzen. Sie rufen das Kontextmenü eines Frames auf,
indem Sie mit der rechten Maustaste in den Hintergrundbereich des Frames klicken.

• Frames ausdrucken
Um ein Hypertext-Dokument, das in einem Frame dargestellt wird, zu drucken, klicken Sie
in den betreffenden Frame mit der linken Maustaste und wählen dann den Menüpunkt File -
> Print Frame aus dem Browser-Menü.

• Fames neu laden
Über den Menüpunkt View -> Refresh veranlassen Sie ein Auffrischen desjenigen Frames,
in dem Sie zur Zeit arbeiten, d.h. Sie müssen vorher in den betreffenden Frame geklickt ha-
ben. Durch View -> Reload Frame wird der Browser veranlaßt, nur den Hypertext in dem
aktuellen Frame vom Server neu zu laden. View -> Reload lädt das gesamte Frameset neu.

Falls es nicht ausdrücklich vom Web-Autor unterbunden worden ist, können Sie die Teilfenster
eines Framesets durch Verschieben der Begrenzungsränder in ihrer Größe verändern: Bringen
Sie dazu den Mauszeiger mit der zu verschiebenden Begrenzung zur Deckung. Der Mauszei-
ger verändert sich zu einem Doppelpfeil. Bei gedrückter linker Maustaste ziehen Sie die Be-
grenzung in die gewünschte Richtung.

Achtung: Ein Web-Autor kann auch Framesets gestalten, bei denen die Begrenzungen nicht
sichtbar sind. Wir werden später noch darauf eingehen.

3.1.5 Ausdrucken von Hypertext

Über den Menüpunkt File -> Print (File -> Print Frame) oder die Schaltfläche Print der
Werkzeugleiste können Sie den Ausdruck eines Hypertextdokumentes veranlassen. Einstellun-
gen für die Druckausgabe werden über den Menüpunkt File -> Page Setup vorgenommen
(Abbildung 21). Hier können Sie beispielsweise festlegen, daß Titel und URL des Dokumentes
im Kopf der Druckseite erscheinen.
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Gedruckt wird das Dokument ohne (d.h. mit weißem) Hintergrund. Je nach eingestelltem
Druckertyp kann es zu Problemen führen, wenn die Textfarbe des Dokumentes weiß oder sehr
hell ist. Wählen Sie in diesem Fall im Page Setup Page Options -> Black Text an.
Der Netscape Navigator erlaubt es über den Menüpunkt File -> Print Preview, zunächst eine
Vorschau der Druckausgabe aufzurufen (Abbildung 22).

Abbildung 21: Einrichten der Druckausgabe

Abbildung 22: Druckvorschau
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3.1.6 Quelle des Hypertextdokuments

Abbildung 23: Hypertext Quelle

Wie oben schon beschrieben wurde, besteht ein Hypertextdokument nur aus ASCII-Zeichen ,
d.h. aus lesbaren Zeichen. Neben der Nutzinformation, die der Leser im Browser-Fenster an-
gezeigt bekommt, hat der Web-Autor noch Steueranweisungen (HTML-Anweisungen) in das
Dokument geschrieben. Diese werden nicht angezeigt, sondern vom Browser zur Darstellung
des Dokumentes interpretiert. Als angehender Web-Autor interessieren Sie sich vielleicht für
den HTML-Aufbau eines Dokumentes, das Ihnen im Fenster angezeigt wird. Die Quelle des
Dokumentes können Sie sich durch View -> Document Source (View -> Framesource) an-
zeigen lassen (Abbildung 23).

3.1.7 Benutzerdefinierte Einstellungen

Über das Dialogfenster Options -> General Preferences können Sie weitere persönliche Ein-
stellungen vornehmen. Wählen Sie beispielsweise die Registerkarte Colors. Hier können Sie
einstellen, in welchen Farben Hintergrund, Text und Anker eines Dokumentes erscheinen. Die-
se Farben werden nur dann verwendet, wenn der Autor keine eigene Farbauswahl im Doku-
ment getroffen hat. Hat der Autor eine eigene Farbauswahl im Dokument getroffen, so können
Sie durch Auswahl des Kontrollkästchens Always Use My Colors Overriding Document
dennoch dafür sorgen, daß Ihre Farbauswahl verwendet wird (Abbildung 24). Letzteres ist z.B.
dann nötig, wenn der Web-Autor einen sehr schrillen Hintergrund ausgewählt hat, so daß der
Text möglicherweise nicht gut lesbar ist.
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Abbildung 24: Farbauswahl

Über die Registerkarte Fonts des Dialogfensters Options -> General Preferences können Sie
ferner einen Font auswählen, der für die Darstellung des Textes im Browser-Fenster verwendet
werden soll (Abbildung 25). Sie haben die Möglichkeit, zwei Fonts vorzugeben: einen für
Texte, die aufgrund von HTML-Anweisungen in einem Proportionalfont dargestellt werden,
und einen Font für Texte, die der Browser in einem festen (Schreibmaschinen-) Font darstellt.
Die Fontauswahl geschieht über die Schaltfläche Choose Font.

Abbildung 25: Fontauswahl
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3.1.8 Konfiguration von Viewer Software
Auf einem HTTP-Server (oder FTP-Server) können Ressourcen beliebiger Art liegen, bei-
spielsweise Dokumente in HTML-, Postscript-, ASCII-Text- oder Word-Format, oder Soft-
ware im Binär-Format. Dabei charakterisiert (vereinfacht gesprochen) die Dateinamenserweite-
rung den Inhalt der Datei. Anker in HTML-Dokumenten können auf solche verschiedenartigen
Ressourcen weisen. Klickt man auf einen Anker, so entscheidet der Browser anhand der Na-
menserweiterung der Zieldatei des Ankers, was er mit der Datei macht. Dateinamen, die auf
.htm, .html, .gif, .jpg, .txt enden, werden dabei direkt vom Browser im Browserfenster darge-
stellt. Dateien, die in einem anderen Format vorliegen, beispielsweise Dateien mit Binärsoft-
ware (.exe), Audiodateien (.au), Postscriptdateien (.ps), Worddateien (.doc) usw. kann der
Browser nicht selbst verarbeiten. Er bietet dem Benutzer in diesem Fall an, die Datei zu holen
und lokal auf dem PC zu speichern (Abbildung 26).

Abbildung 26: Ungewöhnliche Links

Die so gespeicherte Software kann der Benutzer dann mit geeigneten Programmen weiterver-
arbeiten. Die meisten Browser bieten die Möglichkeit an, diese Weiterverarbeitungssoftware
(Viewer- oder Helper-Software) direkt zu starten (Pick App ... in Abbildung 26). Hat man
einmal ein Programm im Dialogfeld Pick App... (Abbildung 27) angegeben, so merkt sich dies
der Netscape Browser dauerhaft. Wenn er ein weiteres Mal auf solch eine Datei trifft, so fragt
er den Benutzer nicht mehr, sondern startet direkt die Helper-Software. Dies kann eine sehr
unsichere Sache sein, da man sich so auch leicht Viren aus dem Internet einfangen kann.

 

Abbildung 27: Pick Application

Die Helper-Software kann über den Menüpunkt Options -> General Preferences -> Helpers
konfiguriert werden. Unsere Konfiguration (Abbildung 28) sieht im Augenblick so aus, daß der
Netscape direkt das Programm Winword startet, wenn er eine .doc Datei aus dem Netz emp-
fängt. Will man dies nicht, so wählt man das Kontrollkästchen Unknown: Prompt User, damit
man beim nächsten Mal wieder gefragt wird, was mit der Datei zu tun ist.
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Abbildung 28: Helper Applications

3.1.9 Mail und News Konfiguration
Damit Sie über den Browser auch Email versenden (und empfangen) können, müssen Sie eine
geeignete Mail Konfiguration vornehmen.

Abbildung 29: Mail und News Server
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Dies geschieht über den Menüpunkt Options -> Mail and News Preferences. Füllen Sie die
Registerkarten Servers und Identity unter Berücksichtigung Ihrer persönlichen Angaben wie
unten angegeben aus (Abbildung 29, Abbildung 30).

Abbildung 30: Angaben zur Person

Soweit die Beschreibung einiger Einstellungen des Netscape Navigators.

Aufgabe 1:

Wenn Sie es noch nicht getan haben, so sollten Sie jetzt ein wenig im Web surfen. Im Hinblick
auf Ihre Autorenkarriere macht es Ihnen vielleicht Freude, sich einige Graphiken, die Sie später
in Ihren Dokumenten verwenden können, zu sammeln. Einige schöne Anlaufpunkte, um Gra-
phiken zu finden, sind

• Randy’s Icon Bazar:
http://www.iconbazaar.com/others/

• Das Icon Depot:
http://www.reynoldsenterprises.com/~jpayne/

• Yahoo’s Icon Index:
http://www.yahoo.com/Computers/World_Wide_Web/Programming/Icons

• Der World Wide Web Power Index Icons:
 http://www.webcom.com/html/icons.html

• Die Pixelsight. Sie bietet die Möglichkeit, sich eigene Icons zu gestalten:
http://www.pixelsight.com/PS/pixelsite/pixelsite.html

• Das Clip Art Universe:
http://www.nzwwa.com/mirror/clipart/

• Kitty’s Homeland:
http://www.snowcrest.net/kitty/hpages/

http://www.iconbazaar.com/others/
http://www.reynoldsenterprises.com/~jpayne/
http://www.yahoo.com/Computers/World_Wide_Web/Programming/Icons
http://www.webcom.com/html/icons.html
http://www.pixelsight.com/PS/pixelsite/pixelsite.html
http://www.nzwwa.com/mirror/clipart/
http://www.snowcrest.net/kitty/hpages/
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• Texture Land:
http://home.pages.de/~textureland

• Heikkis Textures:
http://www.medios.fi/heikki/

• Hintergründiges von Netscape
http://home.netscape.com/assist/net_sites/bg/backgrounds.html

• Ressourcen für Web Autoren von Microsoft:
http://www.microsoft.com/activex/gallery/

Die meisten Autoren stellen Ihre Graphiken frei zur Verfügung, wenn sie nicht-kommerziell
genutzt werden. Bitte lesen Sie jedoch die Lizenzbestimmungen der Autoren durch. Viele ma-
chen eine Verwendung Ihrer Graphiken davon abhängig, daß man ein Copyright auf die Seite
setzt, in der man die Graphik verwendet. Dies ist das wenigste, was man tun kann, um sich für
die große Mühe der Autoren zu bedanken.

3.2 Internet Explorer 3.01
Der Internet Explorer ist vom Prinzip in gleicher Art zu bedienen wie der Netscape Navigator,
wobei die Bezeichnungen der Menüpunkte natürlich anders sind. Wir gehen daher die einzel-
nen Punkte, die wir im Rahmen des Netscape Navigators bereits angesprochen haben, hier
noch einmal kurz für den Internet Explorer durch. Dabei wird nur auf die Unterschiede im Me-
nüsystem eingegangen. Weitergehende Informationen können Sie der Online-Hilfe entnehmen,
die zusammen mit dem Browser installiert worden ist. Sie ist über den Menüpunkt Help ->
Help Topics abrufbar.

3.2.1 Werkzeug- und Menüleiste
Starten Sie den Internet Explorer. Auch zur Konfiguration des Internet Explorers benötigen
Sie keinen Kontakt zum Internet. Entsprechende Anwahlversuche sollten Sie abbrechen, gege-
benenfalls auch durch Anklicken des Stop-Symbols in der Werkzeugleiste.
Wenn Sie den Cursor mit dem Begrenzungsbalken zwischen Anzeigefenster und Werkzeuglei-
ste zur Deckung bringen, so verändert sich der Cursor zu einem Doppelpfeil. Durch Ziehen des
Begrenzungsbalkens können Sie das Aussehen der Werkzeugleiste verändern. Machen Sie die
Werkzeugleiste einmal so klein wie möglich (Abbildung 31).

Abbildung 31: Verkleinerte Werkzeugleiste

Durch eine Besonderheit der Werkzeugleiste geht durch das Verkleinern keine Schaltfläche
verloren, die Schaltflächen sind lediglich in Werkzeugbändern verschwunden. Sie erkennen die
Bänder an den kleinen „Griffen“ beispielsweise links vom Wort Address. Wenn Sie auf diese
Griffe klicken, so schiebt sich das zugehörige Menü wieder auf. Werkzeugbänder sind hinter-
einander aufzuklappen, d.h. es darf sich in der Öffnungsrichtung eines Bandes kein weiteres
geschlossenes Band befinden.
Derartig konstruierte Werkzeugleisten werden Sie in Zukunft häufiger finden. Sie sind eine
Neuentwicklung von Microsoft und werden als CoolBar bezeichnet.

http://home.pages.de/~textureland
http://www.medios.fi/heikki/
http://home.netscape.com/assist/net_sites/bg/backgrounds.html
http://www.microsoft.com/activex/gallery/
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Quick Links
Klicken Sie auf den Griff im Menü Links. In diesem Menü finden Sie fünf sogenannte Quick
Links (Abbildung 32). Letztlich sind dies Schaltflächen, über die schnell auf Web-Seiten zuge-
griffen werden kann. Durch Klicken auf einen dieser Quick Links wird die zugehörige Web-
Seite geladen.

Abbildung 32: Quick Links

Welche URLs sich hinter den Quick Links verbergen, können Sie über die Registerkarte Navi-
gation des Menüs View -> Options einstellen (Abbildung 33).

Abbildung 33: Einstellungen für Quick Links

3.2.2 Netzkonfiguration

Einstellen einer Home Page
Rufen Sie im Internet Explorer den Menüpunkt View -> Options auf. Es erscheint ein Dia-
logfeld mit mehreren Registerkarten. Wählen Sie die Registerkarte Navigation und füllen Sie
diese wie in Abbildung 34 angegeben aus. Als Start Page wird http://www.ruhr-uni-bochum.de
eingetragen.

Proxy-Konfiguration
Rufen Sie den Menüpunkt View -> Options auf. Wählen Sie die Registerkarte Connection
und füllen Sie diese wie in Abbildung 35 dargestellt aus.
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Abbildung 34: Home Page

Abbildung 35: Proxy-Konfiguration
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In den Zeilen HTTP, Secure, FTP, Gopher ist jeweils die Adresse www-cache.rz.ruhr-uni-
bochum.de mit der Portnummer 80 einzutragen. Unter Exceptions wählen Sie die Schaltfläche
Do not use proxy for local addresses.

3.2.3 Internet Explorer Cache
Um Einstellungen für den Internet Explorer Cache zu treffen, wählen Sie zunächst wieder den
Menüpunkt View -> Options und anschließend die Registerkarte Advanced. Im Feld Tem-
porary Internet Files wählen Sie die Schaltfläche Settings. Es erscheint das in Abbildung 36
dargestellte Dialogfenster. Die Einstellungen sind natürlich von den Gegebenheiten Ihres PCs
abhängig und entsprechen im allgemeinen nicht den Einstellungen, die Sie in der Abbildung
sehen. Hier können Sie festlegen, wo das Cacheverzeichnis auf der Platte Ihres PCs abgelegt
werden soll (Move Folder). Sie können eine Größe für den Cache vorgeben (Amount of disk
space to use) und den Inhalt des Caches löschen (Empty Folder).

Abbildung 36: Internet Explorer Cache

Über das Feld Check for newer versions of stored pages läßt sich einstellen, wann eine Seite,
die bereits im lokalen Cache vorhanden ist, neu vom Server heruntergeholt wird.
Über die Refresh Schaltfläche der Werkzeugleiste wird stets ein Neuladen der Seite vom Ser-
ver angestoßen.

3.2.4 Navigieren auf „einfachen“ Hypertext-Seiten
Grundsätzlich funktioniert das Navigieren ebenso wie beim Netscape Navigator beschrieben:
Durch Eingeben eines URLs in das Adreßfeld der Werkzeugleiste wird das Holen einer Seite
veranlaßt. Die Eingabe muß mit der Return-Taste quittiert werden. Über die Schaltfläche Stop
läßt sich der Übertragungsvorgang vorzeitig abbrechen. Alle URLs, die Sie in das Adreßfeld
eingegeben haben, finden Sie im Pull-down Menü des Feldes wieder.

Bookmarks
Lesezeichen (Bookmarks) auf eine Seite können Sie durch Aufruf des Menüpunktes Favorites
-> Add to Favorites ... setzen. Alle Seiten, die Sie sich auf diese Art „gemerkt“ haben, finden
Sie im Menü Favorites wieder. Bookmarks können ebenso wie beim Netscape Navigator in



Web-Seiten selbst gestalten  ( Rechenzentrum, Ruhr-Universität Bochum) 35

Verzeichnissen organisiert werden. Rufen Sie dazu das Menü Favorites -> Organize Favori-
tes ... (Abbildung 37) auf. Das Verwalten der Bookmarks erfolgt menügesteuert. Wie dies im
einzelnen funktioniert, wird in der Online Hilfe beschrieben.

Abbildung 37: Bookmark-Verwaltung

History-Liste
Im Menü Go werden diejenigen Seiten dokumentiert, die Sie sich bereits haben anzeigen lassen
(Abbildung 38).

Abbildung 38: History Liste

Diese Liste wird gelöscht, wenn Sie den Internet Explorer verlassen. Der Internet Explorer
führt daneben eine weitere History-Liste. Diese können Sie über den Menüpunkt Go -> Open
History Folder aufrufen. Diese History Liste bleibt auch bei Verlassen des Internet Explorers
erhalten. Sie können festlegen, wie lange ein History Eintrag erhalten bleiben soll. Wählen Sie
dazu den Menüpunkt View -> Options und anschließend die Registerkarte Navigation. Im
Feld History können Sie einstellen, für wieviele Tage ein Eintrag erhalten bleibt. Sie können
ebenfalls ein sofortiges Löschen (Clear History) der History Liste veranlassen (Abbildung 39).
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Dies ist manchmal erforderlich, da die History-Liste sehr viel Platz auf der Platte Ihres PCs
einnehmen kann.

Abbildung 39: Einstellungen für die History-Liste

Laden von Inline Graphiken, Inline Videos und Hintergrundmusik
Der Internet Explorer ist in der Lage, im Browser-Fenster neben Bildern, den sogenannten
Inline Images, auch Inline Videos darzustellen. Daneben kann ein Autor noch eine Hinter-
grundmusik für seine Seite bereithalten, die dann ebenfalls abgespielt wird, wenn der Klienten-
PC über eine Soundkarte verfügt. Das Laden all dieser Ressourcen kann sehr langwierig sein.
Sie können das Holen von Inline Bildern, Inline Videos und Hintergrundmusik unterdrücken.
Dazu wählen Sie den Menüpunkt View -> Options und anschließend die Registerkarte Gene-
ral (Abbildung 40). Im Feld Multimedia können Sie ankreuzen, welche Art Information Sie
sehen oder hören wollen.
Falls ein Bild oder Video nicht geholt wurde, so stellt der Internet Explorer ein Ersatzicon im
Browser-Fenster an der Stelle dar, an der das Bild oder Video erscheinen würde. Nach  Klik-
ken mit der rechten Maustaste auf dieses Ersatzicon öffnet sich ein Kontextmenü. Über den
Menüpunkt Show Picture (Show Video) kann ein Nachladen der entsprechenden Ressource
veranlaßt werden.

Kontextmenü
Der Internet Explorer bietet genau wie der Netscape Navigator reichhaltige Kontextmenüs an.
Ein Kontextmenü wird durch Klicken mit der rechten Maustaste auf ein Objekt angezeigt. Die
Menüpunkte variieren je nachdem, auf welches Objekt man geklickt hat. Das Kontextmenü für
Bilder enthält stets den Menüpunkt Save Picture as ..., über den Sie ein Abspeichern des Bil-
des auf Ihrer lokalen Platte veranlassen können. Das Kontextmenü für Links bietet immer den
Punkt Open in New Window. Wählt man diesen Menüpunkt, so wird ein weiteres Internet
Explorer Fenster mit diesem Hyperlink geöffnet.
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Klicken Sie auf den Hintergrundbereich eines Web-Dokumentes mit der rechten Maustaste, so
enthält das Kontextmenü auch den Menüpunkt Create Shortcut. Über diesen Menüpunkt wird
ein Icon auf Ihrem Desktop erzeugt, das Sie anklicken können, um später den Internet Ex-
plorer direkt mit dieser Seite zu starten.

Abbildung 40: Unterdrücken von Multimedia Effekten

3.2.5 Navigieren mit Frames
Die grundsätzliche Vorgehensweise beim Navigieren mit Frames gleicht der des Netscape Na-
vigators.

• Bookmarks auf Frames
Wählen Sie aus dem Browser-Menü den Menüpunkt Favorites -> Add to Favorites, so
wird ein Bookmark auf die Seite gesetzt, die den Frameset enthält.
Um einen Bookmark auf einen Hypertext zu setzen, der in einem einzelnen Frame angezeigt
wird, muß man aus dem entsprechenden Kontextmenü den Punkt Add to Favorites aus-
wählen.

• Frames Ausdrucken
Um ein Hypertext-Dokument, das in einem Frame dargestellt wird, zu drucken, klicken Sie
in den betreffenden Frame mit der linken Maustaste und wählen anschließend den
Menüpunkt File -> Print aus dem Browser Menü.

• Frames neu Laden
Über die Schaltfläche Refresh der Werkzeugleiste veranlassen Sie ein Neuladen des ge-
samten Framesets. Wollen Sie nur einen einzelnen Frame neu laden, so müssen Sie den
Punkt Refresh des entsprechenden Kontextmenüs verwenden.
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3.2.6 Ausdruck von Hypertext

Über den Menüpunkt File -> Print oder die Schaltfläche Print der Werkzeugleiste veranlassen
Sie das Ausdrucken eines Hypertext-Dokumentes bzw. einen Ausdruck des aktuellen Frames.
Über den Menüpunkt File -> Page Setup können Sie Einstellungen für die Druckausgabe vor-
nehmen (Abbildung 41).

Abbildung 41: Einstellungen  für die Druckausgabe

Über die Schaltfläche Headers/Footers erhalten Sie ein Dialogfenster (Abbildung 42), in dem
Sie vorgeben können, welche Information in Kopf- und Fußzeile der Druckseiten erscheinen
soll.

Abbildung 42: Kopf- und Fußzeile

In Abbildung 43 sehen Sie, welche Angaben möglich sind. &u bedeutet beispielsweise, daß an
diese Stelle der Kopf- oder Fußzeile der URL der Seite ausgegeben wird.
Eine Vorschau der Druckausgabe, wie sie der Netscape Navigator anbietet, gibt es beim Inter-
net Explorer nicht.
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Abbildung 43: Mögliche Angaben fürs Dailogfeld Headers/Footers

3.2.7 Quelle des Hypertextdokumentes

Über den Menüpunkt View -> Source können Sie sich die Quelle des angezeigten Hypertext-
Dokumentes anzeigen lassen. Um die Quelle eines Dokumentes angezeigt zu bekommen, das in
einem Frame eines Framesets angezeigt wird, müssen Sie den entsprechenden Menüpunkt des
Kontextmenüs verwenden.

3.2.8 Benutzerdefinierte Einstellungen

Über die Registerkarte General des Dialogfensters View -> Options können Sie weitere per-
sönliche Einstellungen für die Darstellung der Dokumente im Browserfenster vornehmen
(Abbildung 44). Der Internet Explorer läßt einem dabei allerdings nicht soviel Freiraum wie der
Netscape Navigator.

Abbildung 44: Persönliche Farb- und Fonteinstellungen
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Im Feld Colors und Links können Sie einstellen, in welcher Farbe Text, Links und Hinter-
grund der Dokumente angezeigt werden sollen. Diese Einstellungen haben allerdings nur dann
Wirkung, wenn vom Autor einer Seite keine eigenen Einstellungen getroffen worden sind.
Über den Menüpunkt View -> Fonts können Sie unter fünf verschiedenen Fontgrößen
(Largest, Large, Medium, Small, Smallest) für die Darstellung des Textes im Browserfenster
wählen.

3.2.9 Konfiguration von Viewer Software
Hat man durch Mausklick eine Datei aus dem Internet geholt, die der Internet Explorer nicht
selber verarbeiten kann, so erhält man das in Abbildung 45 dargestellte Dailogfenster: Der In-
ternet Explorer fragt, ob er die Datei auf der Platte des PCs sichern soll oder ob er ein
Hilfsprogramm zur Verarbeitung der Datei starten soll.

Abbildung 45: Ungewöhnliche Links

Abbildung 46: Konfiguration von Viewer-Software
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Anders als der Netscape Navigator erlaubt es der Internet Explorer auch, ausführbare Dateien
(.exe) aus dem Browser heraus auszuführen. Dies ist beispielsweise die einfachste Art, um eine
neue Version des Internet Explorers zu installieren.
Hilfsprogramme können über das Menü View-> Options -> Programs konfiguriert werden.
Wählen Sie dazu die Schaltfläche File Types. Sie erhalten das in Abbildung 46 dargestellte
Dialogfenster. Zur Konfiguration wählt man sich zunächst denjenigen Dateityp aus der Liste
aus, den man bearbeiten möchte und betätigt anschließend die Schaltfläche Bearbeiten. Man
erhält das in Abbildung 47 dargestellte Dailogfenster2.

Abbildung 47: Konfiguration von Viewer-Software

Ist die Schaltfläche Öffnen nach dem Herunterladen bestätigen aktiviert, so startet der
Browser die Hilfs-Applikation für den betreffenden Dateityp nicht automatisch, sondern fragt
erst an, ob er dies tun soll.

Aufgabe 2:

Benutzen Sie einen Web-Browser dazu, sich die Zusatzmaterialien, die Sie zur Bearbeitung des
im folgenden beschriebenen Web-Projektes benötigen, zu holen. Wählen Sie dazu die Seite
http://www.ruhr-uni-bochum.de/www-rz/wojcibbw/WebBuch/ an. Dort finden Sie weitere
Instruktionen.

                                               
2 Die Zuordnung von Dateitypen zu Applikationen ist eine Leistung des Windows-Betriebssystems. Über die
Menüpunkte des Internet Explorers gelangt man in diese Betriebssystem-Dialogfenster hinein.
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4 Web-Seiten selbst gestalten
Das Web-Projekt wurde Anfang 1989 am Europäischen Zentrum für Teilchenphysik (CERN)
entwickelt. Idee bei dem Projekt war, die vielfältig vorhandenen Ressourcen (Dokumente,
Programme, Bilder ..) in komfortabler Weise für Nutzer zugänglich zu machen. Das Projekt
wurde weltweit begeistert aufgenommen und entwickelte sich explosionsartig. Erste-Hand-
Informationen zum Stand des Projektes erhält man über das WWW (W3)-Konsortium
(http://www.w3.org/).
Ein Dokument im Web hat einen speziellen Aufbau: Es besteht aus Nutzinformation, die dem
Leser im Browser-Fenster präsentiert wird, und aus Steueranweisungen für den Browser, die
dieser zur Gestaltung des Dokuments nutzt. Die Steueranweisungen sind in der sogenannten
Hypertext MarkUp Language (HTML) zu verfassen.
Zur Gestaltung eines Web-Dokumentes benötigt ein Autor zunächst einmal kein spezielles
Programm. Man benötigt lediglich einen ASCII-Editor wie den Notepad-Editor unter Win-
dows. Mit Hilfe des Editors können Nutztext und geeignete HTML-Anweisungen, die auch
Tags genannt werden, in eine Datei eingetragen werden. Hypertext-Anweisungen werden in
spitze Klammern <...> eingeschlossen und haben einen genau definierten syntaktischen und
semantischen Aufbau. Anders ausgedrückt: Ein Browser interpretiert alles, was zwischen spit-
zen Klammern steht, als Anweisung für sich. Kann ein Browser eine solche Anweisung nicht
interpretieren, weil sie beispielsweise syntaktisch falsch ist, so schmeißt er sie einfach weg.
Nun ist es sehr mühsam für einen Autor, sich die gesamte Syntax der Anweisungen merken zu
müssen. Es gibt daher zahlreiche Web-Editoren, die einem die Sache erleichtern. Man kann im
Grunde zwei Arten von Editoren unterscheiden:
Zunächst einmal gibt es erweiterte ASCII-Editoren, die ein Menüsystem anbieten, mit dessen
Hilfe man HTML-Tags in sein Dokument einbauen kann. Das hat mehrere Vorteile, zum einen
spart man Schreibarbeit, des weiteren sind die so eingesetzten Tags syntaktisch richtig. Auch
beim semantischen Aufbau helfen derartige Editoren, indem sie sich beispielsweise einfach
weigern, Tags an Stellen einzufügen, an denen sie nicht stehen dürfen. Ein Autor muß bei
Verwendung derartiger Editoren jedoch zuvor gute Kenntnisse über die HTML-Anweisungen
und deren Verwendung erworben haben.
Ein anderer Ansatz sind Wysiwyg (What you see is what you get)-Editoren. D.h. ein Web-
Autor muß sich nicht mehr um die Syntax der Tags kümmern. Er ediert sein Dokument menü-
gesteuert in einer Art, wie er es von einem Textverarbeitungsprogramm gewohnt ist. Das Er-
gebnis seiner Tätigkeit wird ihm im Editorfenster gleich in solcher Art präsentiert, wie sein
Dokument von einem Web-Browser dargestellt würde. Der Netscape-Editor ist ein solcher
Wysiwyg-Editor. Wir werden ihn in dieser Kurzeinführung zur Gestaltung einiger Web-Seiten
verwenden. Wie Sie später sehen werden, kommt man leider auch bei derartigen Editoren nicht
umhin, gewisse Grundkenntnisse über die HTML-Tags zu erwerben: Sei es, um Fehler auszu-
bauen, oder um Leistungen zu erreichen, die über das Menüsystem des Editors nicht abrufbar
sind.

4.1 Hypertext MarkUp Language
Wie jede Programmiersprache entwickelt sich HTML entsprechend den Bedürfnissen der Nut-
zer weiter. Tatsächlich ist ein richtiger „Kleinkrieg“ darüber entstanden, welche neuen Ele-
mente in die Sprache aufgenommen werden. Die Hersteller der Web-Browser, federführend
Netscape, Microsoft und SUN, überschlagen sich mit Erweiterungen, die dann natürlich nur ihr
Browser verstehen kann. Die Diskussionen um die Richtung der Weiterentwicklungen werden
vom W3-Konsortium geleitet. Da man als Web-Autor seine Dokumente nicht nur für einen
bestimmten Browser schreiben möchte, ist eine Standardisierung der HTML-Anweisungen
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unerläßlich. Im November 1995 wurde der erste Standard HTML 2.0 festgelegt. HTML 2.0
umfaßt nur einen winzigen Bruchteil derjenigen Sprachelemente, die heutzutage in Web-
Dokumenten verwendet werden. Beispielsweise wird durch diesen Standard noch nicht festge-
legt, wie HTML-Anweisungen zum Aufbau von Tabellen aussehen müssen. Die Verabschie-
dung neuer Standards gestaltet sich mühsam, denn zu viele haben mittlerweile ein Interesse am
Web-Projekt. Als aktueller Standard wurde HTML 3.2 am 14. Januar 1997 beschlossen. Der
Netscape Navigator 3.01 und der Internet Explorer 3.01 „verstehen“ im wesentlichen alle An-
weisungen, die HTML 3.2 umfaßt. HTML 3.2 definiert bereits den Aufbau von Tabellen. Die
Syntax der Anweisungen zur Frameset-Gestaltung und vieles andere mehr werden von diesem
Standard jedoch nicht behandelt.
Will man sich als Web-Autor nicht auf den schmalen HTML 2.0 Sprachumfang beschränken,
so muß man stets im Auge behalten, welche Sprachelemente man verwendet. Auch ein reiner
Web-Leser wird von dieser Entwicklung nicht verschont: Sehr viele Dokumente im Web nut-
zen HTML-Anweisungen, die „alte“ Browser nicht mehr verstehen. Dadurch sind die Leser
gezwungen, sich regelmäßig neue Versionen der Browser zu beschaffen. Wohl dem, der dafür
nichts bezahlen muß!

4.2 Einrichten der Entwicklungsumgebung
Wenn Sie Web-Seiten im Internet publizieren wollen, so müssen diese Web-Seiten von einem
Web-Server verwaltet werden. Mitglieder der Ruhr-Universität können Ihre Web-Seiten über
die Server des Rechenzentrums publizieren.
Während der Entwicklung der Web-Seiten benötigen Sie noch keinen Zugriff auf einen Web-
Server. Auch nicht zur Kontrolle des Ergebnisses Ihrer Arbeit, denn wie sich ein Web-
Dokument präsentiert, entscheidet der Browser allein. Der Internet-Explorer und der Netsca-
pe-Navigator bieten die Möglichkeit, lokale Dokumente, die im HTML-Format verfaßt worden
sind, darzustellen. Werden in den Dokumenten Verweise auf andere Ressourcen verwendet, so
können die Browser auch damit umgehen, wenn die Pfadangaben relativ zum Pfad des HTML-
Dokuments erfolgen, das den Verweis enthält (siehe unten). Somit können Sie Ihre Web-Seiten
ohne Internetanschluß entwickeln. Um die folgenden Beispiele zu bearbeiten, sollten Sie sich
ein leeres Verzeichnis (z. B. Webstart) auf einem Laufwerk Ihres PCs anlegen, in das Sie
die von Ihnen entwickelten Dokumente ablegen. Ist die Entwicklung der Web-Seiten beendet,
so übertragen Sie diese anschließend per FTP in Ihr Verzeichnis auf dem Web-Server zur Pu-
blikation.

4.3 Die Home Page: Das Holsteiner Tee & Gewürz Kontor
Bevor  wir weitere theoretische Betrachtungen anstellen, wollen wir jetzt die ersten Web-
Seiten selbst gestalten: Das Holsteiner Tee&Gewürz-Kontor möchte seine Produkte übers
Internet anbieten. Wir werden hierzu eine Startseite (Home Page) mit Firmeninformationen,
einige Seiten mit Preislisten und ein Bestellformular erstellen. Anhand dieses Beispiels werden
Sie den Umgang mit dem Netscape Editor kennenlernen Am Ende jedes Abschnitts wird der
syntaktische und semantische Aufbau der verwendeten HTML-Tags beschrieben. Der Beginn

dieses Teils wird jeweils mit dem Symbol  gekennzeichnet. Neben der Beschreibung der
Syntax der verwendeten HTML-Sprachelemente finden Sie hier auch weitere Hintergrundin-
formationen sowie Tips und Tricks.
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4.3.1 Grundgerüst einer HTML-Datei

Starten Sie den Netscape-Editor: Dies kann über den Menüpunkt File -> New Document ->
Blank des Netscape Navigators geschehen. Das Browser-Fenster bleibt erhalten und es öffnet
sich ein zusätzliches Editor Fenster.
Durch Eingabe des Kommandos netscape -edit läßt sich der Editor ohne Umweg über
den Netscape Browser starten. Sie können dieses Kommando unter Windows 95 beispielswei-
se durch Aufruf des Dialogfensters Start -> Ausführen eingeben. Noch einfacher ist es, wenn
Sie sich für dieses Kommando ein Icon auf den Desktop ablegen. Wie dies geht, entnehmen Sie
bitte Ihrer Windows Dokumentation. Nach dem Start des Editors erhalten Sie das in Abbildung
48 dargestellte Fenster.

Abbildung 48: Leeres Dokument im Netscape Editor

Innerhalb des Anzeigefensters des Editors können Sie den Text für Ihr Web-Dokument einge-
ben. Über das Menü Insert werden HTML-Tags eingefügt. Sie sehen diese Tags nicht direkt,
sondern nur ihre Auswirkung auf die Darstellung des Dokuments. Das Menü Properties dient
zur weiteren Spezifizierung von Eigenschaften der HTML-Tags. Auf einzelne Punkte dieser
Menüs wird im weiteren Verlauf der Einführung ausführlich eingegangen. Zur Vereinfachung
der Bedienung sind einige Leistungen über die Schaltflächen der Werkzeugleisten abrufbar. Sie
sehen im Bild (Abbildung 48) drei Werkzeugleisten:

• zur Zeichenformatierung
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• zur Absatzformatierung

• und für allgemeine Befehle

Sollte eine dieser Leisten bei Ihnen nicht angezeigt werden, so können Sie dies über den
Menüpunkt Options -> Show Edit/File Toolbar, Options -> Show Character Format
Toolbar und Options -> Show Paragraph Format Toolbar ändern. Sie können die Werk-
zeugleisten per Drag & Drop an eine beliebige Stelle Ihres Bildschirms ziehen.
Bringen Sie den Mauszeiger mit einer der Schaltflächen zur Deckung, so wird in der Status-
zeile des Editors am unteren Bildrand eine kurze Information zur Funktion der Schaltfläche
ausgegeben.
Zur weiteren Vereinfachung der Bedienung des Editors kann jederzeit ein Kontextmenü abge-
rufen werden. Dazu klicken Sie mit der rechten Maustaste auf das zu bearbeitende Objekt.

Beginnen wir jetzt mit der Arbeit. Zunächst rufen Sie den Menüpunkt Properties -> Docu-
ment auf. Sie erhalten ein Dialogfenster. In diesem wählen Sie die Registerkarte General und
füllen sie wie in Abbildung 49 angegeben aus. Quittieren Sie dann mit OK.

Abbildung 49: Titel und Meta-Information
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Geben Sie Ihrem Dokument jetzt auch einen Namen, indem Sie es unter erste.htm in Ih-
rem Verzeichnis Webstart speichern. Wie bei Windows-Programmen üblich, geschieht dies
über File -> Save as.
Vielleicht fragen Sie sich, was Sie eigentlich speichern sollen, denn im Anzeigefenster des
Editors hat sich noch nichts geändert. Wenn Sie aufmerksam waren, so haben Sie aber bereits
festgestellt, daß Ihr Dokument jetzt einen Titel „Holsteiner Tee&Gewürz-Kontor“ hat, der in
der Titelleiste des Editors angezeigt wird. Schauen Sie sich das Dokument im Netscape-
Browser an. Sie können dazu den Menüpunkt File -> Open File in Browser des Netscape-
Navigators verwenden. Öffnen Sie die Datei erste.htm. Dieser Vorgang läßt sich durch

Verwendung der Netscape-Editor Schaltfläche  vereinfachen (Abbildung 50).

Tatsächlich besteht Ihr HTML-Dokument bereits aus einer ganzen Reihe von Zeilen. Sie kön-
nen dies erkennen, wenn Sie sich die Quelle des Dokumentes anzeigen lassen. Wählen Sie dazu
den Menüpunkt View -> View Document Source. Sie erhalten die in Abbildung 51 darge-
stellte Auflistung.

Ausgabe:

Abbildung 50: Ansicht des ersten Dokuments im Netscape Bowser
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Eingabe:

Abbildung 51: Quelle des ersten Web-Dokuments

Der Netscape-Editor hat das Grundgerüst eines leeren HTML-Dokuments automatisch für Sie
erzeugt. Das gesamte Dokument ist in die Tags <HTML> ...</HTML> eingeschlossen. Darin
geschachtelt finden Sie den Dokumentkopf <HEAD> ...</HEAD> und den Dokumentkörper
<BODY> ... </BODY>. Die Information, die der Web-Browser im Browser-Fenster anzeigt,
ist innerhalb des Dokumentkörpers einzugeben.

Titel
Im Dokumentkopf finden Sie den Titel, den der Web-Browser in der Titelleiste anzeigt, sowie
zusätzliche Meta-Information. Der Titel ist in die Tags <TITLE> ... </TITLE> eingeschlos-
sen. Zeilen, die mit <! beginnen, sind Kommentarzeilen.

Meta-Information
Meta-Information dient unter anderem dazu, das Dokument näher zu qualifizieren. Derartige
Information kann beispielsweise von Suchmaschinen benutzt werden, um das Dokument zu
indizieren. Welche Meta-Information spezifiziert wird, bleibt dem Autor überlassen.

Sonderzeichen
Dokumente werden im Internet weltweit bereitgestellt. Unter diesen Bedingungen findet man
die unterschiedlichsten Zeichensätze vor. Insbesondere die Sonderzeichen (z.B. die Umlaute)
der nationalen Zeichensätze wirken sich dabei störend aus. Damit ein Dokument überall gleich
aussieht, werden Sonderzeichen in den HTML-Dokumenten durch Ersatzzeichenfolgen um-
schrieben. Diese beziehen sich auf den international standardisierten ISO-Latin-1 Zeichensatz.
Beachten Sie beispielsweise das ü von Gewürze im Titel unseres Dokumentes. Es wird durch
die Ersatzzeichenfolge &uuml; beschrieben.
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Einige Zeichen werden von den Web-Browsern als Steuerzeichen interpretiert. Dies sind die
Zeichen <, >, &, ". Will man diese Zeichen in einem Dokument verwenden, so muß man eben-
falls zur Ersatzdarstellung greifen. Dies ist z.B. beim & Zeichen im Titel unseres Dokumentes
geschehen. Es wird durch &amp; umschrieben. Der Netscape-Editor fügt automatisch die
Ersatzdarstellungen ein, wenn ein Autor ein Sonderzeichen über die Tastatur eintippt. Bequem,
nicht wahr? Eine Liste der Sonderzeichen und deren Ersatzdarstellung finden Sie in Tabelle 8
des Anhangs.

4.3.2 Absatzformatierungen
Schließen Sie das HTML-Quellfenster wieder und kehren Sie zum Netscape Editor zurück.
Wir wollen jetzt einige Informationen in den Körper (Anzeigefenster) unseres Dokumentes
einfügen. Es soll nachher wie in Abbildung 53 angegeben aussehen.

Einfügen von Überschriften
Zur Formatierung von Überschriften stehen die Absatzformate Heading1 - Heading6 zur
Kennzeichnung von 6 verschiedenen Überschriftenebenen zur Verfügung (Abbildung 52). Sie
können diese Formate aus dem Pull-down Menü der Absatz-Werkzeugleiste auswählen.

Abbildung 52: Absatzformate

Zum Einfügen der ersten Überschrift in unser Dokument klicken Sie nun in das Editor-Fenster.
Wählen Sie aus dem Pull-Down Menü der Absatz-Werkzeugleiste das Format Heading 1 aus.
Geben Sie als Überschrift Holsteiner Tee&Gewürz-Kontor ein und beenden Sie die Eingabe
mit der Return-Taste. Der Cursor wird in die nächste Zeile positioniert und ein neuer Para-
graph im Format Normal begonnen. Jedesmal, wenn Sie die Return-Taste betätigen, wird
(ähnlich wie bei den anderen Textverarbeitungsprogrammen unter Windows) ein neuer Para-
graph begonnen. Innerhalb eines Paragraphen wird automatisch vom Editor (wie auch später
vom Browser) umgebrochen. Die Breite des Paragraphen wird dabei optimal an die Breite des
Anzeigefensters angepaßt.

Eingeben eines Absatzes
Geben Sie den folgenden Text zur Beschreibung der Firma im Absatzformat Normal als
Fließtext (d.h. ohne Paragraphenumbruch) ein:
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Willkommen beim Holsteiner Tee&Gewürz-Kontor. Wir sind eine traditionsreiche Firma im
Herzen von Nieder-Kuckuckstätt. Unser Geschäft wurde 1723 gegründet und ist seither in
Familienbesitz. Wie führen ein ausgesuchtes Angebot an hochwertigen Tees und Gewürzen
sowie Accessoires rund um das Teegenießen. Wir freuen uns auf Ihren Besuch in unserem
Hauptgeschäft an der Hauptstrasse von Nieder-Kuckuckstätt. Unsere Firma möchte jedoch
auch diesen elektronischen Weg nutzen, um unsere Produkte weltweit anzubieten. Unser
Angebot finden Sie in den folgenden Listen beschrieben:

Beenden Sie den Absatz durch Betätigen der Return-Taste.
Versuchen Sie einmal, mehrere aufeinanderfolgende Leerzeichen einzugeben: Es geht nicht.
Dies hat auch einen guten Grund: Mehrere aufeinanderfolgende Leerzeichen werden in HTML-
Dokumenten wie ein Leerzeichen behandelt.
Nachträgliche Korrekturen im Text können wie bei allen Textverarbeitungsprogrammen üblich
durch Einfügen oder Überschreiben vorgenommen werden. Die letzte Änderung kann über den
Menüpunkt Edit -> Undo zurückgenommen werden.

Einfügen einer Liste

Wir wollen jetzt eine unnumerierte Liste erzeugen. Wählen Sie dazu die Schaltfläche  aus.
Es erscheint der erste Listenpunkt. Geben Sie die drei Listenpunkte Teeliste, Gewürzliste, Ac-
cessoires ein. Ein neuer Listenpunkt wird durch Betätigen der Return-Taste erzeugt. Die Liste
wird beendet, indem Sie zunächst einen weiteren leeren Listenpunkt erzeugen und dann die

Schaltfläche  betätigen.

Eingeben eines weiteren Absatzes
Geben Sie einen weiteren Abstz im Format Normal mit folgendem (Fließ-) Text ein:

Sie können alle unsere Produkte über das folgende Bestellformular Online anfordern. Die
Lieferung erfolgt innerhalb von 6-10 Werktagen. Die Bezahlung der ersten Bestellung muß per
Nachname erfolgen. Weitere Bestellungen können gegen Rechnung ausgeführt werden:

Beenden Sie den Abstz durch Betätigen der Return-Taste.

Einfügen einer weiteren Liste
Fügen Sie eine weitere Liste mit einem einzigen Listenpunkt „Bestellformular“ ein.

Einfügen einer Seitenunterschrift
Komplettieren Sie die Seite durch eine Unterschrift:

Wir freuen uns auf Ihre Bestellung.
Alfred Ingwersen und Familie

Jede Zeile soll dabei in einem neuen Paragraphen erscheinen.

Abspeichern der Arbeit

Speichern Sie Ihre Arbeit durch Betätigen der Schaltfläche .
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Schauen Sie sich das Dokument im Netscape-Navigator an. Sie sollten das in Abbildung 53
dargestellte HTML-Dokument erzeugt haben.

Ausgabe:

Abbildung 53: Ausgabe des ersten Dokuments im Nescape Navigator (erste.htm)
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Eingabe:

Abbildung 54: HTML-Quelle des ersten Dokuments
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Dies ist Ihr erstes Web-Dokument. Bevor wir uns an die Verschönerung machen, wollen wir
uns die HTML-Tags anschauen, die wir bisher bereits verwendet haben. Schließen Sie den
Netscape-Navigator und kehren Sie zum Netscape-Editor zurück. Schauen Sie sich die Quelle
Ihres Dokumentes an (View -> View Document Source). Sie ist in Abbildung 54 abgebildet.

HTML-Sprachelemente haben im allgemeinen den Aufbau <tagname attribut=wert ...>.Viele
der HTML-Sprachelemente, die sogenannten Container-Elemente, bestehen aus einem An-
fangs- und einem Endtag. Das Endtag hat die Form </tagname> und kann entfallen, wenn der
Browser aus dem Kontext das Ende einer Struktur erkennen kann. Tags können in Groß- oder
Kleinbuchstaben geschrieben werden. Die meisten der Sprachelemente können geschachtelt
werden.
Der Autor kennzeichnet durch die HTML-Tags, in welchen Formaten der durch die Tags ge-
rahmte Text vom Browser dargestellt werden soll. Über die endgültige Formatierung von
Überschriften, Absätzen, Listen usw. entscheidet der Browser aber nach eigenen Vorstellun-
gen. Er legt Font, Fontgröße, Zeilenabstand, Einzug und Abstand zum umgebenden Text fest.
Ein HTML-Dokument kann daher bei Verwendung verschiedener Browser auch unterschied-
lich aussehen. Innerhalb eines Absatzes wird der Zeilenumbruch automatisch vom Browser
vorgenommen, wobei die Zeilenlänge möglichst optimal an die Breite des Anzeigefenster an-
gepaßt wird. Mehrere aufeinanderfolgende Leerzeichen in der HTML-Quelle werden vom
Browser wie ein Leerzeichen behandelt. Auch ein Zeilenumbruch in der HTML-Quelle wird
wie ein Leerzeichen behandelt und führt damit nicht unbedingt zu einem Zeilenumbruch im
Browserfenster. Mit HTML 3.2 werden zu den meisten Sprachelementen Attribute definiert.
Durch Verwendung der Attribute hat der Autor etwas mehr Einfluß auf die Darstellung der
Objekte im Browser-Fenster. Attribute zu Sprachelementen werden im Netscape Editor durch
Properties-Dialoge angesprochen. Wir gehen darauf später noch ein.
Tags zu Erzeugung von Überschriften, Paragraphen, Listen sind sogenannte blockformatie-
rende Elemente (block level elements). Sie erzeugen immer einen Absatzumbruch im
Browserfenster. Im Gegensatz dazu gibt es auch textformatierende Elemente (text level ele-
ments), die zur Formatierung einzelner Zeichen im laufenden Text dienen. In den Tabellen im
Anhang finden Sie die meisten dieser Elemente mit einer kurzen Erläuterung gelistet. Werfen
Sie einen kurzen Blick auf diese Tabellen.

Überschriften
Eine Überschrift wird in die Tags <Hx> ... </Hx> eingeschlossen. Für x steht eine Ziffer von 1
bis 6, die 6 verschiedene Überschriftenebenen kennzeichnet.

Paragraphen
Jeder Absatz (Paragraph) eines HTML-Dokumentes wird in die Tags <P> ...</P> eingeschlos-
sen.

Ungeordnete Listen
Eine ungeordnete Liste wird in die Tags <UL> ... </UL> eingeschlossen. Jeder neue Listen-
punkt innerhalb der Liste wird in die Tags <LI>... </LI> eingeschlossen.

4.3.3 Weitere Absatz- und Textformatierungen, Verweise
Wir wollen nun Verschönerungen an unserem HTML-Dokument vornehmen. Unser Text soll
nachher wie in Abbildung 59 dargestellt aussehen. Dabei werden Sie eine Reihe weiterer
HTML-Tags und Attribute zur Modifizierung der Tags kennenlernen.
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Einfügen horizontaler Linien
Zunächst soll die Überschrift durch eine Trennlinie vom übrigen Text abgesetzt werden. Dies
geht sehr leicht. Positionieren Sie den Cursor ans Ende der Überschrift. Eine horizontale Linie

in Standardformat fügen Sie mit Hilfe der Schaltfläche  ein. (Sie können auch den
Menüpunkt Insert ->Horizontal Line verwenden.) Eine horizontale Trennlinie wird zwischen
Überschrift und erstem Paragraphen dargestellt. Klicken Sie mit der rechten Maustaste auf die
Linie. Es öffnet sich ein Kontextmenü. Wählen Sie aus diesem Menü den Punkt Horizontal
Line Properties aus. Sie erhalten das in Abbildung 55 abgebildete Dialogfenster. Hier können
Sie die Attribute für die Linie ändern. Attribute sind Liniendicke (Height), Linienlänge
(Width), Ausrichtung (Align) und 3D-Shading. 3D-Shading bedeutet, daß die Linie mit einer
Schattierung umgeben wird. Die Liniendicke ist stets in Anzahl Bildpunkte (Pixel) anzugeben,
die Linienlänge kann in Anzahl Bildpunkte oder als prozentualer Anteil der Breite des Anzei-
gefensters angegeben werden. Sie können die Linie durch Auswahl eine der Align Schaltflä-
chen linksbündig, zentriert oder rechtsbündig ausrichten.

Abbildung 55: Linienattribute

Ändern Sie die Linienlänge auf 75% der Länge des Anzeigefensters und zentrieren Sie die Li-
nie. Speichern Sie Ihre Arbeit. Fügen Sie eine zweite Trennlinie der Länge 75% vor die Seiten-
unterschrift „Wir freuen uns ...“ ein.

Ausrichten von Absätzen
Absätze können über den Paragraph/List Properties-Dialog (oder auch über die entspre-
chenden Schaltflächen der Absatz-Werkzeugleiste) ausgerichtet werden: Zur Zentrierung der
Überschrift unseres Dokumentes klicken Sie mit der rechten Maustaste auf die Überschrift.
Wählen Sie den Kontext-Menüpunkt Paragraph/List Properties und dann die Registerkarte
Paragraph aus. Sie erhalten das in Abbildung 56 dargestellte Dialogfenster. Wählen Sie im
Feld Align die Schaltfläche Center. Die Überschrift erscheint nun zentriert
Richten Sie die Dokumentenunterschrift „Alfred Ingwersen und Familie“ nach dem gleichen
Verfahren rechtsbündig aus.

Schriftstil und Schriftgröße
Zur Veränderung von Schriftstil, Schriftgröße und Schriftfarbe einzelner Textpassagen dient
der Character Properties-Dialog: Der Autor „Alfred Ingwersen“ soll kursiv und in etwas
größerer Schrift gesetzt werden. Markieren Sie dazu bei gedrückter linker Maustaste den Text.
Klicken Sie mit der rechten Maustaste auf den markierten Text und wählen Sie den Menüpunkt
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Character Properties. Wählen Sie im Feld Style den Typ Italic und im Feld Size die Größe 1
aus (Abbildung 57).
Einige Textformatierungen können Sie vielleicht etwas schneller über den Menüpunkt Proper-
ties -> Character des Editors vornehmen. Für die am häufigsten gebrauchten Formatierungen
bietet auch die Zeichenformatierungs-Werkzeugleiste Schaltflächen an.

Abbildung 56: Paragraph Attribute

Abbildung 57: Text Eigenschaften

Einfügen von „sanften“ Zeilenumbrüchen
Damit die Überschrift nicht so lang ausfällt, wollen wir sie hinter „Holsteiner“ umbrechen.
Wir können dies tun, indem wir den Cursor hinter dieses Wort plazieren und die Return-Taste
betätigen. Wie oben schon erwähnt wurde, beginnt der Netscape Editor bei Betätigen der Re-
turn-Taste stets einen neuen Absatz. Schauen Sie in die Quelle des Dokumentes (View ->
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View Document Source). Aus der Überschrift sind zwei Überschriften geworden. Daraus
erklärt sich auch der große Zeilenabstand, denn der Browser fügt zwischen Blockstrukturen
einen größeren Abstand ein.
Machen Sie Ihre Formatierung durch Anwahl des Menüpunktes Edit -> Undo rückgängig.
Es gibt ein HTML-Sprachelement, das einen „sanften“ Zeilenumbruch bewirkt, d. h. einen
Zeilenumbruch, ohne daß ein neuer Absatz begonnen wird. Positionieren Sie den Cursor wie-
der hinter das Wort „Holsteiner“ und wählen Sie den Menüpunkt Insert -> New Line Break.
Schauen Sie sich die Quelle des Dokumentes an. Sie besteht jetzt aus einer Überschrift, die
durch das Sprachelement <br> umgebrochen wird. Der Zeilenabstand sieht jetzt auch schöner
aus.

Einfügen von lokalen Verweisen
In unserem Text verheißen wir dem Leser einige Listen, in denen er Informationen über unsere
Produkte finden kann. Angenommen, wir hätten diese Listen bereits als HTML-Dokument mit
den Namen tee.htm, gewuerz.htm, access.htm, bestell.htm formatiert.
Durch Einfügen von geeigneten Verweisen (Anker, Links) in unser Dokument kann der Leser
diese Informationen auf Knopfdruck anfordern. Der Leser soll beispielsweise durch Anklicken
des Wortes Teeliste das Dokument tee.htm angezeigt bekommen.
Markieren Sie dazu das Wort Teeliste. Klicken Sie mit der rechten Maustaste in den markier-
ten Bereich. Wählen Sie den Menüpunkt Create Link Using Selected ... aus. Sie erhalten das
in Abbildung 58 dargestellte Dialogfenster.

Abbildung 58: Anker

Geben Sie in das Feld Link to a page... den Namen der Datei an, auf die Sie verweisen wollen.
Quittieren Sie mit OK. Zurück im Editorfenster sehen Sie, daß das Wort Teeliste nun blau und
unterstrichen dargestellt wird. Dies zeigt dem Leser an, daß er auf dieses Wort klicken kann,
um sich ein neues Dokument anzeigen zu lassen. Achtung: Unsere Anker funktionieren noch
nicht, denn dazu müssen wir erst die notwendigen anderen Dokumente erstellen.
Fügen Sie nach dem gleichen Verfahren Anker für die beiden anderen Listen und das Bestell-
formular ein. Speichern Sie Ihre Arbeit. Wenn Sie nachträglich noch etwas an den Verweisen
ändern wollen, so klicken Sie einfach mit der rechten Maustaste auf den Verweis und wählen
Sie aus dem Kontextmenü Link Properties aus.
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Ihr Dokument sollte nun das in Abbildung 59 angegebene Aussehen haben.

Ausgabe:

Abbildung 59: Zweites Dokument (zweite.htm)
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Eingabe:

Abbildung 60: Quelle von zweite.htm
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Schauen wir uns wieder an, welche HTML-Sprachelemente vom Netscape-Editor in unsere
Quelle eingefügt worden sind (Abbildung 60).

Horizontale Linien
Zur Erzeugung der horizontalen Linien (hinter der Überschrift und vor der Dokumentenunter-
schrift) hat der Netscape Editor die HTML-Anweisung <HR WIDTH="xx%"> eingefügt.
Die vollständige Syntax des <hr>-Tags finden Sie in Tabelle 2 des Anhangs beschrieben. Die
Angabe zum Alignment (align=center) fehlt. Fehlt eine Angabe zum Alignment, so werden
horizontale Linien standardmäßig zentriert.

Ausrichten von Textelementen
Zur horizontalen Ausrichtung gibt es zu vielen HTML-Sprachelementen, die Blockstrukturen
definieren,  das Attribut align (align=left, align=center, align=right). Zur Zentrierung der
Überschrift benutzt der Netscape Editor das Attribut align=center des <hx>-Tags: <H1
align=center>....</h1>
Zur rechtsbündigen Ausrichtung der Dokumentenunterschrift verwendet der Netscape Editor
nicht das entsprechende Attribut align=right des <p>-Tags. Stattdessen verwendet er ein neu-
es HTML-Sprachelement <div align=...>...</div>. Textpassagen, die in dieses Tag einge-
schlossen werden, werden vom Browser gemäß der Angabe zu align ausgerichtet.

Schriftstil und Schriftgröße
Zur Veränderung des Schriftstils stehen eine Reihe von HTML-Tags zur Verfügung. Sie finden
diese in Tabelle 3 des Anhangs gelistet. Der Name „Alfred Ingwersen“ wurde hier durch das
Sprachelement <I> ... </I> kursiv gesetzt.
Zur Veränderung der Fontgröße wurde das Sprachelement <font size=..>...</font> eingesetzt.
Die Browser kennen sieben verschiedene Fontgrößen 1 - 7. Die Fontgrößen entsprechen dabei
nicht absoluten Größen in Pixel: Der Font der Größe 3 entspricht dem Defaultfont. Dies ist
derjenige Font, den der Leser als Basisfont für sich eingestellt hat3.  Die Fonts 4-7 sind dann
abgestuft jeweils ein bißchen größer als der Defaultfont, die Fonts 1-2 abgestuft jeweils ein
bißchen kleiner (Abbildung 61).
Im <font>-Tag kann die Größe in absoluten Zahlen von 1-7 angegeben werden oder in relati-
ven Zahlen +größe, -größe. Relative Zahlen beziehen sich stets auf den Defaultfont, d.h. +3
bedeutet 3 Stufen größer als der Defaultfont. Der Netscape Editor benutzt zur Formatierung
der Fontgrößen relative Angaben.
Zur Formatierung des Namens „Alfred Ingwersen“ beispielsweise hat der Netscape Editor fol-
gendes HTML-Tag eingefügt: <FONT SIZE=+1>Alfred Ingwersen</FONT>.

Beachten Sie, daß Sie über diese Fontgrößen keinen „absoluten“ Einfluß auf die Darstellung
der Schrift im Browserfenster nehmen können, denn sie sind stets relativ zu dem im Browser
eingestellten Font zu verstehen. Mit anderen Worten: Der Autor verfügt damit nicht über die
Möglichkeit, im Browserfenster eine Schriftgröße von z.B. exakt 12 Punkten zu erzwingen. Im
Augenblick gibt es Diskussionen über sogenannte Style-Sheet-Sprachelemente, die hier Abhilfe
schaffen können. Style Sheets (gemäß dieser Definition) werden im Augenblick nur vom Inter-
net Explorer unterstützt.

                                               
3 Menüpunkt : Options -> General Preferences -> Font -> Choose Font des Netscape Navigators; Menüpunkt
View ->Fonts des Internet Explorers
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Abbildung 61: Fontgrößen

Schriftart
Über das HTML-Sprachelement <font face=..> ... </font> kann ein Autor eine Schriftart ex-
plizit auswählen: Beispielsweise durch <font face=“comic sans ms“> .... </font> läßt sich ein
Absatz in der Schriftart Comic Sans Ms setzen. Voraussetzung ist, daß dieser Font auf dem
System des Lesers installiert ist. Fehlt der Font, so wird der Standardfont zur Darstellung ge-
nutzt. Eigens für diese Fälle werden bei Installation des Internet Explorers auf einem System
standardmäßig auch die folgenden Fonts installiert:

Verdana, Verdana Bold, Verdana Italic, Verdana Bold Italic
Arial, Arial Bold, Arial Italic, Arial Bold Italic
Times New Roman, Times New Roman Bold, Times New Roman Italic, Times New Roman
Bold Italic
Comic Sans Ms, Comic Sans Ms Bold,
Arial Black und
Impact

Das face Attribut ist kein Bestandteil des HMTL 3.2 Standards. Es wird vom Netscape
Browser und vom Internet Explorer interpretiert. Dieses Attribut kann über das Menüsystem
des Netscape Editors nicht gesetzt werden. Möchten Sie die Schriftart Ihres Dokumentes ver-
ändern, so müssen Sie ein entsprechendes <font>-Containertag mit einem ASCII-Editor in Ihre
Quelle einfügen. In Abbildung 62 sehen Sie eine Darstellung unserer Seite, wobei als Schriftart
Comic Sans Ms gewählt wurde.

„Sanfte“ Zeilenumbrüche
Innerhalb eines Absatzes werden die Zeilenumbrüche vom Browser selbsttätig vorgenommen
und dabei der Größe des Anzeigefensters angepaßt. Ein Zeilenumbruch kann durch das
HTML-Sprachelement <BR> erzwungen werden. Dies ist in der Überschrift unseres Doku-
mentes geschehen.
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Abbildung 62: Font Face Comic Sans MS

Verweise
Die Stärke von Hypertext Dokumenten ist, daß sich der Leser ausgehend von einer Seite wei-
tere Seiten durch Mausklick auf Anker anzeigen lassen kann. Ein Anker wird durch das
HTML-Sprachelement <a href=“...“>Verweistext</a> gesetzt. In unserem Dokument sind
die Teeliste, die Gewürzliste, die Accessoires und das Bestellformular Verweistexte auf andere
Dokumente. Statt eines Verweistextes kann auch ein Bild als Ankerpunkt verwendet werden
(siehe unten).
Die Angabe zu href ist eine Methode, die beschreibt, wie auf ein weiteres Dokument zuge-
griffen werden soll. Liegt das Dokument auf dem gleichen Webserver wie die Startseite, die
den Verweistext enthält, so kann hier eine relative oder absolute Pfadangabe zur betreffenden
Datei stehen. Relative Pfadangaben beziehen sich immer auf das Verzeichnis, in dem das Do-
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kument liegt, das den Anker enthält. Liegt das Dokument auf einem anderen Server im Inter-
net, so muß unter href ein vollständiger URL stehen.

Beispiele:

<a href=“tee.htm“>Teeliste</a> ist ein Verweis mit relativer Pfadangabe. Der Server sucht
die Datei tee.htm im Verzeichnis des referenzierenden Dokuments.

<a href=“../listen/tee.htm“>Listen</a> ist ein Anker mit relativer Pfadangabe. Um das Do-
kument zu suchen, muß zunächst in der Verzeichnishierarchie eine Stufe heraufgegangen wer-
den (..) und anschließend in das Verzeichnis listen gewechselt werden.

<a href=“/www-public/dezenbbq/Webstart/liste.htm“>Liste</a> ist ein Anker mit absolu-
ter Pfadangabe. Die Pfadangabe erfolgt ausgehend vom Wurzelverzeichnis / des Servers.

<a href=“http://www.leo.org/index.htm“>Home Page von Leo</a> ist ein Anker auf ein
Dokument eines anderen Web-Servers im Internet.

Innerhalb eines Projektes sollten Sie stets relative Pfadangaben verwenden. Dies ermöglicht,
daß Sie die gesamte Verzeichnisstruktur verschieben können, ohne etwas an den Pfadangaben
in Ihren Dokumenten ändern zu müssen. Beispielsweise können Sie so Ihr Projekt zunächst auf
dem PC entwickeln und anschließend die gesamte Verzeichnisstruktur auf den Server übertra-
gen.
Ein Anker muß nicht immer auf ein HTML-Dokument verweisen. Hinter einem Anker kann
sich eine Datei in beliebigem Format verstecken.

4.3.4 Einfügen von Verweisen auf Ressourcen anderer Server
Als Service für den Leser wollen wir unten auf unsere Seite einen Anker auf die Home Page
des Schleswig Holstein Musik Festivals einfügen. Der URL ist http://www.shmf.de/.
Fügen Sie am Ende des Dokuments (hinter die Dokumentenunterschrift) eine horizontale
Trennlinie ein. Wählen Sie den Menüpunkt Insert -> Link und füllen Sie das Dialogfenster wie
in Abbildung 63 dargestellt aus. Quittieren Sie mit OK. Der Anker soll linksbündig ausgerich-
tet erscheinen.

Die meisten Web-Autoren ermöglichen den Lesern, ihnen Anmerkungen und Kommentare per
email zukommen zu lassen. Komfortabel ist es, wenn man als Leser ein solches email-Fenster
mit richtiger Adresse auf Mausklick vorgelegt bekommt. Auch dies läßt sich über Anker reali-
sieren. Bei der Besprechung der Web-Adressen haben Sie gesehen, daß ein URL auch die
Form mailto:email_adresse annehmen kann. Diesen URL benutzen wir in einem An-
ker. Der Autor unseres Web-Dokumentes „Alfred Ingwersen“ soll dabei als Verweistext die-
nen. Markieren Sie den Namen. Klicken Sie mit der rechten Maustaste in den markierten Be-
reich. Wählen Sie den Menüpunkt Create Link Using Selected. Füllen Sie das Dialogfenster
wie in Abbildung 64 angegeben aus. (Die email Adresse ist natürlich fiktiv. Falls Sie später Ihre
Arbeit testen wollen, so setzen Sie hier Ihre eigene email Adresse ein.)
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Abbildung 63: Anker ins Netz

Abbildung 64: Mailto Anker

Speichern Sie Ihre Arbeit. Schauen Sie sich die Seite im Netscape Navigator an. Probieren Sie
die beiden neuen Anker aus. Während Sie Anker mit relativen Pfadangaben (d.h. Anker auf
lokale Ressourcen) ohne Netzanschluß testen können, benötigen Sie natürlich zum Test von
Ankern „ins Internet“ einen Netzanschluß: Sie wollen ja auch etwas von einem entfernten Ser-
ver. In unserem Fall vom Server www.shmf.de und vom Mailhost, der Ihren Brief weiterleiten
soll.
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Zusamenfassung
Einen Anker „ins Netz“ setzt man durch Angabe eines vollständigen URLs.

Beispiel:
<a href=“http://www.shmf.de“>Schleswig Holstein Musik Festival</a>

Als Service für den Leser kann sich auf Klicken eines Ankers auch ein email-Fenster öffnen.
Der URL hat in diesem Fall die Form mailto:email_adresse

Beispiel:
<a href=“mailto:Alfred.Ingwersen@teeladen.de“>Alfred Ingwersen</a>

4.3.5 Ein Kessel Buntes
Unsere Seite wirkt mit der schwarzen Schrift auf grauem oder weißem Hintergrund ein wenig
trist. Die Darstellung hängt genauer gesagt von den Einstellungen ab, die der Leser in seinem
Browser getroffen hat. Wir wollen sie jetzt etwas farbiger gestalten.

Hintergrund- und Textfarben einstellen
Wählen Sie im Netscape Editor den Menüpunkt Properties -> Document und in dem folgen-
den Dialogfenster die Registerkarte Appearance. Hier können Sie einstellen, welche Farbe der
Hintergrund Ihres Dokumentes hat und in welchen Farben normaler Text und Verweistext er-
scheint (Abbildung 65).

Abbildung 65: Hintergrund- und Textfarben

Der Verweistext kann in drei verschiedenen Farben erscheinen, je nachdem, ob ein Link bereits
angeschaut wurde (followed link), ob er gerade aktiv ist (active link), oder noch nicht ange-
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klickt wurde (link). Wählen Sie über die Schaltfläche Background einen dunkelbraunen Hin-
tergrund für unser Dokument aus (Abbildung 66).

Abbildung 66: Farbauswahl

In dem Dialogfenster zur Farbauswahl können Sie unter 48 Grundfarben auswählen. Darüber-
hinaus können Sie weitere Farben definieren4. Klicken Sie dazu auf die Schaltfläche Farben
definieren. Es öffnet sich ein erweitertes Dialogfenster wie in Abbildung 67 dargestellt.

Abbildung 67: Farben definieren

Hier können Sie weitere Farben für die Farbpalette Benutzerdefinierte Farben auswählen.
Die Farbe können Sie durch Anklicken aus dem Spektrum, oder durch Eingabe der HSB-
(Hue, Saturation, Brightness) oder RGB-Farbwerte bestimmen. Bevor Sie die Farbentöne zu
filigran nuancieren bedenken Sie, daß es Leser gibt, die nur 16 oder 256 verschiedene Farbtöne
darstellen können.
Wählen Sie über die Schaltflächen Normal Text, Link Text, Active Link Text und Followed
Link Text passende Farbtöne für die Textelemente aus. Etwa einen Gelbton für den normalen

                                               
4 Diese Funktion ist abhängig vom verwendeten Betriebssystem.
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Text und Orange- und Grüntöne für die Verweistexte. Nun ja, jeder hat hier so seine eigenen
Vorstellungen. Quittieren Sie mit OK und speichern Sie Ihre Arbeit. Das Dokument sieht so
schon etwas imposanter aus (Abbildung 68). Leider sind die Trennlinien nicht mehr gut sicht-
bar. Wir werden dies später ändern.

Abbildung 68: Coloriertes Dokument

Schriftfarben einzelner Textpassagen
Im Bild sehen Sie, daß auch die Farben und Größe einzelner Textpassagen verändert werden
können. Beispielsweise wurde der erste Buchstaben jedes Paragraphen in einer anderen
Schriftfarbe und Schriftgröße gesetzt. Um dies zu formatieren, markieren Sie den Buchstaben,
klicken mit der rechten Maustaste in den markierten Bereich und wählen aus dem Kontextme-
nü Character Properties aus. Wählen Sie im folgenden Dialogfenster eine Textfarbe (color)
und Größe (size) aus (Abbildung 69).
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Abbildung 69: Fontgröße und Fontfarben

Hintergrundmuster einstellen
Als Hintergrund können Sie auch eine beliebige Textur (ein Muster im gif-oder jpg-Format)
wählen. Das Muster wird vom Browser so oft nebeneinander und untereinander gesetzt, bis der
gesamte Hintergrund des Anzeigefensters gefüllt ist. Wir wollen hier das Hintergrundmuster
aus der Datei sack.jpg (aus den Zusatzhilfsmitteln) verwenden. Kopieren Sie diese Datei in
das Web-Verzeichnis auf Ihrem PC.
Rufen Sie jetzt wieder den Document Properties Dialog auf (Menüpunkt: Properties ->
Document). Aktivieren Sie im Dialogfenster das Kontrollkästchen Use Image (Abbildung 70)
und geben Sie in das Eingabefeld sack.jpg als Hintergrundtextur ein. Quittieren Sie mit
OK. Das Hintergrundbild ist zwar nicht sehr unruhig, dennoch sind die Trennlinen nicht mehr
gut sichtbar. Dies werden wir im nächsten Schritt ändern.

Einfügen von Bildern
Web-Browser können auch Graphiken zusammmen mit dem Text im Browser-Fenster darstel-
len. Diese Bilder nennt man Inline Images. Die meisten Browser können Inline Images im gif-
oder jpg-Format verarbeiten. Wir wollen solch ein Bild (bar1p.gif) nun als Trennlinie ver-
wenden. Kopieren Sie das Bild (aus den Zusatzhilfsmitteln) in Ihr Web-Verzeichnis. Entfernen
Sie jetzt zunächst die bereits zuvor eingefügten Trennlinien. Markieren Sie dazu die Trennlinie
durch Anklicken mit der linken Maustaste und drücken Sie die ENTF-Taste. Das erste Bild
fügen wir zwischen Überschrift und erstem Paragraphen ein. Klicken Sie dazu ans Ende der
Überschrift und betätigen Sie die Return-Taste. Der Cursor sollte jetzt in der Mitte einer leeren
Zeile blinken. Wählen Sie den Menüpunkt Insert -> Image. Sie erhalten das in Abbildung 71
dargestellte Dialogfenster. Geben Sie in das Feld Image File Name den Namen der Datei ein,
die das Bild enthält. In das Feld Alternative representations/ Text können Sie einen alternati-
ven Text eingeben, der angezeigt wird, wenn das Bild vom Browser nicht geladen werden
konnte. Die weiteren Einstellungen, die über dieses Dialogfenster getroffen werden können,
finden Sie in Abschnitt 4.3.6 und Abschnitt 4.3.7 beschrieben.



Web-Seiten selbst gestalten  ( Rechenzentrum, Ruhr-Universität Bochum) 67

Nach dem gleichen Verfahren fügen Sie das Bild als Trennlinie vor der Dokumentenunter-
schrift „Wir freuen...“ ein. Sorgen Sie auch hier durch Betätigen der Return-Taste dafür, daß
das Bild in eine leere Zeile eingefügt wird. Das Bild erscheint nicht zentriert. Um das Bild zu

zentrieren, markieren Sie es und klicken Sie die Schaltfläche .
Fügen Sie ein weiteres zentriertes Trennlinien-Bild hinter die Dokumentenunterschrift ein. Sie
sollten jetzt das in Abbildung 72 dargestellte Dokument erzeugt haben.

Abbildung 70: Hintergrundtextur

Abbildung 71: Inline Images
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Ausgabe:

Abbildung 72: Drittes Dokument (dritte.htm)



Web-Seiten selbst gestalten  ( Rechenzentrum, Ruhr-Universität Bochum) 69

Eingabe:

Abbildung 73: Quelle des dritten Dokuments
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Jetzt machen wir wieder einen Ausflug zu den HTML-Sprachelementen, die wir verwendet
haben (Abbildung 73).

Hintergrund-, Text- und Verweistextfarbe
Das HTML-Sprachelement <body..> kann um Attribute erweitert werden, über die eine Hin-
tergrund-, Text- und Verweistextfarbe für das Dokument eingestellt werden kann. Zur farbli-
chen Gestaltung unseres Dokumentes, die wir in unserem Beispiel über das Menüsystem vor-
genommen haben, hat der Netscape Editor folgendes <body> Tag in das Dokument eingefügt:

<BODY TEXT="#FFFF80" BGCOLOR="#643200" LINK="#FFFF00" VLINK="#FF8000"
ALINK="#FF8040">

Im <body>-Sprachelement können Farben für den Hintergrund (bgcolor), den „normalen“
Text (text), sowie für Anker (link), bereits besuchte Anker (vlink) und aktive Anker (alink)
gesetzt werden.

Farben werden in der Regel als sechsstellige hexadezimale Zahlen in der Form #rrggbb ange-
geben. Jeweils zwei hexadezimale Ziffern charakterisieren 256 verschiedene Farbnuancen in rot
(rr), in grün (gg) und in blau (bb). Am einfachsten läßt sich der hexadezimale Wert einer Farbe
durch Hilfsprogramme, sogenannte Color Wizards ermitteln. Ähnlich wie im Farben-
Dialogfenster des Netscape Editors (Abbildung 66) wählt man eine Farbe anhand einer Palette
aus. Das Programm zeigt dann den zugehörigen RGB-Wert an. Farben können auch über
Verwendung spezieller Farbnamen angegeben werden. Browser, die dem HTML 3.2 Standard
genügen, verstehen auch folgende Farbnamen:

Farbname RGB Wert Farbname RGB-Wert
black #000000 green #008000
silver #c0c0c0 lime #00ff00
gray #808080 olive #808000
white #ffffff yellow #ffff00
maroon #800000 navy #000080
red #ff0000 blue #0000ff
purple #800080 teal #008080
fuchsia #ff00ff aqua #00ffff

Diese Farben kann jeder VGA-Bildschirm darstellen.
Der Netscape Navigator und der Internet Explorer verstehen darüberhinaus weitaus mehr
Farbnamen:

Alicebluem, antiquewhite,*aqua*, aquamarine, azure, beige, bisque, *black*, blanche-
dalmond, *blue*, blueviolet, brown, burlywood, cadetblue, chartreuse, chocolate, coral,
cornflowerblue, cornsilk, crimson, cyan, darkblue, darkcyan, darkgoldenrod, darkgray,
darkgreen, darkkhaki, darkmagenta, darkolivegreen, darkorange, darkorchid, darkred,
darksalmon, darkseagreen, darkslateblue, darkslategray, darkturquoise, darkviolet, deep-
pink, deepskyblue, dimgray, dodgerblue, firebrick, floralwhite, forestgreen, *fuchsia*,
gainsboro, ghostwhite, gold, goldenrod, *gray*, *green*, greenyellow, honeydew, hot-
pink, indianred, indigo, ivory, khaki, lavender, lavenderblush, lawngreen, lemonchiffon,
lightblue, lightcoral, lightcyan, lightgoldenrodyellow, lightgreen, lightgrey, lightpink,
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lightsalmon, lightseagreen, lightskyblue, lightslategray, lightsteelblue, lightyellow,
*lime*, limegreen, linen, magenta, *maroon*, mediumaquamarine,mediumblue, mediu-
morchid, mediumpurple, mediumseagreen, mediumslateblue, mediumspringgreen, medi-
umturquoise, mediumvioletred, midnightblue, mintcream, mistyrose, moccasin, navajo-
white, *navy*, oldlace, *olive*, olivedrab, orange, orangered, orchid, palegoldenrod,
palegreen, paleturquoise, palevioletred, papayawhip, peachpuff, peru, pink, plum, pow-
derblue, *purple*, *red*, rosybrown, royalblue, saddlebrown, salmon, sandybrown,
seagreen, seashell, sienna, *silver*, skyblue, slateblue, slategray, snow, springgreen,
steelblue,tan,*teal*, thistle, tomato, turquoise, violet, wheat, *white*, whitesmoke,
*yellow*, yellowgreen

Farbnamen können Sie beim Netscape Editor nicht angeben. Sie können jedoch Farbwerte im
erweiterten Farbdialog (Abbildung 67) auswählen.
Bedenken Sie, daß es viele Leser gibt, deren Bildschirmkarte nur 256 verschiedene Farben
darstellen kann. Das heißt, nur eine bestimmte Auswahl von RGB-Werten kann auf diesen
Bildschirmen exakt getroffen werden. Farben, die zu anderen RGB-Werten gehören, werden
von den Browsern mehr oder weniger gut angenähert. Auf Farbbildschirmen mit 256 Farben
werden Farben mit RGB-Werten  FF, CC, 99, 66, 33, 0 (dezimal Werte: 255, 204, 153, 102,
51, 0) exakt dargestellt. Ein Beispiel für einen solchen Farbwert ist # 996600. Weitere Infor-
mationen zur Farbauswahl findet man über die Thalia Color Page (http://www.sci.kun.nl/tha-
lia/guide/color/).

Hintergrundmuster
Sie können den Hintergrund Ihres Dokuments auch mit einer Textur verschönern. Als Hinter-
grundtextur kann ein Muster im gif-oder jpg-Format verwendet werden.
In unserem Beispiel haben wir das Hintergrundmuster aus der Datei sack.jpg verwendet.
Das zugehörige <body>-Sprachelement sieht wie folgt aus:

<BODY TEXT="#FFFF80" BGCOLOR="#800000" LINK="#FF8040" VLINK="#00FF00"
ALINK="#FF8040" BACKGROUND="sack.jpg">

Hinter background ist ein Dateipfad (oder URL) anzugeben. In unserem Beispiel sucht der
Navigator die Datei sack.jpg im gleichen Verzeichnis, in dem auch das HTML-Dokument
liegt. Groß- und Kleinschreibung ist in Pfadangaben relevant.

Fontfarben
Abweichend von der allgemeinen Einstellung der Text-Farbe im <body>-Tag können einzelne
Textpassagen anders „eingefärbt“ werden. Dies ist in unserem Beispiel mit den „Initialen“ der
Absätze vorgenommen worden. Das <font>-Sprachelement besitzt das Attribut color, über das
die Farbe des Textes eingestellt werden kann. Die farbliche Einfärbung des Initials „W“ in un-
serem ersten Absatz geschieht auf folgende Weise:

<FONT COLOR="#FF8040"><FONT SIZE=+3>W</FONT></FONT>

Beide <font>-Tags hätten auch zusammengefaßt werden können:

<FONT SIZE=+3 COLOR=“FF8040“>W</FONT>
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Inline Images
Als Trennlinen haben wir in unserem Text sogenannte Inline Images verwendet. Dies sind Gra-
phiken im gif- oder jpg-Format, die der Browser zusammen mit dem Text im Browserfenster
anzeigt. Sie können zur Auflockerung der Seite dienen. Inline Images werden über das <img>-
Tag in ein Hypertext-Dokument eingefügt. In unserem Beispiel wurde folgendes Sprachele-
ment eingefügt:

<IMG SRC="bar1p.gif" ALT="Trennlinie" HEIGHT=20 WIDTH=544>

Hinter src ist eine Methode anzugeben, die angibt, wie der Browser die Datei finden kann, in
der die Graphik abgelegt ist. Liegt die Datei auf dem lokalen Web-Server, so ist dies ein abso-
luter oder relativer Dateipfad. Liegt die Datei auf einem anderen Server im Internet, so ist hier
ein URL anzugeben. Graphikdateien sollten man stets auf dem lokalen Server ablegen.
Das Attribut alt gibt an, welcher Alternativtext im Browserfenster erscheint, wenn die Graphik
nicht geladen werden konnte.
Die Attribute height und width beschreiben die Ausmaße, das heißt Breite und Höhe, der
Graphik in Pixel. Diese Angabe kann entfallen. Der Browser ermittelt dann beim Laden der
Datei die entsprechende Größe. Dies führt dazu, daß der Ladevorgang länger dauert und der
Text im Browserfenster springt, bis die Graphik endgültig fertiggestellt ist. Daher sollte man
diese Größe möglichst angeben. Der Netscape Editor ermittelt automatisch die passende Grö-
ße für width und height einer Graphik und setzt diese in das Tag ein (Abschnitt 4.3.6).
Für width und height können auch absichtlich andere Größen als die tatsächlichen Ausmaße
der Graphik angegeben werden. Die Graphik wird dann entsprechend gestreckt oder gestaucht.
Unter Berücksichtigung der Übertragungsgeschwindigkeiten im Netz sollten Sie Graphiken nur
sparsam verwenden (Faustregel: nicht mehr als 30 K). Verwenden Sie eine Graphik mehrmals
auf einer Seite, so muß sie nur einmal übers Netz geladen werden. Bei Wiederverwendung
kann der Browser sie anschließend aus seinem lokalen Cache holen.
Verzichtet man jedoch ganz auf Graphiken, so wird eine Web-Seite sehr schnell langweilig.

4.3.6 Dimensionierung von Graphiken im Netscape Editor
Klicken Sie mit der rechten Maustaste auf eine der eingefügten Trennlinienbilder und wählen
Sie den Kontextmenüpunkt Image Properties. Sie erhalten das in Abbildung 74 dargestellte
Dialogfenster. Der Netscape Editor hat beim Einfügen der Graphik automatisch deren Abmes-
sungen in Bildpunkten ermittelt und in das Feld Dimensions eingesetzt. Wählt man für width
und height andere Größen als diese Originalabmessungen des Bildes, so wird das Bild entspre-
chend gestreckt oder gestaucht. Über die Schaltfläche Original Size kann jederzeit die Origi-
nalgröße wiederhergestellt werden.
Über das Feld Space around image läßt sich der Abstand des Bildes zum umgebenden Text
einstellen. Ferner kann über das Feld Solid Border eingestellt werden, daß ein zusätzlicher
Rahmen um das Bild gezeichnet wird. Dazu muß Solid Border auf einen Wert größer als 0
gesetzt werden. Dieses Attribut ist laut HTML Standard nur dann auszuwerten, wenn das Bild
als Ankermarkierung dient (Abschnitt 4.3.12). Mit anderen Worten, wird der zusätzliche Rah-
men nur dann angezeigt, wenn das Bild als Anker fungiert. Im Gegensatz hierzu interpretiert
der Netscape Navigator das Attibut immer.
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Achtung:
Der Netscape Editor setzt manchmal beim Einfügen von Bildern absolute statt relative Pfadan-
gaben für die Bilddatei ein. Insbesondere kann dies passieren, wenn man ein schon einmal ver-
wendetes Bild per Copy und Paste an einer anderen Stelle erneut einfügt:

<IMG SRC="file:///H:/webstart/bar1p.gif" ALT="Trennlinie" HEIGHT=20 WIDTH=544>

Die absolute Pfadangabe, die Sie hinter src finden, funktioniert nicht, wenn Sie Ihr Dokument
anschließend im Web publizieren wollen: Auf dem Web-Server gibt es kein Laufwerk H mit
der angegebenen Verzeichnisstruktur. Relative Pfadangaben in der Form

<IMG SRC="bar1p.gif" ALT="Trennlinie" HEIGHT=20 WIDTH=544>

hingegen funktionieren, vorausgesetzt, das Bild gibt es tatsächlich in dem Verzeichnis, in dem
auch das Dokument liegt.

Wenn Sie im Browserfenster statt Ihres Bildes ein Ersatzsymbol in der Art  oder 
finden, so überprüfen und korrigieren Sie den Pfad.

Abbildung 74: Image Properties Dialog

4.3.7 Ausrichten von Graphiken
Kopieren Sie die Datei cup.gif in Ihr Web-Verzeichnis. Fügen Sie das Bild zu Beginn des
ersten Absatzes ein. Sie fragen, wie das geht? Noch einmal zur Erinnerung: Klicken Sie mit
dem Cursor an den Anfang des ersten Absatzes. Wählen Sie den Menüpunkt Insert -> Image.
Füllen Sie das folgende Dialogfenster wie in Abbildung 75 angegeben aus.
Die Teetasse wird wie in Abbildung 76 angegeben in Ihr Dokument eingefügt: Der untere
Rand der Graphik wird am unteren Rand des folgenden Textes ausgerichtet.
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Es gibt auch Möglichkeiten, die Graphik gezielt anders zu positionieren. Im Netscape Editor
stehen dazu die Schaltflächen des Feldes Alignment im Image-Properties-Dialogfenster zur
Verfügung (Abbildung 75). Die ersten fünf Schaltflächen entsprechen von links nach rechts den
Ausrichtungen: texttop, abscenter, center, bottom, absbottom. Mit Ausnahme von bottom sind
derartige Ausrichtungen im HTML-Standard nicht definiert. Daher kann ein Autor nicht davon
ausgehen, daß ein anderer Browser als der Netscape Navigator die Ausrichtungen interpretiert.
Der Internet Explorer interpretiert von diesen Ausrichtungen nur die Werte texttop, center und
bottom.
Im HTML-Standard werden die Graphikausrichtungen: top, middle und bottom definiert (siehe
unten). Diese werden auch vom Netscape Navigator und vom Internet Explorer ausgewertet,
können aber wie oben gesagt mit Ausnahme von bottom im Netscape Editor nicht gesetzt wer-
den. Die Ausrichtung bottom wird standardmäßig gewählt, wenn Sie im Netscape Editor ein
Bild einfügen. Möchten Sie unbedingt eine andere Ausrichtung erreichen, so sollten Sie die
gewünschte Ausrichtung top, middle oder bottom, wie im folgenden HTML-Abschnitt be-
schrieben, mit Hilfe eines ASCII-Editor (etwa dem notepad) in die HTML-Quelle einfügen.

Abbildung 75: Teetasse

Unsere Teetasse wurde durch folgendes HTML-Element in das Dokument eingefügt:

<IMG SRC="cup.gif" ALT="Teetasse" HEIGHT=110 WIDTH=120>

Zur Ausrichtung einer Graphik relativ zum Text steht das Attribut align des <img>-Tags zur
Verfügung. Es kann die Werte top, middle und bottom annehmen. In Abbildung 77 sehen Sie
die Wirkung. Die Graphik ist dabei mit folgenden Befehlen eingefügt worden:

<IMG SRC="cup.gif" align=top ALT="Teetasse" HEIGHT=110 WIDTH=120>
<IMG SRC="cup.gif" align=middle ALT="Teetasse" HEIGHT=110 WIDTH=120>
<IMG SRC="cup.gif" align=bottom ALT="Teetasse" HEIGHT=110 WIDTH=120>
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Beim Alignment top wird der obere Bildrand am oberen Rand des größten Textelementes der
folgenden Zeile ausgerichtet. Beim Alignment middle wird die Mitte der Graphik mit der fol-
genden Zeile ausgerichtet, beim Alignment bottom wird der untere Rand der Graphik am unte-
ren Rand des folgenden Textes ausgerichtet.

Abbildung 76: Viertes Dokument (vierte.htm)

Fehlt in der HTML-Anweisung eine Angabe zum Alignment, so wird die Graphik standardmä-
ßig gemäß align=bottom eingesetzt.

Abbildung 77: Ausrichtung von Graphiken
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4.3.8 Floating Images
In Abbildung 77 sehen Sie, daß keine dieser Ausrichtungen dafür sorgt, daß die Graphik in den
Text eingebettet wird, das heißt vom Text umflossen wird. Die beiden rechten Schaltflächen
des Alignment Dialogfeldes (Abbildung 75) dienen dazu, solche „Floating Images“ zu erzeu-
gen. Sie entsprechen den Ausrichtungen left und right des <img>-Tags für eine Ausrichtung
des Bildes am linken oder rechten Rand des Browserfensters.

Rufen Sie den Image Properties Dialog auf und richten Sie die Graphik über die Schaltfläche

 aus. Sie steht für das Attribut align=left. Die Wirkung sehen Sie nicht im Editorfenster,
sondern Sie müssen sich Ihr Dokument nun im Browser anschauen. Die Tasse ist jetzt in den
Text eingebettet (Abbildung 78).

Bei der Gestaltung von Seiten mit Floating Images stößt man schon hart an die Grenzen des
Netscape Editors: Da die Ausrichtung der Bilder nicht im Editorfenster dargestellt wird, ist die
Gestaltung der Seite mit dem Editor recht unhandlich. Da man jedoch nicht so viele von diesen
Bildern in sein Dokument einfließen lassen wird, ist dies jedoch nicht ganz so schwerwiegend
zu bewerten.

Die Gestaltung der Home Page des Kontors ist hiermit abgeschlossen. Speichern Sie sich die
Home Page unter dem Namen Index.html.

Der gesamte HTML-Code, mit dem die Graphik als „Floating Image“ eingefügt wird, sieht nun
so aus:

<IMG SRC="cup.gif" ALT="Teetasse" HEIGHT=110 WIDTH=120 ALIGN=LEFT>

Abbildung 78: Floating Images

Mitunter möchte man den Textfluß um die Graphik herum vorzeitig beenden. Dies ist beim
unteren Bild in Abbildung 79 geschehen. Das Attribut clear des <BR>-Tags sorgt für eine sol-
che Formatierung.
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Es kann gemäß HTML-Standard die Attributwerte <BR clear=left>,<BR clear=right> und
<BR clear=all> annehmen. Die Attributwerte left und right beenden den Textfluß um Floa-
ting Images, die links bzw. rechts in den Text eingebettet wurden. Der Attributwert all beendet
den Textfluß sowohl um linksseitig wie rechtsseitig eingebettete Bilder. In unserem Beispiel
hätte sowohl die HTML-Anweisung <BR clear=left> als auch die HTML-Anweisung <BR
clear=all> die gezeigte Wirkung gehabt.

Abbildung 79: Zeilenumbruch nach Floating Images

Mit Hilfe des Netscape Editors fügt man diese HTML-Anweisung über den Menüpunkt Insert
-> Break below Image(s) ein. Der Netscape Editor erzeugt daraus die HTML-Anweisung
<BR clear=both>. Diese verhält sich wie die Anweisung <BR clear=all> und wird vom Net-
scape Browser und vom Internet Explorer interpretiert. Möchte man sich standardgemäß ver-
halten, so kann muß man die HTML-Anweisung über den Menüpunkt Insert -> HTML-Tag
des Editors einfügen. Es öffnet sich ein Dialogfenster wie in Abbildung 80 dargestellt, in das
man die HTML-Anweisung eintragen kann.

Abbildung 80: HTML-Tag einfügen
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Für derartig eingefügte Tags erscheint im Editorfenster eines der Symbole .

Puuh, die Geschichte mit den Bildern ist ganz schön kompliziert, nicht wahr? Und es geht noch
weiter, wie Sie in den nächsten Abschnitten sehen werden.

4.3.9 Animierte Bilder
Das Einfügen von Inline Images im gif- oder jpg-Format lockert Web-Seiten in der Darstellung
ein wenig auf. Graphiken im gif-Format bestehen dabei häufig nicht nur aus einem einzelnen
Bild, wie beispielsweise unserem Trennlinienbild, sondern ähnlich wie bei einem Video aus
einer ganzen Folge von Bildern samt Übergangseffekten. Hinter der Teetasse verbirgt sich eine
solche Bildfolge. Der Netscape Navigator und der Internet Explorer unterstützen das gif-
Format (genauer das gif89a-Format) in derartiger Weise, daß Sie die Bildfolgen im Browser-
fenster darstellen können.
Alles, was Sie über das gif89a-Format wissen möchten, wird Ihnen über die Web-Seite von
Royal Frazier (http://members.aol.com/royalef/gifanim.htm) mitgeteilt. Mit Hilfe des Gifcon-
struction Sets von Alchemy Mindworks (http://www.mindworkshop.com/ alchemy/ alchemy.
html) lassen sich animierte Bilder im gif-Format erzeugen. Eine schöne Schritt-für-Schritt-
Beschreibung findet man bei Kitty’s Homeland (www.snowcrest.net/kitty/hpages/demo.html).
Im Internet werden bereits zahlreiche fertige Bilder dieser Art zur persönlichen Nutzung zur
Verfügung gestellt.

4.3.10 Transparente Bilder
Das gif89a-Format erlaubt es, zu jedem Bild eine Farbe als transparente Farbe zu wählen. Flä-
chen des Bildes, die in dieser transparenten Farbe gezeichnet sind, sind durchscheinend, das
heißt der Hintergrund bleibt sichtbar (Abbildung 81).
Alle modernen Zeichenprogramme erlauben die Angabe einer transparenten Farbe beim Ab-
speichern eines Bildes im gif89a-Format. Näheres finden Sie in Abschnitt 4.4.

Abbildung 81: Transparente Bilder

4.3.11 Verwendung von Bildern als Listenpunkte
In Abschnitt 4.3.2 wurde bereits eine ungeordnete Liste auf unsere Web-Seite eingefügt. Wel-
che Listenmarkierungen im Browser-Fenster erscheinen, hängt vom verwendeten Browser ab.
Werden ungeordnete Listen geschachtelt, so hängt die Listenmarkierung möglicherweise auch
noch von der Schachtelungstiefe ab. In Abbildung 83 sehen Sie eine in drei Tiefen geschach-
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telte Liste, wie Sie vom Netscape Browser dargestellt wird. In Abbildung 82 sehen Sie die
gleiche Liste, wie Sie im Internet Explorer erscheint.

Abbildung 83: Liste im Netscape

Während der Netscape Navigator abhängig von der Schachtelungstiefe unterschiedliche Li-
stenmarkierungen verwendet, stellt der Internet Explorer stets einen Punkt als Listenmarkie-
rung dar.
Ein Autor kann über den List Properties-Dialog des Netscape Editors bestimmen, welche Art
von Listenmakierungen im Browserfenster dargestellt werden sollen (Abbildung 84). Im Feld
Bullet Style kann der Typ der Listenmarkierung eingestellt werden.

Abbildung 84: Listenmarkierung

Abbildung 82: Liste im Internet Explorer
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Solid circle steht für einen Punkt, Open circle für einen Kreis und Solid square für ein ge-
fülltes Quadrat. Die Möglichkeit, einen Typ für die Listenmarkierung vorzugeben, wird vom
HTML 3.2 Standard definiert. Diese Einstellungen werden zur Zeit aber nur vom Netscape
Navigator ausgewertet.

Tip:
Geschachtelte Listen fügen Sie im Netscape Editor am einfachsten ein, indem Sie zunächst alle
Listenpunkte in einer einfachen Liste ohne Schachtelung aufschreiben. Anschließend markieren
Sie diejenigen Punkte, die Sie tiefer schachteln wollen und rücken Sie mittels der Schaltflächen

 (increase indent) ein.

Über das Attribut type=circle, type=disc oder type=square des <UL>-Tags kann ein Autor
bestimmen, welche Listenmarkierungen vom Browser genommen werden sollen. Das Attribut
circle steht für einen Kreis, das Attribut disc für einen Punkt und das Attribut square für ein
gefülltes Quadrat. Dieses Attribut gehört zum HTML 3.2 Standard, wird aber zur Zeit nur
vom Netscape Navigator ausgewertet.

Häufig sieht man in HTML-Dokumenten auch, daß Bildchen als Markierungspunkte einer Li-
ste verwendet werden. Die Liste muß man als Autor in diesem Fall etwa aus einem Absatz mit
„sanften“ Zeilenumbrüchen selbst konstruieren. Vor jede Zeile fügt man dann ein Bild ein. Zur
Erzeugung der „Liste“ aus Abbildung 85 wurde folgender HTML-Code verwendet:

<P><IMG SRC="yellow.gif" HSPACE=5 HEIGHT=17 WIDTH=17>Teeliste<BR>
<IMG SRC="yellow.gif" HSPACE=5 HEIGHT=17 WIDTH=17>Gew&uuml;rzliste<BR>
<IMG SRC="yellow.gif" HSPACE=5 HEIGHT=17 WIDTH=17>Accessoires</P>

Abbildung 85: Liste mit Bildmarkierungrn

Hierbei wurde das Attribut HSPACE des <img>-Tags verwendet. Der Attributwert gibt an,
wieviel Leerraum in Pixel links und rechts neben der Graphik verbleiben soll.
Im Netscape Editor kann dies über den Image Properties Dialog (Abschnitt 4.3.6) eingestellt
werden. Der Wert ist über die Felder Space around image des Dialogfensters einzustellen.

4.3.12 Verwendung von Bildern als Anker
Bilder können auch anstelle des Verweistextes bei Ankern eingesetzt werden. Um das Bild
wird in diesem Fall standardmäßig ein Markierungsrahmen gezeichnet (Abbildung 86). Dies ist
nicht immer wünschenswert. Über das Attribut border des <img>-Tags kann man dies verhin-
dern: Es ist eine Rahmenstärke von 0 Pixel (border=0) einzusetzen. Die Anker in Abbildung 86
sind durch folgenden HTML-Code erzeugt worden:
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<P>Bild als Anker. Es wird ein Rahmen um das Bild gezeichnet:</P>
<P><A HREF="home.htm"><IMG SRC="arrow_big_left.gif"></A></P>

<P>Bild als Anker. Durch Verwenden des Attributs border=0 wird verhindert,
daß ein Rahmen erscheint:</P>
<P><A HREF="home.htm"><IMG SRC="arrow_big_left.gif" BORDER=0 ></A></P>

Abbildung 86: Bilder als Anker

Das Attribut border kann im Netscape Editor im Image Properties Dialog (Abschnitt 4.3.6)
gesetzt werden. Im Feld Space around image ist für Solid Border der gewünschte Wert ein-
zutragen.

4.4 Helferlein

4.4.1 Online Hilfen
Sie haben jetzt schon eine Reihe von HTML-Sprachelementen kennengelernt. Durch einen
Blick in die Tabellen des Anhangs werden Sie auch festgestellt haben, wie leicht man dabei den
HTML 2.0 Standard verläßt und Elemente des HTML 3.2 Standards verwendet. Dies ist auch
nicht weiter schlimm, da die neuen Browser diesen Standard in der Regel beherrschen. Oft
benutzt man aber unwissentlich proprietäre Erweiterungen der Browser Hersteller. Dies wird
Ihnen nicht nur so gehen, wenn Sie den Netscape Editor zur Erstellung Ihrer Seiten verwen-
den, sondern auch wenn Sie mit einem beliebigen anderen Web-Editor arbeiten. Zumindestens
die Verwendung proprietärer Sprachelemente und Attribute wird die meisten Autoren stören,
wenn sie Ihr Dokument nicht für einen speziellen Browser entwickeln wollen. Es ist daher un-
erläßlich, diese Editoren „mit Verstand“ einzusetzen, das heißt, Sie sollten die verwendeten
Sprachelemente einordnen können. Eine große Erleichterung ist dabei eine Online-Hilfe. Eine
sehr schöne Online Hilfe (in englischer Sprache) ist die HTML Reference Library von Stephen
Le Hunt. Sie finden sie beispielsweise über Tucows (http://www.fh-reutlingen.de/tucows/) im
Verzeichnis Web Accessories. Es gibt diese Hilfe für Windows 95/NT und Windows 3.x. Sie
können die HTML Reference Library für den persönlichen Gebrauch kostenfrei nutzen. Sie ist
aufgebaut wie die üblichen Windows Hilfen: Über Inhaltsverzeichnisse oder über den Index
hangelt man sich bis zu der Stelle vor, die man näher erläutert haben möchte. Neben der textu-
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ellen Hilfestellung bietet die HTML Reference Library auch häufig die Möglichkeit an, sich die

Wirkung der HTML-Sprachelemente in einem Snapshot  anzuschauen (Abbildung 87).

Abbildung 87: HTML Reference Library

Die Reference Library umfaßt den HTML 3.2 Standard sowie spezielle Erweiterungen des
Netscape Navigators 3.01 und des Internet Explorers 3.01. Es wird jeweils darauf hingewie-
sen, welche Sprachelemente proprietär sind. Ergänzend zu der Online Hilfe wird ein einfacher
Color Wizard installiert (Abbildung 88).
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Abbildung 88: Color Wizard von Stephen Le Hunt

4.4.2 Organisation von Graphiken
Im Laufe der Zeit „sammelt“ man als Web-Autor zahlreiche Graphiken als potentielle Kandi-
daten zur späteren Nutzung auf seinen Web-Seiten. Ein schönes Programm zur Organisation
dieser Graphiken ist das Programm Thumbs Plus 3.0 von Cerious Software (Abbildung 89).

Abbildung 89: Thumbs Plus 3.0
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Sie können es ebenfalls über Tucows (Bereich: Image Viewer) beziehen. Es kann 30 Tage ko-
stenlos gestestet werden. Eine Lizenz kann über die Firma PD-Profi Zöttlein Software zum
Preis von 89.- DM zuzüglich Versandkosten erworben werden. Bestellformulare finden Sie
nach Installation des Programms Thumbs Plus. Das Programm kann mit den meisten gängigen
Graphikformaten umgehen und erlaubt es, Graphiken in verschiedenste Formate zu konvertie-
ren. Im Anzeigefenster kann der Benutzer sich Vorschaubilder seiner Graphiken anzeigen las-
sen. Das Programm eignet sich auch dazu, Bilder im GIF-Format transparent zu machen: Beim
Abspeichern von Bildern im GIF89a-Format kann eine Farbe als transparente Farbe definiert
werden (Abbildung 90).

Abbildung 90: Transparentes Bild im gif-Format

4.4.3 Zeichenprogramme
Es gibt zahlreiche Zeichenprogramme, mit Hilfe derer Web-Autoren eigene Bilder für ihre
Seite entwickeln können. Das Programm Paint Shop Pro 4.1 ist beispielsweise ein kleines
handliches Programm dieser Art. Das Programm kann 30 Tage kostenlos getestet werden. Es
ist in Deutschland zu beziehen über den Verlag Gisela Lakies (http://www.lakie.com). Eine
Lizenz kostet zur Zeit 164.- DM.
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Abbildung 91: Paint Shop Pro

4.4.4 Web Editoren
Es sind zahlreiche Web-Editoren auf dem Markt erhältlich. Wie eingangs schon gesagt, lassen
sich zwei Arten von Editoren unterscheiden:

Erweiterte ASCII-Editoren
Man arbeitet mit ihnen wie mit einem ASCII-Editor. HTML-Tags lassen sich über ein Menüsy-
stem in das Dokument einbauen. Das hat den Vorteil, daß man Schreibarbeit spart, des weite-
ren sind die so eingesetzten Tags syntaktisch richtig. Auch beim semantischen Aufbau helfen
derartige Editoren, indem sie sich beispielsweise einfach weigern, Tags an Stellen einzufügen,
an denen sie nicht stehen dürfen. Komfortablere Editoren konvertieren bei der Texteingabe
auch gleich Sonderzeichen, die über die Tastatur eingegeben werden, in die zugehörige
HTML-Ersatzdarstellung. Zusätzlich bieten viele dieser Editoren Assistenten oder Wizards an,
über die die Gestaltung von Tabellen, Frames etc. erleichtert werden soll.
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Abbildung 92: Web-Editor Luckman Webedit

Als Beispiel für einen Editor dieser Art sehen Sie in Abbildung 92 den Editor Luckman Webe-
dit Pro 2.0. Dieser zeichnet sich vor allem durch ein recht übersichtliches Menüsystem aus. Als
weiterer Vorteil ist zu nennen, daß es rabattierte Lizenzen für Mitglieder von Bildungseinrich-
tungen gibt. Eine Schullizenz kostet zur Zeit 99.- DM für die Professional-Version und 69.-
DM für die Standard-Version. Die Lizenz kann über die Stuttgarter Firma Michael Kalus Soft-
und Hardwarehandel bezogen werden.
Als weiterer leistungsfähiger Editor ist der Hotdog Professional 3.0 der australischen Firma
Sausage zu nennen. Seinem Leistungsumfang entsprechend ist das Menüsystem des Editors
recht verwirrend. Er ist sicherlich für viele Anwender überdimensioniert. Weiterer Nachteil ist,
daß eine Lizenz reibungslos nur per Kredit-Karte erworben werden kann. Eine Lizenz kostet
zur Zeit 99 australische Dollar.
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Wysiwyg-Editoren
Ein anderer Ansatz sind Wysiwyg (What you see is what you get)-Editoren. Einen solchen
haben Sie mit dem Netscape Editor bereits kennengelernt. Beispiele für weitere Wysiwyg-
Editoren sind der Frontpage Editor von Microsoft und der Internet Assistant für MS Word.
Der Internet Assistant ist vor allem gut als HTML-Konverter einsetzbar, das heißt er kann
Daten im MS Word Format in HTML-Dateien konvertieren und umgekehrt.

Bei beiden Arten von Editoren kommt man nicht umhin, Grundkenntnisse über die HTML-
Tags zu erwerben: Sei es, um Fehler auszubauen, oder um Leistungen zu erreichen, die über
das Menüsystem des Editors nicht abrufbar sind.

Zur Bewertung der Editoren muß man sich zunächst klarmachen, daß der HTML 3.2 Standard
eigentlich keine oder nur sehr wenige Sprachelemente zur Formatierung eines Dokumentes
enthält. Noch nicht einmal die bei jedem Textverarbeitungsprogramm üblichen Absatzformatie-
rungen wie Erstzeileneinzug, Definition von Seitenrändern, Absatzeinzug etc. sind definiert.
Derartige „Effekte“ lassen sich heutzutage nur über Tricks, das heißt zweckentfremdete Ver-
wendung von Sprachelementen, realisieren. Im weiteren Verlauf dieser Einführung werden Sie
einige dieser Tricks kennenlernen. Die Editoren können diesen Mangel natürlich auch nicht
„ausbügeln“. Einem Autor, dem es in erste Linie auf ein besonders „ausgefallenes“ Design sei-
ner Seiten ankommt, können Editoren keine Hilfestellung leisten. Steht jedoch die Intention,
Informationen in ansprechender Form zu publizieren im Vordergrund, so sind Web-Editoren
nützliche Helferlein.

Bei allen von uns getesteten Editoren hatten wir mit Tücken zu kämpfen. Sie haben dies be-
stimmt auch schon beim Netscape Editor feststellen können. Der Netscape Editor ist dennoch
gut zu gebrauchen, um schnell und einfach ansprechende, wenn auch schlicht gestaltete Seiten
zu entwerfen. Listen über weitere Shareware Editoren und HTML-Konverter finden Sie bei-
spielsweise bei Tucows (http://www.fh-reutlingen.de/tucows/) oder über die Informationssei-
ten des W3-Konsortiums (http://www.w3.org/pub/WWW/Tools/).

Aufgabe 3:
Durch Verwendung von Bildern und Farben können Sie den Charakter eines Dokumentes ver-
ändern (Abbildung 93). Speichern Sie das bisher gestaltete Web-Dokument in eine neue Datei
variante.htm ab. Gestalten Sie es unter Verwendung anderer Bilder und Farben neu. Sie kön-
nen sich dazu selbst Bilder aus dem Internet besorgen (Aufgabe1), oder beispielsweise das
Hintergrundmuster z_lines.gif, die Trennlinie bvine.gif, sowie die Bilder fly.gif und flower.gif
aus den Zusatzhilfsmitteln verwenden.
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Abbildung 93: Dokumentvariante (variante.htm)

4.5 Publizieren der Web-Seiten
Sie haben bislang Ihre Web-Seiten lokal auf Ihrem PC entwickelt. Wenn Sie diese Seiten im
Internet publizieren wollen, so müssen Sie auf einem Web-Server abgelegt werden, denn nur
ein solcher Web-Server kann Anfragen von entfernten Rechnern im Internet beantworten. Das
Rechenzentrum der Ruhr-Universität betreibt einen Web-Server, über den Mitglieder der Ruhr-
Universität ihre persönlichen Seiten publizieren können. Der Server hat die Internet-Adresse
homepage.ruhr-uni-bochum.de. Für jeden Benutzer, der einen Antrag auf Nutzung von
Kommunikations-/Internetdiensten gestellt hat, wird auf diesem Server ein persönliches Ver-
zeichnis (Home Page Verzeichnis) eingerichtet, in das er seine Seiten zur Publikation ablegen
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kann. Sie können Ihre Seiten beispielsweise mit Hilfe eines ftp-Klienten auf den Web-Server
übertragen.

Der Netscape Editor bietet darüberhinaus eine bequeme Upload-Funktion, um Web-Seiten auf
einen Server zu übertragen. Das Upload funktioniert nur bei abgeschaltetem Proxy oder bei
automatischer Proxy-Konfiguration (Abschnitt 3.1.1). Möchten Sie beispielsweise das Web-
Dokument fuenfte.htm in Ihr persönliches Verzeichnis auf dem Homepage-Server über-
tragen, so laden Sie zunächst diese Datei in den Editor. Wählen Sie den Menüpunkt File ->
Publish an. Sie erhalten das in Abbildung 94 dargestellte Dialogfenster. Die Upload-Funktion
des Netscape Editors ist so komfortabel, daß sie gleich mit anbietet, alle Inline Graphiken, die
im Dokument verwendet werden, mit zu übertragen.
Ins Feld Upload File to this location geben Sie die Internet-Adresse des Homepage-Servers
in Form eines URLs an: ftp://homepage.ruhr-uni-bochum.de. Ins Feld User name geben Sie
die Benutzerkennung ein, die Sie aufgrund des Antrags auf Nutzung von Internetdiensten zu-
gewiesen bekommen haben. Ins Feld Password müssen Sie das zugehörige Paßwort eingeben5.

Abbildung 94: Upload von Dokumenten

Quittieren Sie Ihre Angaben mit OK. Anschließend wird das Web-Dokument fuenfte.htm
zusammen mit den Inline Graphiken auf den Server übertragen.

Um Ihre Seiten im Internet zu adressieren, geben Sie den URL

http://homepage.ruhr-uni-bochum.de/Vorname.Nachname/Name_der_Seite

ein, z.B. http://homepage.ruhr-uni-bochum.de/Der.Tester/fuenfte.htm. Vorname und Nachna-
me ergeben sich aufgrund des Namensanteils Ihrer Email-Adresse.

                                               
5 Sie werden beim Aufwählen auf den Server automatisch in Ihr persönliches Web-Verzeichnis gestellt.
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Sie sollten in Ihrem Home Page Verzeichnis unbedingt eine Datei mit dem Namen Index.html
oder index.html oder Index.htm oder index.htm ablegen. Diese Datei bekommt jemand ange-
zeigt, der den URL http://homepage.ruhr-uni-bochum.de/Vorname.Nachname/ ohne weitere
Angabe zum Dateinamen verwendet.

4.6 Download von Web-Seiten
Mittels des Netscape Navigators Gold können Sie auch Web-Seiten von einem Server herun-
terladen, um sie anschließend lokal zu edieren. Laden Sie dazu die Seite in den Netscape
Browser. Wählen Sie den Menüpunkt File -> Edit Document. Der Netscape Editor wird mit
der angezeigten Seite gestartet und Sie erhalten das in Abbildung 95 dargestellte Dialogfenster.

Abbildung 95: Download von Web-Seiten

In dem Dialogfenster werden Sie darauf aufmerksam gemacht, daß Sie die Seite nur dann ver-
ändern können, wenn Sie sie lokal speichern. Betätigen Sie die Schaltfläche Save, um das
Übertragen und Speichern der Seite zu veranlassen. Haben Sie das Kontrollkästchen Save
images with document aktiviert, so werden Inline Images, die im Dokument verwendet wer-
den, ebenfalls geholt.

4.7 Noch mehr Listen
Wir wollen jetzt mit der Vervollständigung unseres Web-Projektes fortfahren.
Die Home Page des „Alfred Ingwersen“ verweist auf Dokumente, in denen ein Käufer die
Produktlisten des „Kontors“ finden kann: tee.htm, gewuerz.htm, access.htm.
Seiten, die zu einem Projekt gehören, sollten möglichst einheitlich gestaltet sein, damit ein Le-
ser die Zusammengehörigkeit der Seiten beim Blättern durchs Web leicht identifizieren kann.
Sie sollten daher auf eine einheitliche Farb- und Layout-Auswahl achten. Damit Sie hier den
Umgang mit weiteren HTML-Spachelementen kennenlernen, werden wir die Listen jedoch in
unterschiedlichen Formaten aufbauen.
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4.7.1 Erstellen einer Seitenvorlage
Einige Stilelemente wie Hintergrundgestaltung und Farbauswahl sollen bei allen Listen in glei-
cher Art erfolgen. Um uns ein wenig die Arbeit zu erleichtern, wollen wir dazu eine HTML-
Vorlage erstellen. Laden Sie die Home Page des „Alfred Ingwersen“ in den Netscape Editor.
Sichern Sie sich diese Seite unter dem Namen vorlage.htm. Nun edieren Sie die Vorlage:
Entfernen Sie alle Zeilen bis auf die Überschriftszeile und die erste Trennline. Die Überschrift
soll ferner in einer Zeile stehen und mit einem Doppelpunkt enden. Sichern Sie sich die Vorla-
ge.

Abbildung 96: Dokument-Vorlage

Wir wollen des weiteren in der linken oberen Ecke der Seite eine kleine Navigationshilfe einfü-
gen: Positionieren Sie den Cursor vor die Überschrift und betätigen Sie die Return-Taste. Es
entsteht ein neuer Paragraph oberhalb der Überschrift. Klicken Sie in diesen Paragraphen. Der
Paragraph soll im Format Normal dargestellt werden und linksbündig ausgerichtet sein. Fügen
Sie jetzt einen Pfeil aus der Datei back.gif ein (Insert -> Image). Markieren Sie diesen
Pfeil. Rufen Sie das Kontextmenü auf und wählen Sie den Punkt Create Link Using Selected.
Der Anker soll auf die Home Page (Index.html) des Kontors weisen. Die Vorgehensweisen
zum Einfügen von Bildern und Ankern wurden in den Abschnitten 4.3.3, 4.3.5 und 4.3.10 be-
schrieben. Ihre Vorlage sollte nun wie in Abbildung 96 dargestellt aussehen.

4.7.2 Numerierte Listen
Als erstes soll die Accessoires-Liste erstellt werden. Sie soll nachher wie in Abbildung 98 dar-
gestellt aussehen.
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Wir werden zur Formatierung der Accessoires-Liste numerierte Listen verwenden, wobei die
Numerierung die Bestellnummer des Produktes angibt.
Öffnen Sie die Datei vorlage.htm in den Netscape Editor. Damit Sie die Vorlage nicht
versehentlich zerstören, sichern Sie sich die Datei gleich unter dem Namen access.htm.

Überschrift und Dokumententitel
Ändern Sie Überschrift und Titel des Dokumentes in „Holsteiner Tee&Gewürz-Kontor: Ac-
cessoires“ ab. Hinweis: Den Dokumententitel können Sie über den Menüpunkt Properties ->
Document -> General ändern.

Abschnittsüberschriften einfügen
Fügen Sie die drei Abschnittsüberschriften „Zuckerzeug“, „Teezubereitung“ und „Teegenie-
ßen“ im Format Heading 2 ein.

Einfügen einer numerierten Liste
Positionieren Sie den Cursor hinter die erste Abschnittsüberschrift und beginnen Sie einen neu-
en Paragraphen durch Betätigen der Return-Taste.

Über die Schaltfläche  fügen Sie eine numerierte Liste ein. Es erscheint ein # als Platzhal-
ter für die Listenmarkierungen im Editorfenster. Im Browserfenster wird dieser Platzhalter
durch eine geeignete Numerierung ersetzt. Tragen Sie die folgende Listenpunkte ein:

# Teezucker, 300 g 2,30 DM
# Kluntjes, 300 g, 4,10 DM
# Rum-Kandis, 250 g, 5,00 DM
# Vanille-Rum-Kandis, 250g, 6,50 DM
# Akazienhonig, 50 g, 2,40 DM
# Orangenblütenhonig, 50 g, 2,40 DM
# Lindenblütenhonig, 50 g, 2,40 DM
# Akazienhonig, 250 g, 4,30 DM

Im Browserfenster beginnt die Numerierung der Liste mit 1, falls vom Autor keine abweichen-
den Angaben gemacht wurden. Unsere Liste soll mit 51 beginnen. Dies können Sie im Editor
über den Properties-Dialog einstellen: Klicken Sie mit der rechten Maustaste auf den ersten
Listenpunkt und wählen Sie Paragraph/List Properties aus.

Im Feld Starting number des folgenden Dialogfensters können Sie die Startnummer eingeben
(Abbildung 97).
Über das Feld Number Style können Sie auch alphabetisch oder römisch als andere Numerie-
rungsarten auswählen. Zur Gestaltung der Accessoires-Liste belassen Sie die Numerierung auf
arabisch.

Fügen Sie unter dem Abschnitt „Teezubereitung“ eine weitere numerierte Liste ein, die bei der
Zählung mit 61 beginnt:
# Teefilter ungebleicht, 100 Stück, 4,90 DM
# Teefilterhalter, 2,50 DM
# Teenetz klein, 2,00 DM
# Teenetz mittel, 2,10 DM
# Teenetz groß, 2,30 DM
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# Blitz-Wasserkocher, 89,90 DM
# Digitalwaage, 95,00 DM
# Tea Timer, 19,90 DM

Abbildung 97: List Properties

Unter dem Abschnitt „Teegenießen“ fügen Sie noch eine Liste, die bei der Zählung mit 71 be-
ginnt, ein:
# Teekanne "Kyoto" Glas, 59,90 DM
# Obertasse, Glas, 4,95 DM
# Untertasse, Glas, 4,50 DM
# Teekanne "Japan", weiß 62,80 DM
# Untertasse "Japan", 5,80 DM
# Obertasse "Japan", 8,70 DM

Eventuell können Sie Ihre Accessoires-Liste noch durch einige Bilder verschönern: ses-
sel.gif, zucker.gif, clock.gif.

Ihre Accessoires-Liste sollte nun im Browser-Fenster wie in Abbildung 98 dargestellt ausse-
hen.
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Ausgabe:

Abbildung 98: Accessoires-Liste (access.htm)
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Eingabe:

Abbildung 99: Numerierte Listen
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Schauen wir uns kurz an, welche HTML-Sprachelemente zum Einsatz gekommen sind. In
Abbildung 99 sehen Sie einen Ausschnitt aus der Quelle unseres Dokumentes.

Numerierte Listen
Numerierte Listen werden über das HTML-Sprachelement <OL> ... </OL> erzeugt. Jeder
Listenpunkt ist durch das Sprachelement <LI> zu kennzeichnen. Das schließende Tag </LI>
kann entfallen. Das Aussehen einer Liste kann über Attribute variiert werden. Das Attribut
start=zahl dient dazu, einen Startwert für die Zählung festzulegen. Fehlt dieses Attribut, so
beginnt die Zählung bei 1.
Über das Attribut type=stil kann eine Form der Numerierung arabisch, alphabetisch oder rö-
misch gewählt werden. Beispiel: <OL type=A start=5> ... </OL> erzeugt eine numerierte Li-
ste, die mit Großbuchstaben als Zählung versehen wird. Die Numerierung beginnt in diesem
Fall bei E. Die Syntax einer numerierten Liste wird in Tabelle 2 des Anhangs beschrieben.

Absatzformatierung
Auch hier merken Sie wieder, daß Sie nur sehr wenige Möglichkeiten haben, auf die Absatz-
formatierung des Dokumentes Einfluß zu nehmen: Es gibt kein HTML-Sprachelement, das zur
Definition eines linken oder rechten Seitenrandes verwendet werden kann. Es fehlt eine Mög-
lichkeit, Tabulatoren anzugeben, um beispielsweise die Beträge untereinander zu setzen. Es
kann kein Einzug für Paragraphen angegeben werden6. Solange ein endgültiger Beschluß des
W3-Konsortiums über die Definition von Style Sheets aussteht, muß ein Autor zu Tabellen
(siehe unten) greifen, um über die Formatierung seines Dokumentes etwas mehr bestimmen zu
können.

Hinweis: Die Schaltflächen   (Increase Indent, Decrease Indent) des Netscape Edi-
tors machen nur im Zusammenhang mit Listen einen Sinn, beispielsweise um Listen zu
schachteln oder zu beenden, ansonsten wird semantisch falscher HTML-Code erzeugt. Das
heißt, diese Schaltflächen sollten nicht dazu verwendet werden, Absätze einzurücken.

4.7.3 Definitionslisten
Es gibt einen weiteren HTML-Listentyp, die Definitionsliste (Glossar). Jeder Listeneintrag
einer Definitionsliste besteht aus einem zu definierenden Element (definition term, definition
title) gefolgt von einer Definition (definition data, definition text). Die meisten Browser rücken
dabei die Definition gegenüber dem zu definierenden Element ein wenig ein (Abbildung 100).
Wir werden eine solche Liste verwenden, um unsere Teeliste aufzubauen. Die Teeliste soll
nachher wie in Abbildung 102 angegeben aussehen.

Überschrift und Dokumententitel
Öffnen Sie die Datei vorlage.htm im Netscape Editor. Ändern Sie Überschrift und Titel
des Dokumentes in „Holsteiner Tee&Gewürz-Kontor: Teeliste“ ab. Speichern Sie das Doku-
ment unter dem Namen tee.htm.

                                               
6 Manche Autoren verwenden dazu die Paragraphen-Formatierung <BLOCKQUOTE>, da die meisten Browser
derartige Paragraphen einrücken. Diese Formatierung ist aber eigentlich nur zur Hervorhebung von Zitatstellen
gedacht und ist somit kein geeignetes Mittel, um Absätze einzurücken.
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Abbildung 100: Description List im Netscape Navigator

Abschnittsüberschriften einfügen
Fügen Sie die drei Abschnittsüberschriften „Schwarzer Tee“, „Grüntee“, „Spezialitäten“ im
Format Heading 2 ein. Der Text soll jeweils zentriert und unterstrichen erscheinen.

Einfügen von Definitionslisten
Positionieren Sie den Cursor hinter die erste Abschnittsüberschrift und beginnen Sie einen neu-
en Paragraphen durch Betätigen der Return-Taste. Der Paragraph soll linksbündig ausgerichtet
sein.
Das Einfügen von Definitionslisten in der im Augenblick aktuellen Version 3.01 des Netscape
Editors Gold ist ein wenig umständlich, da diese Funktion fehlerhaft implementiert ist: Klicken
Sie mit der rechten Maustaste auf den neuen noch leeren Paragraphen und wählen Sie den
Menüpunkt Paragraph/List Properties aus. Sie erhalten das in Abbildung 101 dargestellte
Dialogfeld. Wählen Sie im Pull-down Menü Additional style den Wert List aus. Jetzt können
Sie im Pull-down Menü List Style den Typ Description List (dies entspricht einer Definiti-
onsliste) wählen. Als Paragraph Style stellt sich automatisch der Wert List Item ein. Dies ist
leider falsch: Hier müßte man den Wert Description Title einstellen können, denn jeder Li-
steneintrag einer Definitionsliste (Description List) besteht aus einem Description Title gefolgt
vom Description Text. Das Menüsystem läßt dies aber leider nicht zu. Quittieren Sie die Ein-
stellungen mit OK.
Im Editorfenster erscheint ein Listenpunkt im Format List Item. Wählen Sie jetzt im Pull-
down Menü der Werkzeugleiste Description Title als Format aus. Tragen Sie Ihren Descripti-
on Titel, in unserem Beispiel ist dies der Text „115 Darjeeling TGFOP“, als Fließtext ein.
Beginnen Sie anschließend einen neuen Paragraphen durch Betätigen der Return-Taste. Wäh-
len Sie als Paragraphen-Format Description Text über das Pull-down Menü der Werkzeuglei-
ste aus. Die Zeile wird eingerückt. Geben Sie jetzt die folgende Teebeschreibung als Descripti-
on Text (Fließtext) ein:

Der Geschmack ist aromatisch, leicht blumig, mild, erinnert an den Geschmack der gerade
beendeten First-Flush-Periode und ist gleichzeitig ein Vorbote für den kommenden Geschmack
der Second-Flush-Ernte; eine gehobene Mediumqualität mit hell-rötlich-brauner
Tassenfarbe.100g 6,80DM

Fügen Sie vor der Preisangabe einen „sanften“ Zeilenumbruch ein.
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Abbildung 101: Einfügen einer Definitionsliste

Beenden Sie den Description Text durch Betätigen der Return-Taste und Anwahl des Formats
Description Titel über das Pull-down Menü der Werkzeugleiste. Nun können Sie den näch-
sten Listeneintrag vornehmen.

Fügen Sie folgende weitere Listeneinträge ein:

116 Darjeeling SFTGFOP Imperial Second Flush
Aus dem Garten Puttabong kommt dieser Superior Finest Golden Tippy Orange Pekoe.
Er hat viele Tips (silberne, kleine Blattspitzen) und einen intensiven Second-Flush-
Charakter: duftig, hocharomatisch, würzig, spritzig.
100g 17,00DM

117 Golden Nepal
Eine leicht-würzige, frische, aromatische Komposition kleiner Mengen nepalesischer
Gartentees. Gehobene Mediumqualität, volle helle Tasse.
100g 7,20DM

118 Ceylon BOP Dimbula medium
Ein Broken Orange Pekoe aus dem traditionsreichen Anbaugebiet Dimbula im Westen
Sri Lankas. Würziges, spritziges Aroma; dunkle, kupferrote Tassenfarbe; einfache Me-
diumqualität.
100g 4,40DM

Falls Sie noch etwas üben wollen, so können Sie unter der Abschnittsüberschrift „Grüntee“
eine weitere Definitionsliste mit folgendem Text einfügen:
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215 Japan Sencha, grün
Ein Sencha mit Mediumqualität, duftig, frisch, leicht herb im Geschmack mit heller,
gelblich-grüner Tasse
100g 7,80DM

216 Japan Kokeicha, grün
Durch die Zugabe von Reisstärke wird diese Mediumqualität aus pulverisiertem Tee in
teeblatt-ähnliche Stengel gepreßt. Dadurch erhält der Tee das Aussehen eines schwar-
zen Tees. Der grüne Tee schmeckt leicht herb, frisch und aromatisch, bei heller, gelber
Tasse
100g 5,80DM

217 Wunderbare Jade
Diese absolute Spitzenqualität unter den japanischen grünen Tees wird auch Tautropfen
genannt. Das fast schwarze, dunkelgrüne Blatt zeugt von bester Qualität. Der Tee er-
hält seinen Character durch die Aufzucht der jungen Knospen im Schatten und hat ein
kräftiges Aroma, chmeckt frisch und sehr blumig; helle grüne Tasse.
100g 33,00DM

Unter der Abschnittsüberschrift „Spezialitäten“ fügen Sie folgende Definitionsliste ein:

515 Himbeere
Schwarze Tees aus Indien, Ceylon und China, gemischt mit Himbeerblättern und Aro-
ma.
100g 5,95DM

516 Mönchs-Tee
Schwarze Tees aus Indien und China und grüne Tees aus China, gemischt mit Jasmin-
blüten und Vanillestückchen und dem Geschmack von Bergamotte.
100g 6,60DM

517 Tropicana
Schwarze Tees aus China, Ceylon und Indien, gemischt mit Hibiskus, Rosenblüten,
Malveblüten und Sonnenblumenblüten. Das grapefruitähnliche, exotische Aroma gibt
dem Tee einen prächtigen Geschmack.
100g 5,95DM

Sie beenden die Description List durch Betätigen der Schaltfläche  der Werkzeugleiste
und Anwahl des Formats Normal.

Sie können Ihre Liste beispielsweise noch mit dem animierten Bild Golden Earth (ganim5b.gif)
von Dan Austin verschönern. Sie sollten die in Abbildung 102 dargestellte Teeliste erzeugt
haben.
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Ausgabe:

Abbildung 102: Definitions-Listen (tee.htm)
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Eingabe:

Abbildung 103: HTML-Sprachelemente zum Aufbau von Definitionslisten
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In Abbildung 103 sehen Sie, welche HTML-Sprachelemente zum Aufbau der Definitionslisten
verwendet wurden.
Eine Definitionsliste wird in die Tags <DL> ... </DL> eingeschlossen. Jeder Listeneintrag be-
steht aus Definition Term und Definition Data. Der Definition Term wird durch die Tags
<DT> ... </DT> geklammert. Das schließende Tag </DT> kann entfallen. Die Definitionsbe-
schreibung (Definition Data) wird durch die Tags <DD> ... </DD> geklammert. Auch hier
kann das schließende Tag </DD> entfallen.

4.8 Tabellen
Als letzte Liste wollen wir die Gewürzliste (gewuerz.htm) erstellen. Diese werden wir in
Form einer Tabelle gestalten. Sie soll nachher wie in Abbildung 111 dargestellt aussehen.
Öffnen Sie die Datei vorlage.htm im Netscape Editor. Ändern Sie Überschrift und Titel
des Dokumentes in „Holsteiner Tee&Gewürz-Kontor: Gewürzliste“ ab. Speichern Sie das Do-
kument unter dem Namen gewuerz.htm ab.

4.8.1 Aufbau einer Tabelle

Tabellengerüst
Positionieren Sie den Cursor hinter die Trennlinie. Beginnen Sie einen neuen Absatz durch
Betätigen der Return-Taste. Der Absatz soll linksbündig ausgerichtet sein.

Zum Einfügen einer Tabelle klicken Sie auf die Schaltfläche  der Werkzeugleiste. Sie er-
halten das in Abbildung 104 dargestellte Dialogfenster.

Abbildung 104: Dialogfenster: Tabelle einfügen

Schauen wir uns kurz an, welche Einstellungen über das Dialogfenster vorgenommen werden
können:
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Über die Felder Number of rows und Number of columns des Dialogfensters können Sie
einstellen, wieviele Zeilen und Spalten Ihre Tabelle haben soll.
Eine Tabelle wird normalerweise mit einem Gitternetz von einem Pixel Stärke dargestellt. Die
Dicke des Außenrahmens können Sie über das Feld Border line width variieren. Möchten Sie
beispielsweise eine Tabelle ohne Gitternetzlinien erstellen, so geben Sie hier eine 0 ein.

Über das Feld Cell spacing können Sie die Dicke der innenliegenden Gitternetzlinien einstel-
len. Cell padding gibt an, wieviel Raum zwischen Zelleninhalt und Zellrand verbleiben soll.

Abbildung 105: Wirkung von Cellspacing und Cellpadding

Die Breite und Höhe einer Tabelle ergibt sich standardmäßig aufgrund des Zellinhalts. Über die
Felder Table width und Table min height kann davon abweichend eine Breite und Höhe der
Tabelle vorgegeben werden. Breite und Höhe können prozentual zu den Ausmaßen des Anzei-
gefensters oder absolut in Anzahl Pixel angegeben werden. Diese erzwungene Dimensionie-
rung der Tabelle tritt außer Kraft, wenn der Browser den Tabelleninhalt in den vorgegebenen
Dimensionen nicht darstellen kann.

Standardmäßig wird eine Tabelle ohne Hintergrund, d. h. mit transparentem Hintergrund dar-
gestellt. Über das Dialogfeld Table color kann eine Hintergrundfarbe für die Tabelle eingestellt
werden.

Über die Schaltknöpfe Table alignment kann die horizontale Ausrichtung der Tabelle festge-
legt werden.
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Wir wollen eine Tabelle mit 14 Zeilen und 4 Spalten erstellen. Der Außenrahmen soll 5 Pixel
Stärke haben, die innenliegenden Gitternetzlinien sollen eine Stärke von 2 Pixel haben. Die
Tabelle soll 80 % der Breite des Anzeigefensters in Anspruch nehmen. Als Hintergrundfarbe
für die Tabelle wählen Sie eine Farbe, die zu unserem Hintergrundbild paßt. Die Tabelle soll
ferner zentriert erscheinen.
Sie sollten das Dialogfeld wie in Abbildung 106 dargestellt ausgefüllt haben. Quittieren Sie Ihre
Einstellungen mit OK.

Abbildung 106: Tabellen Einstellungen

Im Editorfenster erscheint ein leeres Tabellengerüst. Falls Sie die Gitternetzlinien auf dem
Hintergrundmuster nicht richtig erkennen können, so müssen Sie während der Bearbeitung der
Tabelle das Hintergrundmuster vom Dokument entfernen.

Achtung: Nicht alle Format-Vorgaben, die Sie für die Tabelle treffen, sehen Sie im Editor-
Fenster. Hier versagt das Wysiwyg-Verfahren in manchen Fällen. Insbesondere vertikale Aus-
richtungen werden erst im Browserfenster angezeigt

Formatierung von Tabellenzeilen
Die HTML-Sprachelemente zur Konstruktion von Tabellen sind im Vergleich zu den Sprache-
lementen, die wir bisher kennengelernt haben, sehr mächtig. Ein Autor kann Einfluß auf die
Gestaltung der Gesamttabelle nehmen. Darüberhinaus können separate Formatierungen für
einzelne Zeilen und sogar einzelne Zellen angegeben werden.
Klicken Sie mit der rechten Maustaste in die erste Zeile der Tabelle und wählen Sie den
Menüpunkt Table Properties. Sie finden jetzt Registerkarten, über die Sie das Aussehen gan-
zer Zeilen (Row) oder einzelner Zellen (Cell) verändern können.
Wählen Sie die Registerkarte Row und stellen Sie eine andere Farbe (etwa Orange) als Zeilen-
farbe ein (Abbildung 107). Über die anderen Schaltflächen können Sie die horizontale und ver-
tikale Ausrichtung der Zellinhalte einer Zeile vorgeben. Standardmäßig werden die Zellinhalte,
außer bei Kopfzeilen (siehe unten), linksbündig und vertikal zentriert ausgerichtet. Quittieren
Sie die Einstellungen mit OK.
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Abbildung 107: Zeilen Eigenschaften

Formatierung von Tabellenzellen
Die erste Zeile unserer Tabelle soll eine Kopfzeile sein, das heißt die Zellen sollen Spaltenüber-
schriften enthalten. Die Zellinhalte von Kopfzellen werden von den Browsern in der Regel
zentriert und fett dargestellt. Wir werden im folgenden die Zellen dementsprechend formatie-
ren. Klicken mit der rechten Maustaste in die linke Zelle der ersten Zeile. Wählen Sie den
Menüpunkt Table Properties und die Registerkarte Cell (Abbildung 108).

Abbildung 108: Zellen Eigenschaften
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Über das Feld Text alignment des Dialogfensters können Sie die horizontale und vertikale
Ausrichtung des Inhalts einer einzelnen Zelle einstellen. Im Feld Text stellen Sie ein, ob es sich
bei der Zelle um eine Kopfzelle (Header style) handeln soll und ob ein Textumbruch in der
Zelle (Wrap text) erlaubt ist.
Über die Felder Cell width und Cell min. height kann eine Zellenbreite und Zellenhöhe einge-
stellt werden. Zellenbreiten gelten für die gesamte Spalte. Entsprechend gelten Angaben zur
Zellhöhe für die gesamte Zeile, brauchen also nur jeweils für eine Zelle einer Spalte bzw. Zeile
eingestellt werden.
Über Cell color kann eine Zellenfarbe abweichend von der Tabellen- oder Zeilenfarbe gewählt
werden.
Über die Felder Cell spans ... row(s), and ... columns kann eingestellt werden, daß sich eine
Zelle über mehrere Zeilen oder Spalten einer Tabelle erstrecken soll (Abbildung 109).

Abbildung 109: Columnspan

Abbildung 110: Kopfzellen formatieren
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Um die erste Zelle unserer Tabelle als Kopfzelle (Header Style) zu formatieren, füllen Sie das
Dialogfenster wie in Abbildung 110 angegeben aus. Gleichzeitig haben wir eine Spaltenbreite
von 20% der Tabellenbreite für die erste Spalte vorgegeben. Quittieren Sie die Einstellungen
mit OK.

Fertigstellen der Gewürzliste
Die Manipulation von Tabellen mit Hilfe des Netscape Editors ist nicht sehr komfortabel, aber
dennoch ausreichend, wenn man sich einmal mit der Bedienung vertraut gemacht hat. Will man
beispielsweise mehrere zusammenhängende Zellen in gleicher Art formatieren, so erlaubt es der
Editor nicht, alle diese Zellen zu markieren und die Properties-Einstellungen in einem Vorgang
zu erledigen. Man muß die Formatierung für jede Zelle einzeln vornehmen.

Formatieren Sie alle Zellen der ersten Zeile als Kopfzellen (Table Properties -> Cell ->Text -
> Header Style). Geben Sie aber nur bei den letzten beiden Zellen eine explizite Spaltenbreite
(Cell width) von 20% vor.

Um einen Text in eine Zelle einzutragen, klicken Sie einfach mit der linken Maustaste in die
gewünschte Zelle. Geben Sie folgende Tabelle ein:

Bestellnummer  Bezeichnung Menge Preis in DM
1000 Basilikum 7,5 g 4,95
1001 Cayennepfeffer 35,0 g 3,95
1002 Chilipulver 30,0 g 3,95
1003 Curry 35,0 g 4,50
1004 Dillspitzen 7,5 g 2,95
1005 Knoblauchsalz 30,0 g 3,95
1006 Mayoran 7,5 g 4,95
1007 Oregano 7,5 g 4,95
1008 Rosmarin 7,5 g 4,95
1009 Thymian 7,5 g 4,95
1010 Pfeffer, weiß 30,0 g 3,95
1011 Pfeffer, schwarz 30,0 g 3,95

Die Zellendaten in den Spalten „Menge“ und „Preis in DM“ sollen rechtsbündig ausgerichtet
werden.
Wie oben schon einmal gesagt wurde, stellt der Netscape Editor nicht alle Tabellenformatie-
rungen dar. Sichern Sie sich Ihre Arbeit und schauen Sie sich die Tabelle im Netscape Browser
an. Sie sollten das in Abbildung 111 dargestellte Dokument erzeugt haben. Der Netscape
Browser wählt als Rahmenfarbe für die Tabelle die Hintergrundfarbe des Dokumentes. Der
Internet Explorer stellt eine Tabelle standardmäßig mit einer grauen Rahmenfarbe dar.
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Ausgabe:

Abbildung 111: Gewürzliste (gewuerz.htm)
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Eingabe:

Abbildung 112: Quelle der Gewürzliste
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Tabellengerüst
Zur Erzeugung unserer Tabelle hat der Netscape Editor folgendes HTML-Sprachelement ver-
wendet:

<TABLE BORDER=5 CELLSPACING=3 WIDTH="80%" BGCOLOR="#400000" >
...
</TABLE>

Eine Tabelle wird in die Tags <TABLE> ... </TABLE> eingeschlossen. Zwischen den <ta-
ble>-Tags werden Tabellenzeilen und Datenzellen definiert (siehe unten). Die Anzahl der Zei-
len und Spalten der Tabelle wird nicht explizit angegeben, sondern ergibt sich implizit aus der
Anzahl der definierten Tabellenzeilen und Datenzellen.

Über Attribute kann ein Autor Einfluß auf das Aussehen der Tabelle nehmen:

Das Attribut border = zahl beschreibt die Rahmenstärke der Tabelle in Pixel. Fehlt dieses At-
tribut oder ist der Attributwert 0, so wird die Tabelle ohne Rahmen gezeichnet (siehe auch
Abschnitt 0). Wird nur der Attributname border ohne Attributwert angegeben, so entspricht
dies der Einstellung border=1.

In Textverarbeitungsprogrammen ist es üblich, daß innenliegende Gitternetzlinien jeweils von
nebeneinanderliegenden Zellen geteilt werden. Mit anderen Worten, es gibt zwischen zwei
Zellen nur eine Trennlinie. Jede Zelle einer HTML-Tabelle hat dagegen eine eigene Umran-
dung. Über das Attribut cellspacing=zahl wird der Abstand zwischen den Umrandungen der
einzelnen Zellen und der Abstand der Zellumrandungen vom Rahmen der Tabelle gesteuert.
Der Netscape Editor stellt den Abstand zwischen den Zellen transparent dar, das heißt es
scheint die Hintergrundfarbe oder das Hintergrundmuster des Dokumentes durch. Der Internet
Explorer stellt diesen Abstand in der Hintergrundfarbe der Tabelle dar.

Der Abstand zwischen Zellinhalt und Zellumrandung wird über das Attribut cellpadding=zahl
in Pixel angegeben.

Standardmäßig ist eine Tabelle so dimensioniert, daß der Zellinhalt optimal in die Tabelle paßt.
Über die Attribute width und height kann vom Autor eine Tabellenbreite und -höhe vorgege-
ben werden. Der Attributwert kann eine Prozentzahl sein, die sich auf die Breite oder Höhe des
Anzeigefensters bezieht, oder ein Absolutwert in Pixel sein. Das Attribut height gehört nicht
zum HTML 3.2 Standard. Prozentuale Angaben werden von den Browsern teilweise fehlerhaft
interpretiert.

Über das Attribut bgcolor=#rgb kann eine Hintergrundfarbe für die Tabelle gewählt werden.
Das Vorgeben einer Tabellenfarbe wird vom HTML 3.2 Standard nicht vorgesehen. Sowohl
Internet Explorer als auch der Netscape Navigator interpretieren dieses Attribut.

Zur Tabellenausrichtung wird vom HTML-Standard das Attribut align=(left, center, right)
vorgesehen. Natürlich kann zur Ausrichtung einer Tabelle auch das Sprachelement <div align=
> ... </div> verwendet werden, in das man die Tabelle einschließt. Der Netscape Editor ver-
fährt in dieser Art.
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Formatieren von Tabellenzeilen
Jede Tabellenzeile wird in die Tags <TR> ... </TR> eingeschlossen. Zwischen diesen Tags
werden die Datenzellen definiert (siehe unten). Das schließende Tag </TR> kann entfallen.
Über Attributwerte können Voreinstellungen für die Zelldarstellungen der gesamten Zeile ge-
troffen werden.

Über das Attribut align=(left, center, right) und valign=(top, middle, bottom) kann die ho-
rizontale und vertikale Ausrichtung der Zellinhalte eingestellt werden. Standardmäßig werden
die Zellinhalte linksbündig und vertikal zentriert ausgegeben.

Über das Attribut bgcolor=#rgb kann eine Farbe zur Darstellung des Hintergrundes der Zellen
einer Zeile eingestellt werden. Das Vorgeben einer Zellenfarbe wird vom HTML 3.2 Standard
nicht vorgesehen. Sowohl Internet Explorer als auch der Netscape Navigator interpretieren
dieses Attribut.

Formatieren von Tabellenzellen
In die Tags <TR> ... </TR> einer Tabellenzeile werden die Tags für jede Datenzelle einge-
schlossen. Eine Datenzelle kann dabei als Kopfzelle ausgezeichnet sein. Eine Kopfzelle ist in
die Tags <TH> ... </TH> einzuschließend, eine „normale“ Datenzelle in die Tags <TD> ...
</TD>. Die schließenden Tags können entfallen. Kopfzellen dienen zur Formatierung von
Zeilen oder Spaltenüberschriften. Die Zellinhalte von Kopfzellen werden von den Browsern in
der Regel fett und zentriert dargestellt. Über Attributwerte kann das Aussehen jeder einzelnen
Kopf- und Datenzelle variiert werden.

Über das Attribut align=(left, center, right) und valign=(top, middle, bottom) kann die ho-
rizontale und vertikale Ausrichtung der Zellinhalte eingestellt werden. Standardmäßig werden
die Zellinhalte, außer bei Kopfzellen, linksbündig und vertikal zentriert ausgegeben.

Über das Attribut bgcolor=#rgb kann eine Farbe zur Darstellung des Hintergrundes einer Zelle
eingestellt werden. Das Vorgeben einer Zellenfarbe wird vom HTML 3.2 Standard nicht vor-
gesehen. Internet Explorer wie auch der Netscape Navigator interpretieren dieses Attribut.

Über die Attribute width und height kann eine Zellenbreite und -höhe bestimmt werden. Der
Attributwert kann eine absolute Zahl in Pixel sein oder ein prozentualer Anteil der Größe der
Gesamttabelle. Die Zellenbreite gilt für die gesamte Spalte einer Tabelle, muß also bei Bedarf
nur in jeweils einer Zelle einer Spalte gesetzt werden. Prozentuale Angaben werden von den
Browsern teilweise fehlerhaft interpretiert.

Normalerweise wird der Zellinhalt automatisch vom Browser umgebrochen. Dies kann über
das Attribut nowrap verhindert werden.

Über die Attribute colspan=zahl und rowspan=zahl kann eingestellt werden, daß sich eine
Zelle über zahl Spalten oder Zeilen erstreckt. Folgender HTML-Quellcode erzeugt die in
Abbildung 109 dargestellte Tabelle

<CENTER><TABLE BORDER=1 BGCOLOR="#FFFFFF" >
<TR><TH COLSPAN="3">&Uuml;berschrift</TH></TR>
<TR><TD>Datenzelle1</TD><TD>Datenzelle2</TD><TD>Datenzelle2</TD></TR>
</TABLE></CENTER>
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4.8.2 Weitere Tips zum Umgang mit dem Netscape Editor

Tabellen oder Tabellenelemente löschen
Eine Tabelle oder Teile einer Tabelle können Sie im Netscape Editor über das Kontextmenü
löschen. Klicken Sie dazu mit der rechten Maustaste in den Tabellenbereich und wählen Sie
den entsprechenden Menüpunkt Delete -> (Table, Row, Column, Cell) (Abbildung 113).

Tabellen oder Tabellenelemente einfügen
Sie können eine Tabelle auf diesem Wege auch um Teile ergänzen oder Tabellen sogar
schachteln. Wählen Sie dazu den Menüpunkt Insert -> (Table, Row, Column, Cell).

Abbildung 113: Umgang mit Tabellen

Beachten Sie, wie bereits schon mehrfach gesagt, daß die Darstellung der Tabelle im Editor-
fenster im allgemeinen nur annähernd der Darstellung der Tabelle im Browser-Fenster ent-
spricht.

Zellen verbinden
Tabellenzellen können sich über mehrere Spalten oder Zeilen erstrecken. Solche Tabellenfor-
matierungen sind im Netscape Editor etwas unhandlich vorzunehmen. Betrachten wir dazu ein
Beispiel.
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Beispiel:
Zur Beschreibung der Funktionen einer Mikrowelle soll folgende Tabelle erstellt werden:

Leistung Anwendung

in Watt in %
600 100 Ankochen
540 90 Erhitzen
480 80 Auftauen
300 50 Fortkochen

Es handelt sich um eine Tabelle bestehend aus 6 Zeilen und 3 Spalten. Die Zelle, in der die
Überschrift „Leistung“ steht, erstreckt sich über zwei Spalten (columnspan=2). Die Zelle, in
der die Überschrift „Anwendung“ steht, erstreckt sich über zwei Zeilen (rowspan=2).
Zur Konstruktion dieser Tabelle mit Hilfe des Netscape Editors erzeugen Sie als erstes das
Grundgerüst einer 6x3-Tabelle. Tragen Sie in die erste Zelle der ersten Spalte die Überschrift
„Leistung“ ein. Wie wollen jetzt dafür sorgen, daß sich diese Überschrift über zwei Zellen er-
streckt. Dazu klicken Sie mit der rechten Maustaste in die rechte Nachbarzelle und wählen
Delete -> Cell (Abbildung 114), um Platz für den Bereich zu schaffen, in den sich die Über-
schriftszelle erstrecken soll. Anschließend klicken Sie mit der rechten Maustaste in die Zelle
mit der Überschrift „Leistung“ und wählen Table Properties aus dem Kontextmenü aus.
Wählen Sie die Registerkarte Cell und tragen Sie Cell spans 1 row(s), and 2 column(s) in der
Registerkarte ein. Quittieren Sie mit OK.

Abbildung 114: Zelle entfernen

Tragen Sie in die oberste Zelle der rechten Spalte die Überschrift „Anwendung“ ein (Abbildung
115). Diese Überschrift soll sich über zwei Zeilen erstrecken. Dazu gehen wir wieder so vor,
daß zunächst die „störende“ darunterliegende Zelle mit Hilfe des Kontextmenüs entfernt wird
(Abbildung 116), denn in diesen Bereich wird sich später die Überschriftszelle erstrecken. An-
schließend klicken Sie mit der rechten Maustaste in die Zelle mit der Überschrift „Anwendung“
und wählen Table Properties aus dem Kontextmenü aus. Wählen Sie die Registerkarte Cell
und tragen Sie Cell spans 2 row(s), and 1 column(s) in der Registerkarte ein. Quittieren Sie
mit OK.
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Abbildung 115: Zeilen verbinden

Abbildung 116: Zellen verbinden

Zur Vervollständigung der Zellen sind jetzt nur noch die weiteren Daten einzutragen
(Abbildung 117).

Abbildung 117: Tabelle mit row- und columnspan
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4.9 Rahmenlose Tabellen
Alle grundlegenden Gestaltungselemente für Ihre Web-Seiten haben Sie bis zu diesem Zeit-
punkt kennengelernt. Wir begeben uns ab jetzt in den Bereich der „fortgeschrittenen“ Gestal-
tung von Web-Seiten. Da alle Vorgehensweisen zur Nutzung des Netscape Editors bereits
ausführlich in den vorangegangenen Abschnitten behandelt worden sind, finden Sie in den fol-
genden Abschnitten auch keine Schritt-für-Schritt Beschreibungen zur Nutzung des Editors
mehr vor.
Tabellen werden im Browserfenster ohne Gitternetzlinien dargestellt, wenn der Autor das Ta-
bellenattribut border=0 verwendet oder wenn das Attribut ganz fehlt.
Bei Tabellen mit farbigem Hintergrund ergibt sich bei der Darstellung im Internet Explorer und
im Netscape Navigator dann jedoch immer noch ein Gitternetzeffekt, wenn nicht auch noch das
Attribut cellspacing=0 gesetzt wird. In Abbildung 118 sehen Sie eine farbige rahmenlose Ta-
belle. Die Farbflächen treffen nur dann nahtlos aufeinander, wenn die Attribute border=0 und
cellspacing=0 gesetzt werden.

Abbildung 118: Rahmenlose Tabellen (border=0, cellspacing=0)

Aufgabe 4:
Gestalten Sie die Tabelle unserer Gewürzliste wie in Abbildung 118 mit Hilfe des Netscape
Editors rahmenlos. Hinweis: Klicken Sie dazu mit der rechten Maustaste in die Tabelle. Wäh-
len Sie aus dem Kontextmenü Table Properties und anschließend die Registerkarte Table.
Tragen Sie  border=0 und cellspacing=0 ein.
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Färben Sie die Zeilen abwechselnd hell und dunkel ein. Speichern Sie die Arbeit.
Schauen Sie sich die Gewürzliste im Internet Explorer und im Netscape Navigator an. Im Net-
scape Navigator treffen die Farbflächen nicht nahtlos aufeinander (Abbildung 119). Woran liegt
das:
Wenn Sie im Netscape Editor die Tabellen-Attribute in dieser Art setzen, so wird das Attribut
border=0 im erzeugten HTML-Tag nicht explizit gesetzt, das heißt das Attribut entfällt. Laut
Standard sollte dies auch zu einer rahmenlosen Tabelle führen. Der Internet Explorer stellt die
Tabelle auch korrekt dar, der Netscape Navigator wertet dies zur Zeit jedoch nicht korrekt
aus. Damit Ihre Tabelle in beiden Browsern nahtlos aussieht, müssen Sie das Attribut border=0
explizit in das <Table>-Tag schreiben. Dies geht nur durch Verwendung eines anderen Editors.

Sie können zu diesem Zweck auch einen ASCII-Editor direkt aus dem Netscape Editor aufru-
fen. Wählen Sie dazu im Netscape Editor den Menüpunkt Options -> Editor Preferences aus.
Geben Sie auf  der Registerkarte General im Feld  HTML Source den Pfad zu einem ASCII-
Editor an, z.B. unter Windows den Editor notepad.exe. Quittieren Sie mit OK.
Wenn Sie jetzt den Menüpunkt View -> Edit Document Source anwählen, so wird Ihre
HTML-Quelle in den Editor geladen. Hier nehmen Sie Ihre Änderungen vor und speichern die
Quelle. In unserem Fall fügen Sie das Attribut border=0 zum <Table>-Tag hinzu. Nach Been-
den des Editors befinden Sie sich wieder im Netscape Editorfenster. Hier sehen Sie die Ände-
rung noch nicht, sondern erst im Browserfenster. Anschließend dürfen Sie im Netscape Editor
keine weiteren Änderungen an der Tabelle vornehmen, da sonst der Eintrag border=0 automa-
tisch wieder gelöscht wird.
Diese Vorgehensweise ist recht umständlich, aber typisch, wenn Sie bei einem Wysiwyg-Editor
HTML-Elemente einfügen wollen, die sich nicht über das Menüsystem setzen lassen.

Abbildung 119: Netscape Tabelle bei fehlendem Attribut border=0
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4.10 Rahmenlose Tabellen als Design-Element
Wie bereits mehrfach erwähnt wurde, hat ein Autor nur sehr wenig Einfluß auf die Absatzfor-
matierung seines Dokumentes im Browserfenster: Beispielsweise gibt es keine Tabulatoren, es
kann kein Paragrapheneinzug angegeben werden, Seitenränder lassen sich nicht definieren.
Dies wird sich alles erst ändern, wenn ein Beschluß über die Definition von Style Sheets vom
W3-Konsortium verabschiedet wird. Style Sheets werden zur Zeit nur vom Internet Explorer
unterstützt.
Bislang benutzen Web-Autoren einen Trick, um etwas mehr Einfluß auf die Gestaltung Ihres
Dokumentes zu erhalten: Die Web-Seiten werden in rahmenlose und damit „unsichtbare“ Ta-
bellen verpackt. Durch die Möglichkeit, Zellbreiten und -höhen angeben zu können, lassen sich
vielfältige Formatierungseffekte simulieren.

4.10.1 Paragrapheneinzug
Der Paragrapheneinzug, den Sie im Abschnitt „Zuckerzeug“ der Abbildung 120 sehen, ist da-
durch erzeugt worden, daß die gesamte Liste in eine rahmenlose Tabelle, bestehend aus einer
Zeile und zwei Spalten, gesetzt wurde. Als Zellbreite für die linke Zelle ist 50 Pixel eingestellt
worden. Die Zelle enthält ansonsten nur einen „unsichtbaren“ Text: Dies ist ein geschütztes
Leerzeichen. Sie können im Netscape Editor ein geschütztes Leerzeichen über den Menüpunkt
Insert -> Nonbreaking Space einfügen7. Der Text der Liste wurde in die rechte Zelle der Ta-
belle eingesetzt.

Abbildung 120: Paragrapheneinzug

                                               
7 Es ist nicht sichergestellt, daß ein Browser leere Zellen auch darstellt. Eine Zelle, die mindestens ein ge-
schütztes Leerzeichen enthält, wird jedoch dargestellt.
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Nur zur Orientierung ist in Abbildung 121 der Tabellenrahmen sichtbar gemacht worden.

Abbildung 121: Sichtbare Tabelle

Auch bei Angabe einer Zellbreite hat der Autor keine Garantie dafür, daß eine Zelle wirklich in
der angegebenen Breite dargestellt wird. Im Konfliktfall entscheidet der Browser, in welcher
Breite er eine Zelle letztlich formatiert. Sie haben nur dann eine Garantie darüber, wie breit
eine Zelle ist, wenn der Inhalt der Zelle vom Browser nicht zusammengeschoben oder umge-
brochen werden kann. Einige Autoren verwenden daher als Inhalt für unsichtbare Spalten, die
in einer gewissen Breite erscheinen müssen, ein unsichtbares (transparentes) Bild in der ent-
sprechenden Größe (siehe dazu auch den nächsten Abschnitt).

Im Kasten sehen Sie den HTML-Code, der zur Erzeugung des Abschnitts „Zuckerzeug“ ver-
wendet wurde:

<H2>
<IMG SRC="zucker.gif" HEIGHT=96 WIDTH=96 ALIGN=CENTER>Zuckerzeug
</H2>
<!Rahmenlose Tabelle zur Absatzformatierung><TABLE>
<TR>
<! Erste Zelle erzeugt den Einzug um 50 Pixel>
<TD WIDTH="50">&nbsp;</TD>
<! Zweite Zelle mit Paragraphentext>
<TD>
<OL START=51>
<LI>Teezucker, 300 g 2,30 DM</LI>
<LI>Kluntjes, 300 g, 4,10 DM</LI>
<LI>Rum-Kandis, 250 g, 5,00 DM</LI>
<LI>Vanille-Rum-Kandis, 250g, 6,50 DM</LI>
<LI>Akazienhonig, 50 g, 2,40 DM</LI>
<LI>Orangenbl&uuml;tenhonig, 50 g, 2,40 DM</LI>
<LI>Lindenbl&uuml;tenhonig, 50 g, 2,40 DM</LI>
<LI>Akazienhonig, 250 g, 4,30 DM</LI>
</OL></TD>
</TR></TABLE>
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4.10.2 Corporate Design
Im Rahmen der Bestrebungen der Ruhr-Universität, Veröffentlichungen ein unverwechselbares
Aussehen zu geben, wurde auch für die Darstellung von Seiten im Web ein Hintergrundmuster
vorgeschlagen. Sie können dies Hintergrundmuster beispielsweise auf der Grundseite der Ruhr-
Universität sehen. In Abbildung 122 sehen Sie ebenfalls dies Muster.

Abbildung 122: Corporate Design 1 (rub-background-0.gif)

Es besteht aus einem blauen vertikalen Balken auf der linken Seite einer ansonsten weißen
Web-Seite. Es gibt auch noch Varianten zu diesem Hintergrund, beispielsweise wie in
Abbildung 123 dargestellt..

Abbildung 123: Corporate Design 2 (rub-bg1.gif)

Diese Hintergrundmuster sind auf dem Web-Server in einem zentralen Verzeichnis abgelegt.
Fragen Sie den Webmaster8, welches Verzeichnis das ist. (Zur Zeit heißt dies Verzeichnis
/icons/rub.)

                                               
8 volkmar.rudolph@rz.ruhr-uni-bochum.de
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Möchten Sie Seiten mit diesem Hintergrund entwerfen, so können Sie sich eine lokale Kopie
der Hintergrundbilder auf Ihren PC sichern. Wenn Sie später Ihre Seiten auf den Web-Server
übertragen, so sollten Sie die Anker so abändern, daß das Hintergrundmuster aus dem zentra-
len Verzeichnis verwendet wird. Für Text- und Ankerfarben sind ferner folgende Werte vorge-
geben: text=#000000 link=#0000ff alink=#ff0000 vlink=#551A8B bgcolor=#c0c0c0.
Bei Verwendung dieses Hintergrundmuster müssen Sie Ihren Seitentext in eine „unsichtbare“
Tabelle einschließen, da Sie einen linken Seitenrand durch eine leere Tabellenspalte in der
Breite des blauen Balkens simulieren müssen.
Wie oben schon gesagt, hat der Autor auch bei Angabe einer Zellbreite keine Garantie dafür,
daß die Zelle wirklich in der angegebenen Breite dargestellt wird. Im Konfliktfall entscheidet
der Browser, in welcher Breite er eine Zelle letztlich formatiert. Sie haben nur dann eine Ga-
rantie darüber, wie breit eine Zelle ist, wenn der Inhalt der Zelle vom Browser nicht zusam-
mengeschoben oder umgebrochen werden kann. Dazu kann man beispielsweise „unsichtbare“
Bilder in der erforderlichen Breite in die Zelle plazieren. Ein Verfahren hierzu stammt von Ro-
bert Tolksdorf und ist in einem Artikel von Henning Behme (iX 11/96, S. 156 ff.) beschrieben:
Ein 1 Pixel breites, transparentes Bild (Datei: 1transp.gif) wird mit Hilfe der Attribute height
und width des <img>-Tags auf die erforderliche Größe skaliert.

Beispiel:

Abbildung 124: Transparente Bilder (corporate.htm)

Zur Formatierung der in Abbildung 124 dargestellten Seite wurde eine rahmenlose Tabelle
bestehend aus einer Zeile und zwei Spalten gewählt. Die Breite der Tabelle wurde auf 100%
der Breite des Anzeigefensters eingestellt. Die Breite der linken Spalte wurde mit 120 Pixel
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vorgegeben. In die linke Spalte (Seitenrand) wurde ein transparentes Bild 1transp.gif plaziert,
wobei als Bildattribute height=3 und width=110 gewählt wurde. Zur Orientierung wurde in
Abbildung 125 das Gitternetz der Tabelle sichtbar gemacht.

Tip:
Wenn Sie im Netscape Editor mit rahmenlosen Tabellen arbeiten, so erstellen Sie die Tabelle
zur besseren Orientierung zunächst mit Rahmen und entfernen Sie erst nach Fertigstellung der
Tabelle wieder den Rahmen.

Abbildung 125: Sichtbares Gitternetz

Zur Formatierung der Tabelle wurde folgender HTML-Code erzeugt:

<TABLE WIDTH="100%" >
<TR>
<TD ALIGN=LEFT VALIGN=TOP WIDTH="120">
<IMG SRC="1transp.gif" HEIGHT=3 WIDTH=110></TD>

<TD><H1>Tabellen als Design-Element</H1>
<P>Zur Formatierung des Textes dieser Seite wurde eine rahmenlose Tabelle bestehend aus
einer Zeile und zwei Spalten gew&auml;hlt. Die Breite der Tabelle wurde auf 100% der Breite
des Anzeigefensters eingestellt. Die Breite der linken Spalte wurde mit 120 Pixel vorgegeben.
Die Angabe einer Zellbreite ist keine Garantie daf&uuml;r, da&szlig; die Zelle wirklich in der
angegebenen Breite dargestellt wird. Im Konfliktfall entscheidet der Browser, in welcher Breite
er eine Zelle letztlich formatiert. In die linke Spalte (Seitenrand) wurde daher ein transparentes
Bild der Gr&ouml;&szlig;e height=1, width=110 plaziert. </P></TD>
</TR>
</TABLE>
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4.10.3 Mehrspaltige Absätze
Rahmenlose Tabellen können auch dazu verwendet werden, einen Text scheinbar in mehrere
Spalten fließen zu lassen. Dies ist für den Autor nicht sehr komfortabel, da er den Spaltenum-
bruch selbst vornehmen muß.

Beispiel:

Abbildung 126: Textspalten (multicol.htm)

Zur Gestaltung der in Abbildung 126 dargestellten Seite wurde eine rahmenlose Tabelle beste-
hend aus einer Zeile und 4 Spalten verwendet. Jede Textspalte gehört zu einer separaten Spalte
der Tabelle. Die Tabelle hat eine Breite von 100% des Anzeigefensters. Die drei rechten Spal-
ten haben jeweils eine vorgegebene Breite von 25% der Tabellenbreite. Die linke Spalte wurde
noch mit einer Hintergrundfarbe eingefärbt.

Zur Formatierung von Spalten in Web-Dokumenten gibt es auch das Tag <multicol> (siehe
Anhang). Es hat den Vorteil, daß der Spaltenumbruch dann automatisch vom Browser vorge-
nommen wird. Dieses Tag versteht zur Zeit aber ausschließlich der Netscape Navigator.
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4.10.4 Absätze mit farbigem Hintergrund
Durch Verwendung von Tabellenfarben in rahmenlosen Tabellen können Sie farblich unterlegte
Textabsätze simulieren (Abbildung 127). Damit die Farben auch bei Betrachtung mit dem Net-
scape Navigator nahtlos aneinanderstoßen, müssen die Attribute cellspacing=0 und border=0
explizit im <Table>-Tag erscheinen (siehe oben: Abschnitt 4.9).

Abbildung 127: Farbiger Absatzhintergrund

4.10.5 Mehrzeilige rahmenlose Tabellen
Bislang haben wir in den Beispielen nur jeweils mehrspaltige, aber einzeilige Tabellen verwen-
det. Zeitungseffekte lassen sich durch Verwendung mehrspaltiger, mehrzeiliger Tabellen erzie-
len. Durch Verbinden von Zellen (colspan, rowspan) in diesen Tabellen oder durch Schachte-
lung von Tabellen lassen sich unterschiedlich große horizontale und vertikale Flächen bilden, in
die man dann Texte einfließen lassen kann. Die Home Page der Tagesschau des Ersten Deut-
schen Fernsehens verwendet beispielsweise derartige Effekte (http://www.tagesschau.de; Bei-
spiel in Abbildung 128).
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Abbildung 128: Home Page der Tagesschau

Durch Verwendung rahmenloser Tabellen als Design-Element lassen sich schöne Effekte für
Home Pages erzielen. In Abbildung 129 sehen Sie noch einmal eine Umgestaltung der Teeliste.
Vielleicht versuchen Sie sich selbst einmal daran, solch eine Seite zu formatieren.
Bei Verwendung derartiger Effekte sollten Sie aber bedenken, daß der Browser eine Tabelle
erst dann darstellt, wenn der gesamte Inhalt der Tabelle vom Server übertragen worden ist. Bei
den heutigen Netzgeschwindigkeiten kann dies (bei großer Entfernung zwischen Server und
Klient) recht lange dauern, wenn in der Tabelle viele Graphiken u. ä. untergebracht sind.
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Abbildung 129: Variante der Teeliste (tee1.htm)

4.11 Formulare
Zum Abschluß unseres Web-Projektes müssen wir noch ein Bestellformular entwickeln. Die
HTML-Seiten, die wir bisher erzeugt haben, präsentiertem dem Leser Informationen, die dieser
mehr oder weniger passiv konsumieren konnte. Über das Bestellformular wollen wir in Inter-
aktion mit dem Leser der Seite treten und Informationen erfragen. Über spezielle HTML-
Sprachelemente, die schon zum HTML 2.0 Standard gehörten, kann ein Web-Autor Formu-
larfelder auf seine Web-Seiten einfügen. Solche Formularfelder sind ein- oder mehrzeilige Ein-
gabefelder, die der Leser ausfüllen kann, Schaltflächen, die angeklickt und Auswahllisten, aus
denen Einträge ausgewählt werden können. Das ausgefüllte Formular wird vom Leser durch
Anklicken einer speziellen Schaltfläche wieder zurück an den Web-Server geschickt. Auf dem
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Web-Server müssen die Formulareingaben mit Hilfe spezieller Programme oder Skripten wei-
terverarbeitet werden. Derartige Server-Programme nennt man CGI-Programme. CGI steht für
Common Gateway Interface. Dies ist ein Standard, der festlegt, wie Programme auf Web-
Servern aufgerufen und mit Parametern versorgt werden können. Ein CGI-Programm kann in
jeder beliebigen Programmiersprache oder Skriptsprache, die der Web-Server versteht, verfaßt
werden. Zum Beispiel kann ein CGI-Programm in C/C++, Fortran, PERL, TCL etc. verfaßt
werden oder ein beliebiges UNIX Skript sein.
Ein Autor eines Formulars muß auch für die Formulierung und ggf. Übersetzung eines geeig-
neten CGI-Programms zur Auswertung seines Formulars Sorge tragen. CGI-Programme kön-
nen zur Ausführung auf Web-Servern in der Regeln nur in speziellen Verzeichnissen abgelegt
werden, auf die nur der Web-Master Zugriff hat. Dies hat auch einen guten Grund, denn mit
CGI-Programmen kann viel Unsinn angerichtet werden, wobei sicherlich noch ein weniger
schlimmer Fall darin besteht, daß ein fehlerhaftes Skript den gesamten Web-Server zum Ab-
sturz bringt9.
Nun ja, werden Sie sich fragen, warum soll ich mich dann überhaupt mit Web-Formularen be-
fassen, wenn ich die serverseitigen Programme nicht ablegen darf? Es gibt einen Ausweg aus
dieser Situation: Ein Web-Autor kann sich die Formulardaten ohne Zuhilfenahme eines CGI-
Skripts per email zusenden lassen. Diese Methode wollen wir im folgenden wählen.
Jetzt kommt noch ein weiterer Pferdefuß: Sie können Web-Formulare nicht mit Hilfe des Net-
scape Editors erfassen. Zum Entwurf des Bestellformulars werden wir daher einen einfachen
ASCII-Editor, etwa den Editor notepad unter Windows verwenden.

4.11.1 Formulargerüst

Ein Web-Formular wird in die HTML-Tags <form action=...  method=... > ... </form> einge-
schlossen.

Über das Attribut action des <form>-Tags wird angegeben, was mit dem ausgefüllten Formu-
lar nach dem Abschicken passieren soll. Als Wert für action ist ein URL anzugeben.
Beispiele:

1. action=“cgi-bin/form-mail“
form-mail ist ein CGI-Programm, das im Verzeichnis cgi-bin desselben Web-Servers abge-
legt ist, auf dem sich auch das Web-Formular befindet.

2. Soll die Formulareingabe an einen anderen Server zur Weiterverarbeitung geschickt werden,
so ist ein vollständiger URL anzugeben, etwa
action=“http://hoohoo.ncsa.uiuc.edu/cgi-bin/post-query“

3. Wenn sich ein Web-Autor die Formulareingabe per email zuschicken lassen möchte, so ist
ein URL in der Form mailto:email-adresse anzugegeben, etwa
action=“mailto:Der.Tester@rz.ruhr-uni-bochum.de“

Das Attribut method beschreibt, in welcher Form die Formulareingaben an den Server ge-
schickt werden. Aus Klientensicht bestimmt das CGI-Programm, das man verwendet, welcher

                                               
9 CGI-programs can crash your computer, burn your house down and steal all the money from your retirement
fund.
          aus der Konfigurationsanleitung des Apache Web-Servers
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Wert für method eingesetzt werden muß. Sollen Formulareingaben per email zugestellt wer-
den, so ist stets method=“post“ anzugeben.

Wir wollen nun ein entsprechendes Formulargerüst für unser Bestellformular erstellen. Laden
Sie dazu zunächst die Datei vorlage.htm in den notepad-Editor. Damit Sie die Vorlage
nicht versehentlich zerstören, sichern Sie sich die Datei gleich unter dem Namen be-
stell.htm.
Ändern Sie den Titel und die erste Überschrift des Dokumentes in „Holsteiner Tee&Gewürz-
Kontor: Bestellformular“ ab. Zur Erinnerung: Der Titel des Dokumentes steht zwischen den
Tags <TITEL> .... </TITEL>. Die erste Überschrift steht in den Tags <H1>...</H1>.
Geben Sie hinter das öffnende <body>-Tag des Dokumentenkörpers das Tag
<form action=“mailto:email-adresse“ method=“post“>
und vor das schließende </body>-Tag des Dokumentenkörpers das schließende Tag
</form>
ein. Die Email-Adresse müssen Sie natürlich durch Ihre eigene Email-Adresse ersetzen.
Sie sollten jetzt das in Abbildung 130 dargestellte HTML-Formular erzeugt haben. Die Zeilen,
die geändert oder eingefügt worden sind, sind grau unterlegt.

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 3.2//EN">
<HTML>
<HEAD>
   <TITLE>Holsteiner Tee&amp;Gew&uuml;rz-Kontor: Bestellformular</TITLE>
   <META NAME="Author" CONTENT="Der Tester">
   <META NAME="Description" CONTENT="Tee und Gewürz Verkauf">
   <META NAME="KeyWords" CONTENT="tea, Tee, spice, Gewürz, seasonings">
</HEAD>

<BODY TEXT="#FFFF80" BGCOLOR="#800000" LINK="#FF8040" VLINK="#FFFF80"
ALINK="#FF8040" BACKGROUND="sack.jpg">

<form action="mailto:Der.Tester@rz.ruhr-uni-bochum.de" method="post">

<P><A HREF="Index.html"><IMG SRC="back.gif" HEIGHT=35 WIDTH=40></A></P>

<H1 ALIGN=CENTER>Holsteiner Tee&amp;Gew&uuml;rz-Kontor: Bestellformular</H1>

<CENTER><P><IMG SRC="bar1p.gif" ALT="Trennlinie" HEIGHT=20
WIDTH=544></P></CENTER>

</form>

</BODY>
</HTML>

Abbildung 130: Formulargerüst des Bestellformulars

Speichern Sie Ihre Arbeit ab. Dieses Formular verfügt noch über keinerlei Möglichkeiten zur
Eingabe. Dazu müssen wir geeignete Formularfelder zwischen die <form>-Tags einfügen.
Formularfelder können ein- oder mehrzeilige Eingabefelder, Kontrollkästchen, Auswahllisten
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oder spezielle Ausführungsknöpfe sein. Wie diese formatiert werden, wird in den nächsten Ab-
schnitten beschrieben.

4.11.2 Eingabefelder
Ein einzeiliges Eingabefeld formatiert man über das HTML-Sprachelement:

<input type=text name=“bezeichner“>

Das HTML-Sprachelement muß in genau der angegebenen Art notiert werden, wobei Sie für
bezeichner einen beliebigen Namen wählen können. Dieser darf keine Leerzeichen und Um-
laute enthalten. Der Bezeichner dient als interne Kennzeichnung des Eingabefeldes. Im
Browser-Fenster wird für das <input>-Tag ein 20-spaltiges Eingabefeld dargestellt, in das der
Leser seine Angaben eintragen kann (Abbildung 131).

Abbildung 131: Einzeilige Eingabefelder

Das <input>-Tag kennt weitere Attribute, über die der Autor Einfluß auf die Darstellung des
Feldes im Browser-Fenster nehmen kann.
Standardmäßig wird ein Eingabefeld 20 Zeichen breit angezeigt. Über das Attribut size=
“ganze_zahl“ kann eine andere Anzeigelänge vorgegeben werden.
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Über das Attribut maxlength=“ganze_zahl“ können Sie ferner eine interne Maximallänge für
die Eingabe vorgeben. In das Eingabefeld können dann maximal maxlength Zeichen eingegeben
werden.
Über das Attribut value=“wert“ kann eine Vorgabe gemacht werden, die im Eingabefeld an-
gezeigt wird. Diese kann dann mit den aktuellen Angaben, die der Leser machen möchte, über-
schrieben werden.

In Abbildung 131 sehen Sie einige Beispiele für die Formatierung von Eingabefeldern. Über
den jeweiligen Eingabefeldern sehen Sie das zugehörige HTML-Sprachelement, das das Feld
erzeugt hat. Zusätzliche Kommentare zu einem Eingabefeld müssen extra notiert werden, wie
Sie im letzten Beispiel  in Abbildung 131 sehen können.

Mehrere zusammengehörige Eingabefelder können zur schöneren Formatierung auch in einer
Tabelle zusammengefaßt werden. Die Zellen der Tabelle sind dann die Eingabefelder. Ein Bei-
spiel dafür sehen Sie in Abbildung 132.

Abbildung 132: Formatierung von Eingabefeldern in einer Tabelle

Auch in unserem Bestellformular wollen wir eine solche Tabelle verwenden. In diese Tabelle
soll der Leser nachher seine Bestellung mit Bestellnummer, Bezeichnung des Artikels und Preis
eintragen können. Die Tabelle soll 6 Eingabezeilen und eine Überschriftenzeile haben. Tragen
Sie die HTML-Sprachelemente zur Formatierung der Tabelle hinter das HTML-Sprachelement
zur Formatierung der Trennlinie ein. Die HTML-Quelle zum Aufbau der Tabelle sehen Sie in
Abbildung 133. Achten Sie darauf, daß die Eingabefelder der Zeile # von links nach rechts mit
den internen Namen nr#, bezeichner# und preis# benannt werden. Sie werden später sehen,
wozu das gut ist. Speichern Sie Ihre Arbeit und schauen Sie sich das Dokument im Netscape
Navigator an. Versuch Sie einmal, etwas in die Tabelle einzutragen. Es funktioniert, aber der
Leser hat noch keine Möglichkeit, seine Eingaben abzusenden. Dies werden wir im nächsten
Schritt ändern.
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<table border=3 bgcolor=#000000 width=50%>
<tr>
<th>Nr
<th>Bezeichnung
<th>Preis
<tr>
<td><input type="text" name="nr1" size="5">
<td><input type=text name="bezeichner1" size="50">
<td><input type=text name="preis1" size="6">
<tr>
<td><input type="text" name="nr2" size="5">
<td><input type=text name="bezeichner2" size="50">
<td><input type=text name="preis2" size="6">
<tr>
<td><input type="text" name="nr3" size="5">
<td><input type=text name="bezeichner3" size="50">
<td><input type=text name="preis3" size="6">
<tr>
<td><input type="text" name="nr4" size="5">
<td><input type=text name="bezeichner4" size="50">
<td><input type=text name="preis4" size="6">
<tr>
<td><input type="text" name="nr5" size="5">
<td><input type=text name="bezeichner5" size="50">
<td><input type=text name="preis5" size="6">
<tr>
<td><input type="text" name="nr6" size="5">
<td><input type=text name="bezeichner6" size="50">
<td><input type=text name="preis6" size="6">
</table>

Abbildung 133: HTML-Quelle der Bestelltabelle

4.11.3 Der Submit Schaltknopf
Über einen Submit (Absenden) Schaltknopf kann ein Leser seine Formulareingaben zur Wei-
terverarbeitung absenden. Diesen Schaltknopf formatiert ein Autor über das Sprachelement

<input type=submit value=“wert“>

Das HTML-Sprachelement muß in genau der angegebenen Art notiert werden, wobei Sie für
wert einen beliebigen Text wählen können. Im Browser-Fenster wird für dieses Sprachelement
ein Schaltknopf dargestellt, der mit dem angegebenen Text als Beschriftung versehen ist. Betä-
tigt ein Leser diese Schaltfläche, so wird die Formulareingabe zur Weiterverarbeitung abge-
schickt. Die Weiterverarbeitung erfolgt gemäß der Angabe zum action Attribut des <form>-
Tags.
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Tragen Sie in die Datei bestell.htm hinter die Tabelle zwei „sanfte“ Zeilenumbrüche
(<BR>) und anschließend das Sprachelement
<input type=submit value=“Bestellung abschicken“>
ein.
In Abbildung 134 sehen Sie die Darstellung des bisher erzeugten Bestellformulars im Netscape
Navigator.

Abbildung 134: Erste vorläufige Version  des Bestellformulars

Die ersten drei Zeilen sind bereits vom Leser ausgefüllt worden. Durch Betätigen der Schalt-
fläche „Bestellung abschicken“ kann er seine Bestellung zur Weiterverarbeitung absenden.
Gemäß des in Abschnitt 4.11.1 eingesetzten <form>-Tags erhalten Sie die Formulareingabe per
email zugestellt. Sie können dies vielleicht schon einmal testen, dazu benötigen Sie allerdings
einen Internet-Kontakt.
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4.11.4 Der „mailtto: Formatter“
Haben Sie das Formular wie in Abbildung 134 dargestellt ausgefüllt und abgeschickt, so er-
halten Sie folgende Formulareingabe per email zugestellt:

nr1=51&bezeichner1=Teezucker&preis1=2%2C30&nr2=74&bezeichner2=Teekanne%2C+Jap
an%2C+wei%DF&preis2=62%2C80&nr3=118&bezeichner3=Ceylon+BOP+Dimbula+mediu
m&preis3=4%2C40&nr4=&bezeichner4=&preis4=&nr5=&bezeichner5=&preis5=&nr6=&bez
eichner6=&preis6=

Die Formulareingabe ist zu einer langen Zeile (ohne Leerzeichen) zusammengefügt worden. In
dieser Zeile sind die internen Namen aller Formularfelder in der Reihenfolge ihrer Definition
aufgeführt10. Hinter jedem internen Namen steht ein Gleichheitszeichen. Hat der Leser ein Feld
mit einem Eingabewert versehen, so erscheint der Eingabewert hinter dem Gleichheitszeichen
des internen Namens des zugehörigen Feldes. Die einzelnen Formularfelder werden durch ein
kaufmännisches UND (&) voneinander getrennt. Leerzeichen in der Eingabe des Benutzers
werden durch ein Pluszeichen (+) ersetzt, Sonderzeichen gemäß der ISO-Latin-1 Codetabelle
durch %## (# ist eine hexadezimale Ziffer) kodiert. Beispielsweise erscheint ein Komma in der
Eingabe anschließend als %2C.

Abbildung 135: mailto: Formatter (Robert P. Fries)

In dieser Form ist die Formulareingabe nicht mehr gut lesbar.

                                               
10 Sehen Sie nun, wie wichtig die eindeutige Bezeichnung der einzelnen Formularfelder mit internen Namen
ist?
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Es gibt viele kleine Helfer-Programme, die diese kryptische Formulareingabe wieder in ein et-
was schöneres Format bringen. Ein nettes kleines Programm dieser Art ist der „mailto: For-
matter“ von Robert P. Fries. Es ist für Windows und Macintosh erhältlich. Zu finden ist dieses
Programm z.B. im „Windows 95 Internet Headquater“ (http://www.windows95.com) im Ver-
zeichnis „Misc. Web Authoring Tools“. Das Programm kann im privaten Gebrauch kostenlos
genutzt werden. Nach Start des Programms erhält man das in Abbildung 135 dargestellte Fen-
ster. Durch File -> Open lädt man die Formulareingabe, die man sich zuvor aus seiner Mailbox
in eine Datei gesichert hat11, in den oberen Fensterbereich. Durch Betätigen der Schaltfläche
Convert File veranlaßt man nun die Konvertierung der Datei in ein schöneres Format. Die
konvertierten Daten werden im unteren Fensterbereich angezeigt. Sie können die Daten im
neuen Format durch File -> Save as sichern.
Aus unserer Formulareingabe ist jetzt wieder eine recht gut lesbare Bestellung geworden
(Abbildung 136), insbesondere sind auch alle kodierten Sonderzeichen wieder durch das ent-
sprechende Sonderzeichen ersetzt worden.

Abbildung 136: Konvertierte Formulareingabe

In den nächsten Abschnitten lernen Sie einige weitere HTML-Sprachelemente zur Formatie-
rung von Formularfeldern kennen. Diese wollen wir nutzen, um unser Bestellformular zu ver-
vollständigen.

4.11.5 Der Reset Schaltknopf
Der Reset Schaltknopf dient dazu, das Formular wieder zu normieren. Dies ist ganz nützlich,
wenn sich der Leser beim Ausfüllen z.B. einmal hoffnungslos vertan hat. Der Reset Schalt-
knopf wird über das HTML-Sprachelement

<input type=reset value=“wert“>

                                               
11 Das Programm kann auch direkt auf einem Mailfolder arbeiten.

nr1=51
bezeichner1=Teezucker
preis1=2,30
nr2=74
bezeichner2=Teekanne, Japan, weiß
preis2=62,80
nr3=118
bezeichner3=Ceylon BOP Dimbula medium
preis3=4,40
nr4=
bezeichner4=
preis4=
nr5=
bezeichner5=
preis5=
nr6=
bezeichner6=
preis6=
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formatiert.
Das HTML-Sprachelement muß in genau der angegebenen Art notiert werden, wobei Sie für
wert einen beliebigen Text wählen können. Im Browser-Fenster wird für dieses Sprachelement
ein Schaltknopf dargestellt, der mit dem angegebenen Text als Beschriftung versehen ist. Betä-
tigt ein Leser diese Schaltfläche, so wird das Formular wieder auf den ursprünglichen Stand
normiert.
Fügen Sie einen solchen Schaltknopf neben den Submit-Schaltknopf in unser Bestellfomular
ein. Er soll die Beschriftung „Bestellung neu ausfüllen“ tragen.

4.11.6 Mehrzeilige Textfelder
Mehrzeilige Eingabefeld werden über das HTML-Sprachelement:

<textarea name=“bezeichner“> ... </textarea>

formatiert. Bezeichner ist ein beliebiger interner Name. Dieser darf keine Leerzeichen und
Umlaute enthalten. Im Browser-Fenster wird für das <textarea>-Tag ein 20-stelliges einzeiliges
Eingabefeld mit vertikalen und horizontalen Rollbalken dargestellt, in das der Leser mehrzeilige
Angaben eintragen kann (Abbildung 137).

Abbildung 137: Mehrzeilige Textfelder
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Standardmäßig wird ein Textfeld einzeilig und 20 Zeichen breit angezeigt. Über die Attribute
rows= “ganze_zahl“ und cols= “ganze_zahl“ kann eine andere Anzeigelänge und -breite vor-
gegeben werden.

Wenn das Textfeld mit Eingaben vorbelegt werden soll, so sind diese zwischen die Tags
<textarea>...</textarea> anzugeben.

In Abbildung 137 sehen Sie einige Beispiele für die Formatierung von Textfeldern. Über den
jeweiligen Textfeldern sehen Sie die zugehörigen HTML-Sprachelemente, die das Feld erzeugt
hat.

Bei der Eingabe von Text in Formulartextfelder wird am Ende der Eingabezeile nicht automa-
tisch umgebrochen (wrap=“off“). Diese Verhaltensweise kann ein Autor durch das Attribut
wrap=“virtual“ oder wrap=“physical“ einstellen. Der Wert virtual bewirkt, daß bei der
Texteingabe zwar umgebrochen wird, die Zeilenumbrüche aber nicht tatsächlich in der Formu-
lareingabe erscheinen. Automatische Zeilenumbrüche erscheinen auch in der Formulareingabe,
wenn das Attribut wrap auf physical eingestellt ist. Das Attribut warp gehört nicht zum
HTML-Standard.

Wir wollen unser Bestellformular um ein mehrzeiliges Textfeld ergänzen, in das der Leser seine
Lieferanschrift eintragen kann. Beginnen Sie dazu vor den Submit und Reset Knöpfen einen
neuen Paragraphen. Geben Sie in die erste Zeile dieses Paragraphen in einem etwas größeren
Font die Feldkennzeichnung „Lieferanschrift“ ein. Beenden Sie diese Zeile mit einem „sanften“
Zeilenumbruch. Geben Sie jetzt die HTML-Sprachelemente zur Formatierung eines mehrzeili-
gen Textfeldes ein. Es sollen 3 Zeilen und 60 Spalten des Textfeldes angezeigt werden. Das
Textfeld soll mit den folgenden drei Eingabezeilen vorbelegt werden (Abbildung 138):

Name, Vorname
D-xxxxx Ort
Straße

<P>
<font size=+2>Lieferanschrift:</font><br>
<textarea name="anschrift" rows="3" cols="60" wrap="virtual">
Name, Vorname
D-xxxxx Ort
Straße
</textarea><br><br>
<input type=submit value="Bestellung abschicken">
<input type=reset value="Bestellung neu ausfüllen">

Abbildung 138: Lieferanschrift als mehrzeiliges Textfeld

Ihr Bestellformular sollte jetzt wie in Abbildung 139 angegeben aussehen.
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Abbildung 139: Bestellformular mit Lieferanschrift

4.11.7 Auswahllisten
Zusätzlich zu Feldern, in die freier Text eingegeben werden kann, gibt es auch Formularfelder,
in denen der Leser aus einer vorgegebenen Liste eine Auswahl treffen kann. Derartige Formu-
larfelder werden über das HTML-Sprachelement select formatiert:

<select name=“bezeichner“>
<option value=“wert1“> Auswahl 1
<option value=“wert2“> Auswahl 2
....
</select>
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Eine Auswahlliste wird durch die Tags <select> ... </select> geklammert.Dabei ist bezeichner
ein beliebiger interner Name zur Kennzeichnung des Formularfeldes. Dieser darf keine Leerzei-
chen und Umlaute enthalten.
Zwischen den <select>-Tags sind die gewünschten Listeneinträge jeweils in Form eines
<option>-Tags anzugeben. Das optionale Attribut value im <option>-Tag legt einen internen
Name für den Listeneintrag fest. Ist dieses Attribut spezifiziert, so wird der interne Wert an-
statt des tatsächlichen Listeneintrags in der Formulareingabe übermittelt. Der zugehörige Li-
steneintrag ist auf das <option>-Tag folgend anzugeben.
Im Browser-Fenster wird für das <select>-Tag eine Auswahlliste in Form eines Pull-down Me-
nüs angezeigt (Abbildung 140). Ist das Menü zugeklappt, so ist standardmäßig nur ein Listen-
eintrag sichtbar. Über das Attribut size=“ganze_zahl“ des <select>-Tags kann ein Autor eine
davon abweichende Anzahl an sichtbaren Zeilen festlegen.

Abbildung 140: Auswahllisten

Aus dem Pull-down Menü des Formularfeldes kann der Leser durch Anklicken mit der linken
Maustaste den gewünschten Eintrag wählen. Falls vom Autor nicht anders angegeben, kann
nur jeweils ein Eintrag ausgewählt werden. Über das Attribut multiple des <select>-Tags kann
ein Autor davon abweichend bestimmen, daß der Leser auch eine Mehrfachwahl treffen darf
(zweites Beispiel in Abbildung 141). Der erste Listeneintrag wird dabei durch Anklicken mit
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der linken Maustaste gewählt. Zusätzliche Listeneinträge können durch Anklicken mit der lin-
ken Maustaste bei gleichzeitig gedrückter Shift- oder STRG-Taste gewählt werden.
Wählt der Leser aus einer Auswahlliste nicht explizit einen Eintrag aus, so gilt standardmäßig
der erste Listeneintrag als ausgewählt. Abweichend davon kann ein Autor über das selected
Attribut des <option>-Tags eine andere Voreinstellung für die Standardauswahl treffen.

Abbildung 141: Noch mehr Auswahllisten

Wir wollen nun unser Bestellformular um eine Auswahlliste ergänzen. Als Service für den
Käufer bietet das „Holsteiner Tee&Gewürz-Kontor“ ein Quartalsgeschenk an. Zur Auswahl
stehen die fünf Geschenke Teezucker (200 g), ein Teesieb, Akazienhonig (50 g), eine Würz-
mischung für Pilzgerichte und Mönchs-Tee (50 g), von denen der Käufer eins auswählen darf.
Formatieren Sie vor das Formularfeld „Lieferanschrift“ einen neuen Absatz. Beginnen Sie die-
sen mit der Kennzeichnung „Quartalsgeschenk:“ und fügen Sie eine einzeilige Auswahlliste mit
den genannten Geschenken ein (Abbildung 142).

<P>Quartalsgeschenk:
<select name="Geschenk">
<option value="Teezucker"> Teezucker (200 g)
<option  value="Teesieb" > Teesieb
<option value="Honig"> Akazienhonig (50 g)
<option value="Gewuerz"> Würzmischung für Pilzgerichte
<option value="Tee"> Mönchs-Tee (50 g)
</select></P>

Abbildung 142: HTML-Quelle für das Formularfeld „Quartalsgeschenk“
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4.11.8 Kontrollkästchenformularfelder mit einfacher Wahlmöglichkeit
Um einem Leser die Möglichkeit zu bieten, aus einer Reihe von Alternativen durch
„Ankreuzen“ eines Kästchens eine Alternative auszuwählen, werden Kontrollkästchenformu-
larfelder benutzt. Ein solches Kontrollkästchenformularfeld wird über folgende HTML-
Sprachelemente formatiert:

<input type=radio name=“bezeichner“ value=“wert1“> Beschriftung1
<input type=radio name=“bezeichner“ value=“wert2“> Beschriftung2
.....
<input type=radio name=“bezeichner“ value=“wertx“> Beschriftungx

Für jedes <input>-Tag wird im Browser-Fenster ein kleines anklickbares „Kästchen“ gefolgt
von der Beschriftung dargestellt (Abbildung 143).

Abbildung 143: Kontrollkästchenformularfeld mit einfacher Auswahlmöglichkeit

Der Wert für bezeichner im <input>-Tag ist ein beliebiger interner Name zur Kennzeichnung
des Formularfeldes. Dieser darf keine Leerzeichen und Umlaute enthalten. Alle Kontrollkäst-
chen, die zu einer Auswahl gehören sollen, müssen mit demselben internen Namen bezeichnet
werden. Im <input>-Tag muß das Attribut value spezifiziert werden. Jedes Kontrollkästchen
einer Auswahl muß dabei mit einem anderen Value-Wert belegt werden. Dieser Wert wird in
der Formulareingabe übermittelt, wenn das Kontrollkästchen vom Leser ausgewählt wurde.
Über das Attribut checked sollte eine Vorauswahl getroffen werden, da sonst die Formularein-
gabe undefiniert ist, wenn der Leser selbst keine Auswahl trifft (vgl. zweites Beispiel in
Abbildung 143).
Bei dieser Art von Kontrollkästchenformularfeldern kann nur jeweils ein Kontollkästchen an-
geklickt werden. Möchte man eine Mehrfachwahlmöglichkeit zulassen, so müssen die Formu-
larfelder wie im nächsten Abschnitt beschrieben formatiert werden.
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Fügen Sie ein Kontrollkästchenformularfeld zur Abfrage der Zahlungsart hinter das Formular-
feld für die Lieferanschrift in unser Bestellformular ein. Das Feld soll genau wie im zweiten
Beispiel der Abbildung 143 angegeben aussehen.

4.11.9 Kontrollkästchenformularfeld mit mehrfacher Wahlmöglichkeit
Kontrollkästchenformularfelder mit Mehrfachwahlmöglichkeit werden ganz ähnlich erzeugt,
wie Formularfelder mit Einfachwahlmöglichkeit. Lediglich der Typ im <input>-Tag ist auf ty-
pe=“checkbox“ zu setzen. Das heißt, ein Kontrollkästchenformularfeld mit Mehrfachwahl-
möglichkeit wird über folgende HTML-Sprachelemente formatiert:

<input type=checkbox name=“bezeichner“ value=“wert1“> Beschriftung1
<input type=checkbox name=“bezeichner“ value=“wert2“> Beschriftung2
.....
<input type=checkbox name=“bezeichner“ value=“wertx“> Beschriftungx

Für jedes <input>-Tag wird im Browser-Fenster ein kleines anklickbares „Kästchen“ gefolgt
von der Beschriftung dargestellt (Abbildung 144).

Abbildung 144: Kontrollkästchen mit Mehrfachwahl

Der Wert für bezeichner im <input>-Tag ist ein beliebiger interner Name zur Kennzeichnung
des Formularfeldes. Dieser darf keine Leerzeichen und Umlaute enthalten. Alle Kontrollkäst-
chen, die zu einer Auswahl gehören sollen, müssen mit demselben internen Namen bezeichnet
werden. Im <input>-Tag muß das Attribut value spezifiziert werden. Jedes Kontrollkästchen
einer Auswahl muß dabei mit einem anderen Value-Wert belegt werden. Dieser Wert wird in
der Formulareingabe übermittelt, wenn das Kontrollkästchen vom Leser ausgewählt worden
ist. Über das Attribut checked kann eine Vorauswahl getroffen werden.

Unser Bestellformular können Sie in voller „Schönheit“ noch einmal in Abbildung 145 an-
schauen. Ihr Bestellformular sollte auch so aussehen. In Abbildung 146 sehen Sie den gesamten
Quellcode zur Erzeugung dieses Formulars.
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Ausgabe:

Abbildung 145: Bestellformular (bestell.htm)
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Eingabe:
<BODY TEXT="#FFFF80" BGCOLOR="#000000" LINK="#FF8040" VLINK="#FFFF80"
ALINK="#FF8040" BACKGROUND="sack.jpg">
<FORM action="mailto:Der.Tester@rz.ruhr-uni-bochum.de" method="post">

<P><A HREF="Index.html"><IMG SRC="back.gif" HEIGHT=35 WIDTH=40></A></P>
<H1 ALIGN=CENTER>Holsteiner Tee&amp;Gew&uuml;rz-Kontor: Bestellformular</H1>
<CENTER><P><IMG SRC="bar1p.gif" HEIGHT=20 WIDTH=544></P></CENTER>

<center><table border=3 bgcolor=#000000 width=50%>
<tr><th>Nr <th>Bezeichnung <th>Preis
<tr>
<td><input type="text" name="nr1" size="5">
<td><input type=text name="bezeichner1" size="50">
<td><input type=text name="preis1" size="6">
<tr>
<td><input type="text" name="nr2" size="5">
<td><input type=text name="bezeichner2" size="50">
<td><input type=text name="preis2" size="6">
<tr>
<td><input type="text" name="nr3" size="5">
<td><input type=text name="bezeichner3" size="50">
<td><input type=text name="preis3" size="6">
<tr>
<td><input type="text" name="nr4" size="5">
<td><input type=text name="bezeichner4" size="50">
<td><input type=text name="preis4" size="6">
<tr>
<td><input type="text" name="nr5" size="5">
<td><input type=text name="bezeichner5" size="50">
<td><input type=text name="preis5" size="6">
<tr>
<td><input type="text" name="nr6" size="5">
<td><input type=text name="bezeichner6" size="50">
<td><input type=text name="preis6" size="6"></table><br>

<P>Quartalsgeschenk: <select name="Geschenk">
<option value="Teezucker"> Teezucker (200 g)
<option  value="Teesieb" > Teesieb
<option value="Honig"> Akazienhonig (50 g)
<option value="Gewuerz"> Würzmischung für Pilzgerichte
<option value="Tee"> Mönchs-Tee (50 g)</select></P>

<P><font size=+2>Lieferanschrift:</font><br>
<textarea name="anschrift" rows="3" cols="60" wrap="virtual">
Name, Vorname
D-xxxxx Ort
Straße</textarea>

<p>Zahlungswunsch:
<input type=radio name="Zahlungsart"  value="Nachname"> Nachname
<input type=radio name="Zahlungsart"  value="Rechnung" checked> Rechnung<br><br>
<input type=submit value="Bestellung abschicken">
<input type=reset value="Bestellung neu ausfüllen"></center>
</FORM></BODY>

Abbildung 146: Quelle des Dokumentkörpers von bestell.htm
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5 Anhang

Index der HTML-Sprachelemente
zusammengestellt von Rainer Wojcieszynski

Alphabetische Auflistung der in der Einführung besprochenen HTML-Tags. Die in den Index-
Tabellen angegebenen Fundstellen beziehen sich auf die nachfolgenden Tabellen: Die Fund-
stelle x.y bezeichnet Tabelle x, Eintrag Nr. x.y

HTML-Tag Fundstelle
<a> 4.4, 4.5,

4.6, 4.7, 7.4
<address> 2.1
<applet> 2.22
<b> 3.1
<basefont> 3.19
<bgsound> 6.3
<big> 3.6
<blink> 3.4
<blockquote> 2.2
<body> 1.3
<br> 4.2, 4.3
<caption> 5.3
<center> 2.3
<cite> 3.13
<code> 3.18
<dfn> 3.14
<div> 2.6
<dl> 2.14

HTML-Tag Fundstelle
<em> 3.12
<embed> 6.4
<font> 3.20
<form> 2.17, 2.18
<frame> 7.3
<frameset> 7.1, 7.2
<hr> 2.15, 2.16
<html> 1.1
<hx> 2.8, 2.9
<i> 3.2
<img> 4.1
<input> 2.19
<kbd> 3.17
<marquee> 6.2
<multicol> 6.5
<noframe> 7.5
<ol> 2.12, 2.13
<p> 2.4, 2.5
<pre> 2.7

HTML-Tag Fundstelle
<samp> 3.15
<script> 6.1
<select> 2.21
<small> 3.7
<strike> 3.5
<strong> 3.11
<sub> 3.9
<sup> 3.8
<table> 5.1, 5.2
<td> 5.6
<textarea> 2.10
<th> 5.5
<title> 1.2
<tr> 5.4
<tt> 3.10
<u> 3.3
<ul> 2.10, 2.11
<var> 3.16

HTML-Sprachelemente

Die nachfolgende Zusammenstellung enthält nur die in dieser Einführung besprochenen
HTML-Sprachelemente. Die Aufzählung der Elemente und ihrer Attribute ist nicht umfassend.
Kursiv gesetzte Begriffe gelten als Variablen, die in nachfolgenden Zeilen definiert werden.
Grundsätzlich dürfen bei Optionen der Art option=argument die Argumentangaben immer in
doppelte Anführungsstriche eingeschlossen werden. In den Tabellen ist dies nur dann explizit
angegeben, wenn die möglichen Argumente diese Syntax erforderlich machen könnten.
In der Spalte HS ist der HTML-Standard angegeben, in dem das entsprechende Tag definiert
wird. Ein „-“ als Eintrag kennzeichnet, daß das Tag noch nicht standardisiert ist. Die in der
Spalte Bemerkungen angegebenen Ausschlüsse geben an, daß das Tag eventuell nicht in allen
Browsern implementiert ist:

nicht IE: Tag wird vom Internet Explorer Version 3.01 nicht interpretiert
nicht NN: Tag wird vom Netscape Navigator Version 3.01 nicht interpretiert
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Tabelle 1: Grundgerüst einer HTML-Datei
Nr. HTML-Tags Erläuterung HS Beispiel Bemer-

kungen
1.1 <html>

<head>
dokumentkopf
</head>
<body>
dokumentkörper
</body>
</html>

Grundgerüst einer HTML-
Datei: dokumentkopf enthält
Titelangaben für das HTML-
Dokument.
dokumentkörper enthält die
Dokumentinformation inkl.
Steueranweisungen

2.0

1.2 <title> ... </title> Dokumenttitel: Bestandteil
des Dokumentkopfs

2.0 <title>Einleitung
</title>

1.3 <body attribute> ... </body>

attribute:

Hintergrund und Textfarben
definieren

2.0

background=“pfad“
pfad: Pfad einer Datei vom
           Typ .gif oder .jpg

Pfad für Hintergrundbild 3.2 <body background=
“wall.gif“
link=“ffffff“
text=“maroon“> ...
</body>

bgcolor=“farbe“
mit:
farbe: #rgb oder farbname

Hintergrundfarbe 3.2 <body
bgcolor=“#fefefe“
link=“#000000“
text=“maroon“> ...
</body>

link=“farbe“ Farbe für Anker 3.2
vlink=“farbe“ Farbe für benutzten Anker 3.2
alink=“farbe“ Farbe für aktiven Anker 3.2 nicht IE
text=“farbe“ Textfarbe 3.2

Tabelle 2: Elemente auf Block-Level

Nr. HTML-Tag Erläuterungen HS Beispiel Bemer-
kungen

2.1 <address> .... </address> Formatierung einer Adresse 2.0
2.2 <blockquote> ... </blockquote> Zitatstellen 2.0
2.3 <center> ... </center> Zentrieren von Absätzen 3.2
2.4 <p> ... </p> Absatz ohne Ausrichtung 2.0
2.5 <p align=attribut> ... </p>

attribut: left, right, center
linksbündig, rechtsbündig
oder zentriert

3.2 <p align=right>
Unterschrift</p>

2.6 <div align=attribut> .... </div>
attribut: left, right, center

Ausrichtung von Textab-
schnitten: gemäß align

3.2 <div align=right>
Unterschrift </div>

2.7 <pre> ... </pre> Vorformatierter Text: Ausga-
be in einem nicht-
proportional-Font unter Bei-
behaltung aller Leerzeichen
und Zeilenumbrüche

2.0 <pre>
   Artikel    Anzahl
   Tassen         6
   Teller           5
   Kanne          1
</pre>

2.8 <hx>...</hx>
x: 1, ..., 6

Überschriften ohne Ausrich-
tung: je kleiner die Zahl,
desto größer die Überschrift

2.0 <h3>Einleitung
</h3>
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Nr. HTML-Tag Erläuterungen HS Beispiel Bemer-
kungen

2.9 <hx align=attribut> ... </hx>
attribut: left, right, center
x: 1, ..., 6

Überschriften mit Ausrich-
tung: links-, rechtsbündig
oder zentriert

3.2 <h3 align=center>
Einleitung </h3>

2.10 <ul>
<li> ...
...
</ul>

Ungeordnete Liste: Jedes
Listenelement wird mit <li>
eingeleitet.

2.0 <ul>
<li>Listenpunkt 1
<li>Listenpunkt 2
</ul>

2.11 <ul type=attribut>
<li> ...
....
</ul>

attribut: square, circle, disc

ungeordnete Liste mit Attri-
buten: Die Liste wird mit
Quadraten, Kreisen oder
gefüllten Kreisen als Markie-
rung für die Listenpunkte
gesetzt.

3.2 <ul type=square>
<li>Listenpunkt 1
<li>Listenpunkt 2
</ul>
erzeugt eine Liste,
mit Quadraten als
Listenpunkte .

nicht IE

2.12 <ol>
<li> ...
...
</ol>

Geordnete Liste: Jedes Li-
stenelement wird mit <li>
eingeleitet

2.0 <ol>
<li>Listenpunkt 1
<li>Listenpunkt 2
</ol>

2.13 <ol type=attribut, start=zahl>
<li> ...
...
</ol>

attribut:A, a, I, i, 1
zahl: ganze positive Zahl

Geordnete Liste mit Attribu-
ten: Erzeugt eine numerierte
Liste mit Numerierungen:
A, B, C ... oder
a, b, c .... oder
I, II, III ... oder
i, ii, iii ... oder
1,2,3, ...
start ist optional und gibt
einen Startwert  vor.

3.2 <ol type=A start=3>
<li>ein Punkt
<li>noch ein Punkt
</ol>

erzeugt eine Liste:
  C  ein Punkt
  D  noch ein Punkt

2.14 <dl>
<dt> ...
<dd> ...
....
</dl>

Definitionsliste: Hinter <dt>
(definition term) steht der zu
definierende Ausdruck, hinter
<dd> (definition data) die
Definition. Die Definition
wird gegenüber dem zu defi-
nierenden Ausdruck einge-
rückt.

2.0 <dl>
<dt>Definition Term
<dd>zu definieren-
der Ausdruck
<dt>Defintion Data
<dd>Erklärung des
Ausdrucks
</dl>

2.15 <hr> Horizontale Trennlinie 2.0

2.16 <hr attribute>
attribute:

Variation der Trennlinie 3.2 <hr align=center
size=5 width=75%>

align= left, right, center Trennlinie wird links-,
rechtsbündig oder zentriert
gesetzt

3.2

size=zahl Stärke in Anzahl Pixel 3.2
width=zahl
width=zahl%

Länge in Anzahl Pixel oder
prozentual zur Breite des
Anzeigefensters

3.2

noshade noshade stellt die Linie ohne
Schatten dar

3.2

color=“farbe“
farbe: #rgb oder farbname

stellt die Linie in der angege-
benen Farbe dar

- nicht NN

2.17 <form>
formatelement
</form>

Grundgerüst eines Formulars
zur Dateneingabe und Über-
mittlung

2.0
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Nr. HTML-Tag Erläuterungen HS Beispiel Bemer-
kungen

2.18 <form attribute>...</form>

attribute:

Eingabeformular definieren 2.0 <form action=
“mailto: name@ort“
method=post> ...
</form>

action= “URL“ Angaben zur Weiterverar-
beitung der Eingabe

2.0

method=post,set Art der Parameterübergabe.
Bei action mailto stets me-
thod=post

2.0

2.19 <input attribute>

attribute:

Eingabezeile zum Formular
definieren

2.0 <input type=text
name=ort size=15
maxlength=10>

name=“feldname“ Interner Name des Feldes 2.0
size=zahl
zahl: positive ganze Zahl

Länge des Eingabefeldes in
Zeichen

2.0

maxlength=zahl
zahl: positive ganze Zahl

maximale Länge der Eingabe 2.0

type= radio, reset, submit, text,
checkbox

radio: Wahl aus Vorgaben
checkbox: Wahl aus Vorga-
ben, Mehrfachwahl möglich
reset: alle Eingabefelder auf
Startwert zurücksetzen
submit: Übertragung der
Eingabe an den Server
text: Einzeiliges Textfeld

2.0 <input type=submit>

<input type=radio
name=RUB va-
lue=“Student der
RUB“>

value=“beliebige Zeichenfolge“ Vorbelegung 2.0
2.20 <textarea attribute> ...

</textarea>

attribute:

mehrzeiliges Eingabefeld
definieren

2.0 <textarea name=
“feld“ rows=2
cols=20> Defaulttext
</textarea>

name=“feldname“ Interner Name 2.0
rows=zahl
zahl: positive ganze Zahl

Größe des Feldes in Zeilen 2.0

cols=zahl
zahl: positive ganze Zahl

Größe des Feldes in Spalten 2.0

wrap=off, physical, virtual Zeilenumbruch in Eingabe -
2.21 <select attribute>

<option value=“wert“>auswahl
...
</select>
attribute:

Eingabeauswahl vorgeben
value=“wert“ gibt dem Ein-
trag einen internen Namen

2.0 <select name=
“wahl“>
<option>ja
<option>nein
</select>

name=“feldname“ Interner Name des Feldes 2.0
size=“zahl“ Anzahl angezeigter Zeilen 2.0
multiple Mehrfachwahlmöglichkeit 2.0

2.22 <applet attribute> Bezeichnung
</applet>
attribute:

Java-Applet einfügen 3.2

code=“pfad“ Fundstelle der Java-Datei 3.2
alt=“text“ Text, falls das Java-Applet

nicht geladen wird.
3.2

width=zahl
zahl: positive ganze Zahl

Breite des Appletfensters in
Pixel

3.2

height=zahl
zahl: positive ganze Zahl

Höhe des Appletfensters in
Pixel

3.2
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Tabelle 3: Elemente auf Text-Level

Nr. HTML-Tag Erläuterung HS Beispiel Bemer-
kungen

3.1 <b> ... </b> Text fett darstellen 2.0
3.2 <i>...</i> Text kursiv darstellen 2.0
3.3 <u>...</u> Text unterstrichen darstellen 3.2
3.4 <blink>....</blink> Text blinkend darstellen - nicht IE
3.5 <strike>...</strike> Text durchgestrichen dar-

stellen
3.2

3.6 <big> ...</big> Text in einem großen Font
setzen

3.2

3.7 <small>...</small> Text in einem kleinen Font
setzen

3.2

3.8 <sup>...</sup> Text höhergestellt setzen
(Superskript)

3.2

3.9 <sub>...</sub> Text tiefergestellt setzen
(Indexposition)

3.2

3.10 <tt>...</tt> Text mit festem Zeichenab-
stand setzen

2.0

3.11 <strong>...</strong> Text stark hervorgehoben
darstellen

2.0

3.12 <em>...</em> Text hervorgehoben darstel-
len

2.0

3.13 <cite>...</cite> Text als Zitatstelle kenn-
zeichnen

2.0

3.14 <dfn>...</dfn> Definition: Der Browser
bestimmt die Art der Dar-
stellung.

3.2 nicht
NN

3.15 <samp>...</samp> Beispiel: Der Browser be-
stimmt die Art der Darstel-
lung.

2.0

3.16 <var>...</var> Textuelle Kennzeichnung
einer Variablen: Der Browser
bestimmt die Art der Dar-
stellung.

2.0

3.17 <kbd>...</kbd> Text im Schreibmaschinen-
font setzen (fester Zeichenab-
stand)

2.0

3.18 <code>...</code> Darstellung von Quellcode in
Schreibmaschinenfont (fester
Zeichenabstand)

2.0

3.19 <basefont attribute>

attribute:

Auswahl eines Basisfonts:
Festlegen der Standard-
schriftgröße

3.2 <basefont size=4
color=“maroon“>

color=“farbe“
farbe: #rgb oder farbname

Textfarbe einstellen 3.2 nicht
NN

face=namensliste
namensliste: Aufzählung von
Fontnamen

Fontbezeichnungen. Es wird
der erste vorhandene Font
gewählt

- nicht
NN

size=zahl
zahl: 1,..,7 oder +1,...,+6 oder -
1,...,-6

Fontgröße: Es kann unter 7
Fontgrößen gewählt werden.
Eine relative Angabe (+, -)
bezieht sich auf eine Vergrö-
ßerung oder Verkleinerung
relativ zum Basisfont

3.2
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Nr. HTML-Tag Erläuterung HS Beispiel Bemer-
kungen

3.20 <font attribute> ... </font>

attribute:

Auswahl der Fontdarstellung 3.2 <font size=-2
color=“#fefefe“> ...
</font>

color=“farbe“
farbe: #rgb oder farbname

Textfarbe 3.2

face= namensliste
namensliste: Aufzählung von
Fontnamen

Fontbezeichnungen. Es wird
der erste vorhandene Font
gewählt.

- nicht
NN

size=zahl
zahl: 1,..,7 oder +1,...,+6 oder -
1,...,-6

Fontgröße:
Es kann unter 7 Fontgrößen
gewählt werden. Eine relative
Angabe (+, -) bezieht sich auf
eine Vergrößerung oder Ver-
kleinerung relativ zum Ba-
sisfont.

3.2

Tabelle 4: Spezielle Elemente auf Text-Level

Nr. HTML-Tag Erläuterung HS Beispiel Bemer-
kungen

4.1 <img attribute>

attribute:

Im Browser-Fenster wird ein
Bild eingefügt

2.0 <img src=“ball.gif“
alt=“Ball“ border=0
align=middle>

src=“Dateipfad“ Pfad der Bilddatei. In der
Regel werden die Bildformate
gif und jpg unterstützt.

2.0

alt=“text“ Ersatztext, wenn das Bild
nicht geladen wurde.

2.0

width=zahl
zahl: positive ganze Zahl

Bildbreite in Pixel 3.2

height=zahl
zahl: positive ganze Zahl

Bildhöhe in Pixel 3.2

border=zahl
zahl: positive ganze Zahl

Stärke der Umrandung.
border=0: ohne Bildrand

3.2

align=top, middle, bottom HTML-Text fließt normaler-
weise nicht um eine Graphik
herum. top, middle und bot-
tom positioniert die Graphik
relativ zur Zeile, in die die
Graphik eingefügt wurde.

2.0

align=left, right Plazierung der Graphik am
rechten (right) oder linken
(left)  Rand des Fensters. Der
nachfolgende Text fließt um
die Graphik herum.

3.2

hspace=zahl
zahl: positive ganze Zahl

horizontaler Abstand in Pixel
zum linken und rechten Ob-
jekt.

3.2

vspace=zahl
zahl: positive ganze Zahl

vertikaler Abstand in Pixel
zum darüber- und darunter
befindlichen Objekt.

3.2

4.2 <BR> Zeilenumbruch innerhalb
eines Absatzes.

2.0
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Nr. HTML-Tag Erläuterung HS Beispiel Bemer-
kungen

4.3 <BR clear=name>

name: left, right, all

Wird als Zeilenumbruch
verwendet, wenn im voran-
gehenden Text Bilder mit
align=left oder right einge-
bettet wurden.

3.2 <br clear=left> Statt
„all“ ist
auch
„both“
möglich

4.4 <a href=“url“> Verweistext
</a>

url: vollständiger URL mit
       Dienstbezeichnung

Anker: Verweis auf Fund-
stelle eines Dienstes auf ei-
nem anderen Server

2.0 <a
href=“http://www.ru
hr-uni-bochum.de/“>
Home Page RUB
</a>

4.5 <a href=“Pfad“> Verweistext
</a>

Anker: Fundstelle für lokale
Ressource

2.0 <a href=
“../Index.html“>
Titelseite </a>

4.6 <a name=“Bezeichner“> Ver-
weistext </a>

Zielpunkt: Markiert einen
Ankerpunkt, auf den verwie-
sen werden kann

2.0 <a
name=“Marke1“>
Einleitung </a>

4.7 <a href=“#Bezeichner“> Ver-
weistext </a>

Zielpunkt: Verweist auf eine
als Anker markierte
Textstelle im gleichen Do-
kument

2.0 <a href=“#Marke1“>
springt zur Einlei-
tung </a>

Tabelle 5: HTML-Tabellen

Nr. HTML-Tags Erläuterung HS Beispiel Bemer-
kungen

5.1 <table>
tabellenbezeichnung
tabellenkopfzellen
tabellendatenzellen
</table>

Grundgerüst einer Tabelle.
Tabellenbezeichnung und
Tabellenkopfzeile sind op-
tional. Es sind beliebig viele
Tabellendatenzeilen mög-
lich.

3.2 <table align=center>
<caption
align=bottom>
Tabelle 1</caption>
<tr><th>S1<th>S2
<tr><td>A<td>B
</table>

5.2 <table attribute>...</table>
attribute:

Tabelle definieren 3.2

align=left, center, right Position der Tabelle im An-
zeigefenster

3.2

height=zahl
height=zahl%
mit:
zahl: positive ganze Zahl

Höhe der Tabelle in Pixel
oder prozentual zur Höhe des
umgebenden Objekts (z.B.
des Ausgabefensters)

-

width=zahl
width=zahl%
mit:
zahl: positive ganze Zahl

Breite der Tabelle in Pixel
oder prozentual zur Breite
des umgebenden Objekts
(z.B. des Ausgabefensters)

3.2

border=zahl
mit:
zahl: positive ganze Zahl

Stärke der Umrandung in
Pixel. border=0 bedeutet:
ohne Umrandung

3.2

cellspacing=zahl
mit:
zahl: positive ganze Zahl

Abstand zwischen den Zel-
lumrandungen in Pixel.

3.2

cellpadding=zahl
zahl: positive ganze Zahl

Abstand zwischen Zellrah-
men und Zellinhalt in Pixel

3.2

bgcolor=“farbe“
farbe: #rgb oder farbname

Hintergrundfarbe der Tabelle -



Anhang 150

Nr. HTML-Tags Erläuterung HS Beispiel Bemer-
kungen

5.3 <caption align=attribut> bezei-
chung </caption>
attribut: top, bottom

Tabellenbezeichnung: Über-
oder Unterschrift

3.2 <caption align=top>
HTML-Elemente
</caption>

5.4 <tr attribute> ... </tr>
attribute:

Tabellenkopfzelle 3.2

align=left, center, right Horizontale Ausrichtung der
Tabelleneinträge

3.2

valign=top, middle, bottom Vertikale Ausrichtung der
Tabelleneinträge

3.2

bgcolor=“farbe“
farbe: #rgb oder farbname

Hintergrundfarbe fuer die
Tabellenzeile

-

5.5 <th attribute> ... </th>
attribute:

Kopf-/Überschriftzelle der
Tabelle

3.2

nowrap Abschalten des automati-
schen Umbruchs in der Ta-
bellenzelle

3.2

rowspan=zahl
zahl: positive ganze Zahl

Vertikale Ausdehnung der
Zelle über mehrere Tabellen-
zeilen

3.2

colspan=zahl
zahl: positive ganze Zahl

Horizontale Ausdehnung der
Zelle über mehrere Tabellen-
spalten

3.2

align=left, center, right Horizontale Ausrichtung der
Tabelleneinträge

3.2

valign=top, middle, bottom Vertikale Ausrichtung der
Tabelleneinträge

3.2

width=zahl
zahl: positive ganze Zahl oder
%zahl

Breite der Zelle in Pixel oder
prozentual zum Anzeigefen-
ster

3.2

height=zahl
zahl: positive ganze Zahl oder
%zahl

Höhe der Zelle in Pixel oder
prozentual zum Anzeigefen-
ster.

3.2

bgcolor=“farbe“
farbe: #rgb oder farbname

Hintergrundfarbe der Zelle -

5.6 <td attribute> ... </td>
attribute:

Tabellendatenzelle 3.2

nowrap Abschalten des automati-
schen Umbruchs in der Zelle

3.2

rowspan=zahl
zahl: positive ganze Zahl

Vertikale Ausdehnung der
Zelle über mehrere Zeilen

3.2

colspan=zahl
zahl: positive ganze Zahl

Horizontale Ausdehnung der
Zelle über mehrere Spalten

3.2

align=left, center, right Horizontale Ausrichtung der
Tabelleneinträge

3.2

valign=top, middle, bottom Vertikale Ausrichtung der
Tabelleneinträge

3.2

width=zahl
zahl: positive ganze Zahl oder
%zahl

Breite der Zelle in Pixel oder
prozentual zum Ausgabefen-
ster

3.2

height=zahl
zahl: positive ganze Zahl oder
%zahl

Höhe der Zelle in Pixel oder
prozentual zum Ausgabefen-
ster

3.2

bgcolor=“farbe“
farbe: #rgb oder farbname

Hintergrundfarbe der Zelle -
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Tabelle 6: Browser-spezifische HTML-Erweiterungen

Nr. HTML-Tag Erläuterung HS Beispiel Bemer-
kungen

6.1 <script language=typ> ...
</script>
typ: JavaScript, VBScript

Skripts einfügen. Der Code
des Java- oder VB-Skripts
steht zwischen den Tags

- <script language=
JavaScript>
...
</script>

VB-
Script
nur IE

6.2 <marquee attribute> text
</marquee>

attribute:

Marquee (Schriftlaufband)
einfügen

- <marquee loop=10
behavior=scroll
direction=left
width=50%
bgcolor="yellow">
Ein Schriftband
</marquee>

nicht
NN

behavior=scroll, slide, alternate scroll: umlaufend
slide: Schrift gleitet ins Feld
und bleibt am Ende stehen
alternate: Schrift pendelt vor-
und rückwärts

-

bgcolor=“farbe“
farbe: #rgb oder farbname

Farbe des Schriftbandes -

direction=left, right Laufrichtung der Schrift -
height=zahl
height=zahl%
zahl: positive ganze Zahl

Höhe des Schriftbandes in
Pixel oder prozentual zum
umgebenden Fenster

-

width=zahl
width=zahl%
zahl: positive ganze Zahl

Breite des Schriftbandes in
Pixel oder prozentual zum
umgebenden Fenster

-

loop=zahl
zahl: positive ganze Zahl

Anzahl Wiederholungen -

6.3 <bgsound attribute>

attribute:

Hintergrundsound abspielen - <bgsound
src=“bojungen.wav“
loop=-1>

nicht
NN

src=“pfad“
pfad: Fundstelle der Datei

-

loop=zahl
zahl: ganze Zahl

Anzahl Wiederholungen
loop=-1 oder loop=infinite
erzeugt Dauerwiederholung

-

6.4 <embed attribute>
attribute siehe img

Einbettung eines Objekts - nicht IE

6.5 <multicol attribute> ...
</multicol>

attribute:

Text mehrspaltig setzen - <multicol  cols=2
width=75%>
... Textabsatz, der
zweispaltig gesetzt
wird ...
</multicol>

nicht IE

cols= zahl
zahl: positive ganze Zahl

Anzahl Spalten -

gutter= zahl

zahl: positive ganze Zahl

Abstand zwischen nebenein-
anderliegenden Spalten in
Pixel

-

width=zahl
width=zahl%

zahl: positive ganze Zahl

Breite des gesamten mehr-
spaltigen Absatzes in Pixel
oder prozentual zum umge-
benden Fenster

-
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Tabelle 7: Framesets

Nr. HTML-Tag Erläuterung HS Beispiel Bemer-
kungen

7.1 <frameset>
framedefinitionen
</frameset>

Grundgerüst eines Framesets - <frameset>
<frame src=“f1.htm“
name=kopf“>
<frame src=“f2.htm“
name=rumpf“>
<noframe> Dieser
Code wird ausge-
führt, wenn der
Browser keine Fra-
mes beherrscht
</noframe>
</frameset>

7.2 <frameset attribute> ..
</frameset>

attribute:

Frameset einfügen - <frameset
rows=“20%,*“>
framedefinitionen
</frameset>
Der obere Frame
belegt 20% des Fen-
sters, der untere den
Rest

rows=“liste“
liste: Aufzählung von
zahl, zahl%, *, zahl*
zahl: positive ganze Zahl

Definiert, wieviele Frames in
welcher Größe vertikal über-
einander gebildet werden.

-

cols=“liste“
liste: siehe rows

Definiert, wieviele Frames in
welcher Breite horizontal
nebeneinander gebildet wer-
den

-

7.3 <frame attribute>

attribute:

Framedefinition.
Die Frames werden in der
Reihenfolge ihrer Definition
den rows/cols-Definitionen
des Frameset-Tags zugewie-
sen.

- <frame
src=“head.html“
name=kopf>

src=“url“ Pfadangabe für das Doku-
ment, das im Frame darge-
stellt wird

-

name=“fenster“ Name für das Frame-Fenster -
scrolling=yes, no, auto Festlegung, ob das Fenster

einen Scrollbar erhält.
-

7.4 <a href=... target=“ziel“> ...
</a>
ziel: Name eines Framefensters
oder _top

Anker für Frames: Das Do-
kument wird im angegebenen
Framefenster dargestellt. Bei
_top füllt das Dokument das
ganze Browserfenster

- <a href=“buch.html“
target=“kopf“>
Buchtitel </a>

7.5 <noframe> ... </noframe> Ersatztext, der von Browsern
angezeigt wird, die keine
Framesets darstellen können

- <noframe>
Sie sehen leider
keine Frameinfor-
mation </noframe>
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Tabelle 8: Sonderzeichen

engl. Bezeichnung Ersatzdarstellung Zeichen Beschreibung
Aacute &Aacute; Á A, Accent aigue
Agrave &Agrave; À A, Accent grave
Acirc &Acirc; Â A, Accent circumflex
Atilde &Atilde; Ã A, Tilde
Aring &Aring; Å A, Ring
Auml &Auml; Ä A, Umlaut (Dieresis)
AElig &AElig; Æ AE Diphtong (Ligatur)
Ccedil &Ccedil; Ç C, cedille
Eacute &Eacute; É E, Accent aigue
Egrave &Egrave; È E, Accent grave
Ecirc &Ecirc; Ê E, Accent circumflex
Euml &Euml; Ë E, Umlaut (Dieresis)
Iacute &Iacute; Í I, Accent aigue
Igrave &Igrave; Ì I, Accent grave
Icirc &Icirc; Î I, Accent circumflex
Iuml &Iuml; Ï I, Umlaut (Dieresis)
ETH &ETH; Ð Eth, Nordisch
Ntilde &Ntilde; Ñ N, Tilde
Oacute &Oacute; Ó O, Accent aigue
Ograve &Ograve; Ò O, Accent grave
Ocirc &Ocirc; Ô O, Accent circumflex
Otilde &Otilde; Õ O, Tilde
Ouml &Ouml; Ö O, Umlaut (Dieresis)
Oslash &Oslash; Ø O, slash
Uacute &Uacute; Ú U, Accent aigue
Ugrave &Ugrave; Ù U, Accent grave
Ucirc &Ucirc; Û U, Accent circumflex
Uuml &Uuml; Ü U, Umlaut (Dieresis);
Yacute &Yacute; Ý Y, Accent aigue
THORN &THORN; Þ THORN, Nordisch
Szlig &szlig; ß scharfes s (s-Ligatur)
aacute &aacute; á a, Accent aigue
agrave &agrave; à a, Accent grave
acirc &acirc; â a, Accent circumflex
atilde &atilde; ã a, Tilde
aring &aring; å a, Ring
auml &auml; ä a, Umlaut (Dieresis)
aelig &aelig; æ ae dipthong (ligature
ccedil &ccedil; ç c, cedille
eacute &eacute; é e, Accent aigue
egrave &egrave; è e, Accent grave
ecirc &ecirc; ê e, Accent circumflex
euml &euml; ë e, Umlaut (Dieresis)
iacute &iacute; í i, Accent aigue
igrave &igrave; ì i, Accent grave
icirc &icirc; î i, Accent circumflex
iuml &iuml; ï i, Umlaut (Dieresis)
eth &eth; ð eth, Nordisch
ntilde &ntilde; ñ n, Tilde
oacute &oacute; ó o, Accent aigue
ograve &ograve; ò o, Accent grave
ocirc &ocirc; ô o, Accent circumflex
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engl. Bezeichnung Ersatzdarstellung Zeichen Beschreibung
otilde &otilde; õ o, Tilde
ouml &ouml; ö o, Umlaut (Dieresis)
oslash &oslash; ø o, slash
uacute &uacute; ú u, Accent aigue
ugrave &ugrave; ù u, Accent grave
ucirc &ucirc; û u, Accent circumflex
uuml &uuml; ü u, Umlaut (Dieresis)
yacute &yacute; ý y, Accent aigue
thorn &thorn; þ thorn, Nordisch
yuml &yuml; ÿ y, Umlaut (Dieresis)
reg &reg; ® Registered TradeMark
copy &copy; © Copyright
trade &trade; ™ TradeMark
nbsp &nbsp; geschütztes

Leerzeichen
Leerzeichen, das nicht umgebro-
chen wird
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